<table>
<thead>
<tr>
<th>Appendix A: Command Summary</th>
<th>123</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appendix B: Application Software Catalog</td>
<td>127</td>
</tr>
<tr>
<td>ABAQUS 6.8 - Dassault Systemes Simulia Corporation</td>
<td>127</td>
</tr>
<tr>
<td>Adams 2010 - MSC Software</td>
<td>127</td>
</tr>
<tr>
<td>Acrobat 9 Professional - Adobe Systems Incorporated</td>
<td>128</td>
</tr>
<tr>
<td>Adobe CS5 (Creative Suite 5) - Adobe Systems Incorporated</td>
<td>128</td>
</tr>
<tr>
<td>ANSYS 12.1 - Ansys Inc</td>
<td>129</td>
</tr>
<tr>
<td>ArcGIS Desktop 9.3 - Environmental Systems Research Institute (ESRI)</td>
<td>129</td>
</tr>
<tr>
<td>ArcWorkstation 9.3 - Environmental Systems Research Institute (ESRI)</td>
<td>130</td>
</tr>
<tr>
<td>Arena 12 - Rockwell Automation, Inc</td>
<td>130</td>
</tr>
<tr>
<td>aspenONE 7.1 - Aspen Technology, Inc</td>
<td>131</td>
</tr>
<tr>
<td>AutoCAD 2009 - Autodesk, Inc</td>
<td>131</td>
</tr>
<tr>
<td>AutoCAD Civil 3D 2009 - Autodesk, Inc</td>
<td>131</td>
</tr>
<tr>
<td>AVR Studio 4 - Atmel Corporation</td>
<td>132</td>
</tr>
<tr>
<td>COMSOL Multiphysics 3.5 - Comsol, Inc</td>
<td>132</td>
</tr>
<tr>
<td>Eclipse 3.4.1 - Eclipse Foundation</td>
<td>132</td>
</tr>
<tr>
<td>Fortran - NAGware f95 Compiler 5.1 - Numerical Algorithms Group</td>
<td>133</td>
</tr>
<tr>
<td>ILOG CPLEX 12.1 - IBM</td>
<td>133</td>
</tr>
<tr>
<td>ILOG OPL CPLEX Development Studio 6.3 - IBM</td>
<td>133</td>
</tr>
<tr>
<td>Java Development Kit 6 (1.6) - Sun Microsystems, Inc</td>
<td>134</td>
</tr>
<tr>
<td>JMP 8.0 - SAS Institute, Inc</td>
<td>134</td>
</tr>
<tr>
<td>LabVIEW 2009 - National Instruments Corporation</td>
<td>135</td>
</tr>
<tr>
<td>LINDO v6.1 - Lindo Systems</td>
<td>135</td>
</tr>
<tr>
<td>LINGO v6.0 - Lindo Systems</td>
<td>135</td>
</tr>
<tr>
<td>Maple 13 - Maplesoft</td>
<td>136</td>
</tr>
<tr>
<td>Mathcad 14 - Parametric Technology Corporation (PTC)</td>
<td>136</td>
</tr>
<tr>
<td>Mathematica 7.0 - Wolfram Research, Inc</td>
<td>137</td>
</tr>
<tr>
<td>MathType 6.0 - Design Science, Inc</td>
<td>137</td>
</tr>
<tr>
<td>MATLAB 7.9 (R2010) - The MathWorks, Inc</td>
<td>138</td>
</tr>
<tr>
<td>Microsoft Access 2007 - Microsoft</td>
<td>138</td>
</tr>
<tr>
<td>Microsoft Excel 2007 - Microsoft</td>
<td>139</td>
</tr>
<tr>
<td>Microsoft PowerPoint 2007 - Microsoft</td>
<td>139</td>
</tr>
<tr>
<td>Microsoft Project 2007 - Microsoft</td>
<td>140</td>
</tr>
<tr>
<td>Microsoft Visio 2007 - Microsoft</td>
<td>140</td>
</tr>
<tr>
<td>Microsoft Visual Studio .NET 2008 Professional - Microsoft</td>
<td>140</td>
</tr>
<tr>
<td>Microsoft Word 2007 - Microsoft</td>
<td>140</td>
</tr>
<tr>
<td>Microstation V8i - Bentley Systems, Inc</td>
<td>141</td>
</tr>
<tr>
<td>Moldflow 2010 - Autodesk, Inc</td>
<td>141</td>
</tr>
<tr>
<td>NEXS Engineering Spreadsheet v1.6 - GreyTrowt Software, Inc</td>
<td>141</td>
</tr>
<tr>
<td>OfficeScan 10 - TrendMicro, Inc</td>
<td>142</td>
</tr>
<tr>
<td>OpenOffice.org 3.2.0 - OpenOffice.org</td>
<td>142</td>
</tr>
<tr>
<td>OPNET 15 - OPNET Technologies, Inc</td>
<td>143</td>
</tr>
<tr>
<td>Primavera P6 - Oracle</td>
<td>143</td>
</tr>
<tr>
<td>Pro/ENGINEER Wildfire 5.0 - Parametric Technology Corporation (PTC)</td>
<td>143</td>
</tr>
<tr>
<td>RS Logix 500 - Rockwell Automation, Inc</td>
<td>144</td>
</tr>
<tr>
<td>SAS 9.2 - SAS Institute Inc</td>
<td>144</td>
</tr>
<tr>
<td>SlickEdit 2010 - SlickEdit, Inc</td>
<td>145</td>
</tr>
<tr>
<td>SolidWorks Education Edition 2010-2011 - SolidWorks Corporation</td>
<td>145</td>
</tr>
<tr>
<td>SPSS and AMOS - SPSS, Inc</td>
<td>146</td>
</tr>
<tr>
<td>SuperPro Designer 7 - Intelligen, Inc</td>
<td>146</td>
</tr>
<tr>
<td>SurfCAM Velocity 4 - Surfware, Inc</td>
<td>147</td>
</tr>
<tr>
<td>Tecplot 360 2010 - Tecplot, Inc</td>
<td>147</td>
</tr>
<tr>
<td>Timberline Office Estimating 7.1.3 - Sage</td>
<td>148</td>
</tr>
<tr>
<td>TK Solver 4.0 - Universal Technical Systems, Inc</td>
<td>148</td>
</tr>
<tr>
<td>VirusBarrier X5 - Intego</td>
<td>148</td>
</tr>
<tr>
<td>Visual MODFLOW 4.3 - Schlumberger Water Services</td>
<td>148</td>
</tr>
<tr>
<td>WaterCAD V8i - Bentley Systems, Inc</td>
<td>149</td>
</tr>
<tr>
<td>WinEdt 5.3 - WinEdt</td>
<td>149</td>
</tr>
<tr>
<td>WinSCP 4.0.3</td>
<td>149</td>
</tr>
<tr>
<td>X-Win32 9.5 - StarNet Communications</td>
<td>150</td>
</tr>
</tbody>
</table>
About Author and ITECS Staff

Ellen McDaniel, Ph.D., Web and Content Management Coordinator
Information Technology and Engineering Computer Services
College of Engineering, North Carolina State University
Box 7901, 215 Page Hall
(919) 515-2458; eoshelp@ncsu.edu

ITECS Staff
Thomas K. Miller III, Associate Dean, Distance Education and Information Technologies
Keith Boswell, Director of Technology
Charles Hunt, Assistant Director
Michelle Bailey, Executive Assistant
Derek Ballard, Operations and Systems Specialist
Tony Baumann, Educational Technology Consultant, Student-Owned Computing
Billy Beaudoin, Systems Manager
Rufus Becoit, Help Desk Consultant
Gary Gatling, Computer Systems Administrator
Rob Grau, Systems Programmer
Damian Hall, Web Applications Developer
Margaret Hudacko, Applications Manager
Justin Lancaster, Eos Lab Manager
Robbie Little, Software Manager
Jason Maners, Coordinator, Student-Owned Computing
Richard McLane, Operations and Systems Analyst
Kristi Reich, Help Desk Manager
Brenda Savage, Assistant Software Manager
Daniel Sink, Operations and Systems Analyst
Tony Strother, Help Desk Consultant
Michael Underwood, Operations and Systems Analyst
Michael Vysocka, Digital Media and Web Developer
Acknowledgments

Guide to Eos and Unity Computing, 2010-11 Edition for UNIX, Windows, and Linux is the principal user manual for the distributed academic computing environment at North Carolina State University. Formerly a College of Engineering system only, Eos was made available to other NCSU colleges in 1996 in a project called Unity. Today, all NCSU students, faculty and staff receive accounts on a fully merged campus-wide system, or realm, often referred to as Eos/Unity.


The current guide, Guide to Eos and Unity Computing: 2010-11 Edition for UNIX, Windows and Linux, is the final edition that will be written and printed, concluding a 20-year history. User documentation can be developed more easily online to reach wider audiences with more up-to-date information.

Special thanks go to the College of Engineering (COE) Computer Committee, Thomas K. Miller, current Vice Provost for Distance Education and Learning Technology Applications (DELTA), and William E. Willis, former Vice Provost for Information Technology, for their vision in building the original Eos system. Tom Miller, Sam Averitt, former Vice Provost for Information Technology, and Marc Hoit, current Chief Information Officer, also have my thanks for their ongoing support of this guide, along with Keith Boswell, Director of ITECS, and Charles Hunt, Assistant Director of ITECS.

I would like to thank the staff of About Author and ITECS Staff on page 5 and NCSU’s Office of Information Technology (OIT) for the information and assistance they provided, which helped to make this manual more complete and comprehensive. I can no longer name all of the people who have helped; the list has grown too long over the years. Troy Hurteau, Ken Sanders and Mike Vysocka have been my close partners in putting this guide online with our move to XML-based publishing. Thanks also to Tim Lowman for the original Hitchhiker’s Guide to the Eos System, to Marshall Brain for the first online Eos tutorials, and to the E115 TAs who maintain the E115 course web site and text. Of course, Eos/Unity would not exist at all without the creative and diligent work of IT staff across campus, particularly in OIT and ITECS. These people provide the vision, development and support for a system that changes daily.

The guide was produced in XMetaL Author Enterprise 6.0 from JustSystems, Inc., with the built-in Render X XEP XSL-FO Formatter and Darwin Information Typing Architecture (DITA) XML DTD. XMetaL enables shared authoring in XML in a topic-based framework based on DITA. The cover for this book is the work of Lou Harrison. I am lucky to have his permission to use the compelling image, Thru the Wall. I would also like to acknowledge the following resources:


Computing @ NC State, Information Technology Division, http://oit.ncsu.edu/.

Unity Accounts and Login

Unity is the campus-wide computing system at North Carolina State University. All faculty, staff, and students have Unity accounts, which enable them to access computing resources for registration, course management, research, software, labs, etc.

Before 1996, Eos (an engineering-only system at the time) and Unity (NCSU) accounts were separate. Today, Eos/Unity is a fully merged network realm, requiring only a single account. What people call an Eos or Unity account is one and the same. However, because accounts are created at the university level, Unity account has become the preferred name and the one used in this guide.

Account Activation

NCSU Enrollment Management and Services (EMAS) and the Office of Information Technology Division (OIT) create campus ID numbers and computer accounts for all users. A Unity account is created for an individual upon registration as a student or employment as staff or faculty.

Unity accounts for students are generated upon acceptance at NC State and no later than the end of New Student Orientation so that students can register for classes. They are delivered to new students through the WolfPAW (http://wolfpaw.ncsu.edu) undergraduate admission system. Your Unity ID and password are not the same as your WolfPAW login.

Unity accounts remain active as long as students are registered, including over summer, if pre-registered for fall, and for four months after graduation from NC State.

Unity accounts for faculty and staff are automatically generated when their employee information appears in the Human Resources (HR) database. Accounts remain active for the duration of faculty and staff employment.

Time-limited guest accounts are authorized on a case-by-case basis by department heads and systems personnel.

To log in, the user types his or her Unity ID and password in the login and password fields of a workstation or web page without capitalization or spaces.

Note: Do not give anyone your Unity ID and password to use! This is a violation of computing policy. If you know that someone else has your password, change it immediately at http://www.ncsu.edu/password/.

Unity ID

Once employed or admitted as a student, users are issued a unique Unity ID and password for secure login to campus email and web pages, lab workstations, MyPack Portal (http://mypack.ncsu.edu) and other computing resources. The Unity ID is also used for the user’s NCSU email address, e.g., unityid@ncsu.edu.

The Unity ID is referred to by many names, e.g., username, login name, login ID, userid, account name, etc. It is generally composed of a person’s first and middle initials and first six characters of his/her last name. For example, if the user’s name is John Q. Public, his Unity ID is jqpublic and his email address is jqpublic@ncsu.edu. Common names may have numbers added, e.g., jqpubli2, jqpubli3. The name may be truncated when a number is added so that the Unity ID is never more than 8 characters.
Unity Password

Your initial password, also known as your "default" password, is the last four digits of your Campus ID number on your All Campus Card, plus the four digits of your birth month and day. For example, if your Campus ID number ends in 1234 and your birthday is March 8, your initial password is 12340308.

This password is not secure and needs to be changed after initial login. To prevent unauthorized access to your files:

1. Go to http://www.ncsu.edu/password/ and change your initial password to one of your own choosing. Follow the password-strength requirements offered at the site.
2. Set up security questions at the OIT Authorized Access site (http://www.acs.ncsu.edu/uia) so that you can identify yourself to help desk consultants should you need help with your account or a password reset.

You should continue to change your password regularly over time. Never tell anyone your password, which would enable that person to access your account and email. Account-sharing is a policy violation.

Password Reset: If you forget your password, go to the Help Desk in 101 West Dunn Building, (help@ncsu.edu, 919-515-HELP, 4357). Please have your NCSU ID with you. System administrators cannot find out your old password for you. Rather, they reset your password to a new one, which you must then change again to a password of your choosing. See Password Troubleshooter.

If you are a distance student or faculty/staff member working via remote access and are not able to come to campus, contact the Help Desk for the procedures they require for password resets (see also #2 above).
If you have other passwords you need to change, consult the Password Troubleshooter tool for help with those.

NC State's authentication environment uses a number of technologies to connect you to various services. This tool will help you pinpoint which system is causing a problem with your password and provide a solution.

To begin, select the service you cannot login to from the menu above.

Completely forgot your Unity password? Click here for password reset instructions.

Account Privileges

Unity accounts provide users with access to many resources, including:

• 350MB of file space allocated as the user wishes through the Quota Manager at http://sysnews.ncsu.edu.
• Nightly backup of user storage locations.
• Email and instant messaging services.
• Delivery of personal web pages from http://www4.ncsu.edu/~unityid and http://sites.ncsu.edu
• High-speed wired and wireless Internet access on campus (http://wireless.ncsu.edu).
• Workstation labs with high-speed Internet in the library, residence halls and academic buildings.
• Extensive application software in labs, classrooms, via remote access, and for personal computers.
• Web applications, e.g., Gmail and Google Apps, WebAssign, MyPack Portal, plus Wolfware, Blackboard Vista, Elluminate, Mediasite, and Moodle learning management software.
• Subscription academic resources, e.g., library databases, journals, newspapers, government documents, etc.
• Help desks (help@ncsu.edu) and support services, e.g., anti-virus software, spam filtering, etc.
• Remote access services and the Virtual Computing Lab (VCL) (http://vcl.ncsu.edu).

If preregistered for fall, students also have access to their accounts over summer without paying a fee. They also have free access to email and AFS space for four months after graduation.

For additional information on student accounts, see:
http://www.ncsu.edu/it/rulesregs/caccounts/student-maint-sop.html

For additional information on faculty and staff accounts and guest accounts, see:
http://www.ncsu.edu/it/rulesregs/caccounts/facstaff-maint-sop.html

Account Deactivation

Student accounts are deactivated on census day (the last day of drop-add) of the first semester that a student is not registered. Accounts are deleted one year after deactivation. For example, if a student is not registered by census day of the spring semester, his or her account will be deactivated. If that student is also not registered by
the following fall semester's census day, the account is deleted. Summer sessions are not counted, only fall and spring semesters.

Accounts for faculty and staff are automatically deactivated when an individual is no longer on the University payroll. They are deleted one year after deactivation.

Users with deactivated accounts cannot log in to workstations, web pages, or remote servers, or have access to the files stored in their account. After one year of deactivation, the account is deleted and cannot be recovered. If users anticipate leaving the university for any period of time, they need to copy to alternative storage any files they wish to keep.

User Lookup and Quota Management

The SysNews web site at [http://sysnews.ncsu.edu](http://sysnews.ncsu.edu) provides tools and links to help you maintain your Unity account. Among the useful resources at this web site is the User Info lookup tool at the top left of the page, which links to Account Information for each user.

<table>
<thead>
<tr>
<th>User Information</th>
<th>AFS Quota Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username: kmsander</td>
<td>Server: uni13f.unity.ncsu.edu</td>
</tr>
<tr>
<td>Full Name: Kenneth Marshall Sanders</td>
<td>Partition: b</td>
</tr>
<tr>
<td>Campus ID: 000764438</td>
<td>Volume: users.kmsander</td>
</tr>
<tr>
<td>Student ID: 000764438</td>
<td>Quota Allowed: 150,000 K</td>
</tr>
<tr>
<td>Employee ID: 000764438</td>
<td>Space Used: 146,539 K</td>
</tr>
<tr>
<td>AFS cell: unity</td>
<td>Space Free: 3,461 K</td>
</tr>
<tr>
<td>Account added: Apr 9 2005 2:46AM</td>
<td>Percent Used: 97.69%</td>
</tr>
<tr>
<td>Policy Violations: 1</td>
<td>Last Krb login: Jul 6 2009 5:53PM</td>
</tr>
<tr>
<td>Last Krb login: Jul 6 2009 5:53PM</td>
<td>(logins today are not included)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Student Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class: CSU</td>
</tr>
<tr>
<td>Major: ENG</td>
</tr>
<tr>
<td>Current Courses: ENG 207 051</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Hered Group Membership</th>
</tr>
</thead>
<tbody>
<tr>
<td>engr_spring Engineering Spring access</td>
</tr>
<tr>
<td>engr_sum Engineering Summer access</td>
</tr>
<tr>
<td>engptstaff Engineering Part-time Staff</td>
</tr>
<tr>
<td>ncsu NCSU</td>
</tr>
<tr>
<td>ncsu_ptstaff Part-time NCSU staff access</td>
</tr>
<tr>
<td>spring Spring access</td>
</tr>
<tr>
<td>sum Summer access for pre-registered students</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Email Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account: uni123map</td>
</tr>
<tr>
<td>IMAP Server: uni123map</td>
</tr>
<tr>
<td>Total Quota: 100.0MB</td>
</tr>
<tr>
<td>Space Used: 52.1MB</td>
</tr>
<tr>
<td>Space Free: 47.9MB</td>
</tr>
<tr>
<td>Percent Used: 52.1%</td>
</tr>
<tr>
<td>Last Check: Tue Jul 8 16:22:02 2009</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>NDS Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Name: Kenneth Marshall Sanders</td>
</tr>
<tr>
<td>Profile Path: kmsander</td>
</tr>
<tr>
<td>Profile Volume: .ITD_PROFILE36.Services.NCSU</td>
</tr>
<tr>
<td>Context: .Active-4.users</td>
</tr>
<tr>
<td>Disabled: FALSE</td>
</tr>
<tr>
<td>Last NDS Login: Tue Jul 8 13:19:40 2009</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Directory Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile Quota: 104,857,600 bytes (100 MB)</td>
</tr>
<tr>
<td>Space Used: 70,492,160 bytes (67.2 MB)</td>
</tr>
<tr>
<td>Space Free: 34,365,440 bytes (32.8 MB)</td>
</tr>
<tr>
<td>Percent Used: 67.2%</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>RMIS eDirectory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Name: Kenneth Marshall Sanders</td>
</tr>
<tr>
<td>Container: P2</td>
</tr>
<tr>
<td>Intruder Lockout: FALSE</td>
</tr>
<tr>
<td>Login Disabled: FALSE</td>
</tr>
<tr>
<td>Last Login Time: Fri Jun 27 20:52:23 2009</td>
</tr>
<tr>
<td>Password Expiration Time: Mon Apr 27 10:00:00 2010</td>
</tr>
<tr>
<td>Login Expiration Time: unknown</td>
</tr>
</tbody>
</table>
The SysNews web site at http://sysnews.ncsu.edu provides tools and links to help you maintain your Unity account. Among the useful resources at this web site is the User Info lookup tool at the top left of the page, which links to the Quota Manager tool for managing the 350 MB you have in three file-storage locations:

- **AFS**: User file and web storage in the user's home directory at /afs/users/a-z/unityid/ (AKA K: drive).
- **Email**: User storage on campus IMAP email servers, available through Webmail and your IMAP mail client.
- **Novell**: User profile data stored on the Novell M: drive of Eos and Unity Windows lab computers (includes files and profile settings left on the desktop or stored on M:).

  **Note**: At the time of this guide's publication, students are being moved to Google Mail and Apps but will retain the unityid@ncsu.edu address. They will no longer use IMAP storage and Webmail (http://webmail.ncsu.edu) but will instead access mail at http://gmail.ncsu.edu.

To allocate your file space:

1. Log in to http://sysnews.ncsu.edu to view a table that shows your Current Usage and Current Quota for each of the above categories (AFS, Email, Novell).
2. To change your allocation for a category, type the desired number into the cell field in the New Quota column. The number must be within the range indicated in parentheses and no lower than your current usage in that category. The New Total Quota automatically recalculates and cannot exceed 350MB.
3. When you have made your changes, select Submit Change Request. If you have difficulty allocating your space, see http://help.ncsu.edu for assistance.

**Personal Computers, ResNet and Wireless Access**

Students with their own computers are increasingly relying on remote-access services and wireless access to connect to Eos/Unity resources. Labs still remain the best way for students to access licensed application software and directly connect to the campus AFS file system. However, remote-access services (http://www.eos.ncsu.edu/remoteaccess/) and the Virtual Computing Lab (VCL) at http://vcl.ncsu.edu are improving as alternative ways to access computing resources from individually owned computers.

**Student-owned Computing**

Nearly all students at NCSU own a desktop and/or laptop computer, which they use from both campus and non-campus locations. The NCSU Office of Information Technology (OIT) and College of Engineering ITECS provide substantial information about purchasing and configuring student computers and using them to make remote-access connections to the campus network and its resources.

http://oit.ncsu.edu/computer-specs/
http://www.eos.ncsu.edu/soc/

The College of Engineering has also negotiated with vendors to provide excellent educational pricing on selected laptop models, which are available for purchase by any NCSU student, faculty or staff:

http://www.eos.ncsu.edu/soc/laptops/buying_new

Other colleges also have recommendations about student-owned computers that students in those colleges need to be aware of. Consult the web sites or IT staff of the college you are in.
ResNet

NCSU provides network services to students in the residence halls called ResNet.

http://www.ncsu.edu/resnet/

Although there are Unity labs in several of the residence halls, ResNet is primarily targeted at connecting student-owned computers to the university’s computer network and to the Internet. Since ResNet lies outside Eos and Unity computing, access to realm resources from the residence halls is via remote access. Excellent ResNet-specific information and resources are also provided at the ResNet web site.

NC State’s wireless network (see following) does not cover residence hall rooms. The way the buildings are constructed keeps this from being feasible. However, students have Ethernet ports in their rooms to access the network over a wired connection. Furthermore, students can bring and set up their own wireless access points for use in their rooms.

Wireless Access

NCSU provides wireless access to the campus network for students, faculty and staff. However, it not yet ubiquitous. To find wireless “hot spots” around campus where you can connect, see:

http://wireless.ncsu.edu

You will need a portable computer or handheld device that either has built-in wireless capability or can be adapted for it. The campus implementation of wireless networks includes 802.11a, 802.11b and 802.11g. Most new laptops come with 802.11n cards, which are compatible with all three, so laptops with 802.11n wireless should work anywhere on campus.

Account Policies and Security

Because campus computing facilities can only support the number of users they were designed for, access to Eos/Unity resources is restricted to NCSU faculty, staff and fee-paying students only. Users must never share their account passwords with anyone. Users also need to stay aware of and follow the policies that protect individual and campus use of NCSU computing resources. Consult the published policies at the web sites below, taking particular note of the ramifications for policy violations.

http://oit.ncsu.edu/n/rules-regulations

For your personal computers, NCSU provides anti-virus software free of charge for all currently enrolled students, faculty and staff. It is very important that you update your anti-virus software frequently. Also, make sure you install all security patches and bug fixes made available from the manufacturer.

http://oit.ncsu.edu/n/welcome-it-security
Getting Help

There are a number of resources available to help users learn to use the Eos/Unity environment, from documentation to one-on-one support. Principal support services for Eos/Unity come from the Office of Information Technology (OIT), available to all NCSU students, faculty and staff, and Information Technology and Engineering Computer Services (ITECS) in the College of Engineering. Additional help comes from other department and college IT organizations.

NC State Help Desk

The university help desk for computing is managed by the Office of Information Technology (OIT).

- **Call Center**: 2620 Hillsborough Street, Room 106. Phone hours: Mon-Fri 7am-6pm.
- **Walk-in**: 101 West Dunn Building (corner of Dan Allen Dr. and Thurman Dr.). Walk-in hours: Mon-Th 8am-8pm, Fri 8am-5pm. Bring NCSU ID.
- **Phone**: (919) 515-HELP (4357)
- **Fax**: (919) 513-0877
- **Email**: help@ncsu.edu (problems are entered into the Remedy call-tracking system)

ITD support sites:

- [http://help.ncsu.edu](http://help.ncsu.edu)
- [http://oit.ncsu.edu](http://oit.ncsu.edu)
- [http://sysnews.ncsu.edu](http://sysnews.ncsu.edu)

College of Engineering ITECS Help Desk

The College of Engineering help desk for computing is managed by Information Technology and Engineering Computer Services (ITECS). The ITECS main office is located in 213 Page Hall.

- **Hours and Locations**: 204 Daniels (515-2458, 8-5 M-F); 203 and 226 Daniels (515-3923, 24/7); 1203a EBII (513-0816, 8am-midnight). Bring NCSU ID.
- **Phone**: (919) 515-2458
- **Fax**: (919) 515-7463
- **Email**: eoshelp@ncsu.edu (problems are entered into the Remedy call-tracking system)

Eos support sites:

- [http://www.eos.ncsu.edu](http://www.eos.ncsu.edu)
- [http://www.itecs.ncsu.edu](http://www.itecs.ncsu.edu)
SysNews System News

NCSU maintains an IT systems news service at http://sysnews.ncsu.edu, which users should watch for information about the system. Lists of System Announcements and Upcoming System Events are posted to let users know of major changes, outages, enhancements, etc.

You can also get announcements particular to your college or group by selecting the More Announcements button under System Announcements and choosing the group you want from the pull-down menu.
Knowledgebase Search

The Help Desk Knowledgebase at http://help.ncsu.edu was built with questions sent to help@ncsu.edu and tracked in the Remedy Action Request System (ARS), which logs and tracks help calls. The help database has an easy-to-use interface for searching for answers to frequently-asked questions (FAQ).

Remedy Problem Tracking

The Remedy Action Request System (ARS) is the application that NCSU uses to track your calls to help@ncsu.edu, eoshelp@ncsu.edu, and other help mail addresses. Computing questions mailed to these addresses enter Remedy and are reviewed by the appropriate consultants.
**Describing the Problem**

Users can expect prompt and helpful assistance from consultants, but there are several ways that tracking and communication can break down. Persist when you need help, but also supply ample information about the problem you are having:

- If writing from a non-NCSU mail address, what is your name and Unity ID?
- Where were you logged in when the problem occurred?
- When did the problem occur?
- Provide problem details, e.g., pertinent URLs, file paths, software used, error messages, etc.

Adequate background on the problem makes it easier for the consultants to solve your problem in one response rather than several. Please be courteous and clear.

**Getting a Solution**

A user who sends mail to help@ncsu.edu first receives an automatic reply from the Help Desk to let him or her know that the mail was received and how to check on the call using the call-tracking number assigned to it. If a call cannot be handled by the consultants, or is intended for another computing group on campus, the call is placed in the work queue of another group. That group is then responsible for resolving the call.

Users who need to contact specific support groups can also mail directly into their work queues in Remedy with the workgroup@help.ncsu.edu address, e.g., regrec@help.ncsu.edu, wolfware@help.ncsu.edu, etc.

Your call will be logged, tracked, and answered in a timely fashion. To check the status of your call, enter your call number at http://help.ncsu.edu/myhelp.php.
Campus and College Computing Labs

There are more than 100 public labs on campus located in all of the places you are likely to need them, the library, residence halls, and academic buildings.

There are nine public Unity labs, which anyone with a Unity ID can log in and use.
http://oit.ncsu.edu/unity-labs/

The College of Engineering ITECS also maintains a large number of Eos labs and collaboratories:
http://www.eos.ncsu.edu/labs/
http://www.eos.ncsu.edu/collabs/

Eos labs can be used by anyone enrolled in an engineering class with an engr designation on their account. For example, the following is from a user’s Hesiod database record and shows the group list for an engineering student enrolled in the fall semester.


The engr_fall identifier, or “flag,” is what allows this student to log in to Eos labs in the current fall semester. Without an engr flag, you cannot log in to workstations in engineering buildings. You can check your Hesiod record at SysNews User Lookup, https://sysnews.ncsu.edu/tools-bin/user-lookup (or type hes unityid at a unity% prompt). Other colleges also have realm-based labs that may be restricted to their users.

All NCSU computer and network resources are governed by the policies described at http://oit.ncsu.edu/n/rules-regulations

Note: Printers in Unity and Eos labs (http://print.ncsu.edu) are managed by WolfCopy. Please contact them if you have problems with printing in labs, http://www.fis.ncsu.edu/materialsmgmt/wolfcopy/.

Unity Lab Policies

Unity labs are managed by the Office of Information Technology (OIT). Current policies governing the use of Unity labs and procedures for handling violations of policy are online at http://oit.ncsu.edu/n/rules-regulations. Individual Unity computing labs may post additional operational rules and restrictions, which users are responsible for reading and following.

1. All those who use University facilities are expected to take proper care of the equipment. Any equipment malfunction should be immediately reported to staff on duty or to the organization responsible for the facility. Users of computing facilities may not move, repair, reconfigure, or modify the computing systems. No food or drink is permitted in University computing facilities.

2. Recreational use of workstations in University computing labs during periods of light usage is permitted. No one may play games or engage in other recreational activities on workstations when others are waiting to use them for academic purposes. It is the responsibility of game players to recognize when resources are needed and to give up their seats to other users. It should not be necessary for someone to ask them to move.

3. Users must realize that they are in an academic facility and refrain from noise, sound effects, violent motion, etc., which may disturb others in the facility.
Eos Lab Policies

Access to Eos labs is restricted to the College of Engineering. Students must be enrolled in at least one engineering course to use Eos workstations. Engineering students can also use campus Unity labs. ITECS is responsible for the workstations in the Eos labs and for lab operators. Academic departments are responsible for the lab space itself. WolfCopy is responsible for maintenance and support of lab printers. The following are policies enforced in the College of Engineering Eos labs, http://www.eos.ncsu.edu/labs/, see also http://www.eos.ncsu.edu/policy.

1. You may not allow any other person to use your password or share your account. It is your responsibility to protect your account from unauthorized use by changing password periodically and using passwords that are not easily guessed.
2. Any attempt to circumvent system security, guess other passwords, or in any way gain unauthorized access to local or network resources is forbidden.
3. Transferring copyrighted materials to or from the Eos system without express consent of the owner is a violation of federal law. In addition, use of the Internet for commercial gain or profit is not allowed from an .edu site.
4. You are expected to take proper care of the equipment in Eos facilities. Report any malfunction to the Eos operator on duty, or contact the Eos help desk by calling 515-2458 or by sending an email to eoshelp@ncsu.edu. Do not attempt to move, repair, reconfigure, modify, or attach external devices to the systems. (Headphones, USB storage devices, and accessibility equipment are exceptions to this rule.)
5. Recreational use of Eos workstations during periods of light usage is permitted. However, you may not play games or engage in other recreational use of some resources if other users are waiting to login. Use of some services for recreational use, such as remote access servers, may be prohibited altogether.
6. Use of electronic mail and other network communications facilities to harass, offend, or annoy other users of the network is forbidden.
7. Food, drink, and smokeless tobacco products are not permitted in any Eos labs. This policy is closely related to policy #4.
8. Individual Eos labs can post additional operational rules and restrictions that are considered part of the Eos User Policy. Users are responsible for reading and following these rules.
9. Owners of cell phones should exercise courtesy to those around them by taking personal calls that are longer than 15 seconds to an area away from computing facilities, preferably outside the building or in lounge areas. Ringers should be set on the lowest setting or on vibrate. Voices should be kept low when speaking so that the labs remain conducive to work and study.

Violations of policy will be treated as academic misconduct, misdemeanor, or felony as appropriate. As a standard rule, a warning will be issued upon a user's first policy violation. The user will then be asked to sign a copy of this policy statement to document that he or she understands and is willing to comply with the above policies. In general, a second violation will be referred to the Office of Student Conduct, 1115 Pullen Hall, Box 7321, at which point the user will work with persons from the Office of Student Conduct to resolve the policy violation.

Vandalism, theft, harassment, security violations, and misuse of computing resources are grounds for dismissal from the University. Computers are for academic use only. No commercial use of resources is permitted.
College Labs

Several colleges and departments maintain computing labs for their students (see list below), which may be restricted for use only by students in the college or department, or open to all NCSU students. You will need to contact the college or department to find out if you can use the lab.

CALS Labs:  http://harvest.cals.ncsu.edu/caat/index.cfm?pageID=777
CHASS Labs:  http://chasslabs.chass.ncsu.edu/
Design Labs:  http://ncsudesign.org/content/index.cfm/mode/1/fuseaction/page/filename/it_lab.html
Education Labs:  http://ced.ncsu.edu/edit/comp_labs.php
Management Labs:  http://mgt.ncsu.edu/index-exp.php/computing/entry/lab-information
PAMS Labs:  http://www.pams.ncsu.edu/students/computerlabs.php
Textiles Labs:  http://www.tx.ncsu.edu/departments/it/tco/computerlabs/

Accessible Labs

The university's mission is to serve all its students, including those with disabilities. For current information about technologies and computing labs available on campus to persons with disabilities:

http://www.ncsu.edu/dso/at/
http://ncsu.edu/it/access/services/comlabs.php
The User's Home Directory

The first question you are bound to ask after you log in is, “Where am I?” The various platform interfaces with their application launchers and menus show you what you have to work with. But where are the files stored that you create? After you log in and the system knows who you are, you are placed by default in your home directory. All files you create are automatically saved there unless you change the path. This file storage space is accessible to you from any platform, but what it is called and how you get to it varies.

User File Space and Location

Everyone with a Unity account is given a home directory in the campus AFS file system with a base quota of 50 MB, which the user can increase via the Quota Manager at http://sysnews.ncsu.edu (350MB total file storage limit per user). Your home directory is configured to keep your files and data secure, and only you can use it.

Names for User File Space

Your home directory is sometimes referred to by other names, e.g., Unity locker, AFS locker, My AFS, user volume, K: drive. Some of these terms are fairly self-explanatory references to your home file space in Unity/AFS. Others are more cryptic.

For example, your home directory is mapped (shortcut) to the K: drive on Windows workstations, coining "my K drive" as one of the more common terms for personal file space. The My Documents folder on your Windows desktop also points to the K: drive and your AFS file space. Remember that this is a platform-specific term. You will not be able to find a K: drive on Solaris, Linux or Mac workstations, but you can certainly access your home directory and files.

Another common term is locker, a file collection belonging to a user, project, software application, etc. Technically, a locker is an AFS volume, which is a container that keeps a set of related files and directories together on a disk partition in AFS. It has its own quota and permission settings. On Eos/Unity, one AFS volume is used for each user’s home directory.

Location of User Home Directories

User directories are stored (distributed) on many file servers on the campus network. AFS does this distribution and management, including backup, so users do not need to know the exact machine on which their files have been stored. Instead of a fixed physical location, users are given a fixed path to their user volume or home directory. Only one location exists in AFS for each user’s home directory. This location does not change, although ways to access it vary (read more about the AFS File System on page 93).

When you log in, you are automatically placed in your home directory, which is several levels down from the top of the AFS file tree. The path originates in the root /afs directory, which encompasses other sites in the world that run AFS. Unity (unity.ncsu.edu), Eos (eos.ncsu.edu), and Backbone Protocol (bp.ncsu.edu) are cells that make up the NCSU AFS site, and they in turn branch into more directories.

User volumes reside in a common users directory in the Unity AFS cell, /afs/unity.ncsu.edu/users/ (a shorter pathname to this space is /afs/unity/users/). Some early users of the system, principally in engineering, may have accounts in the Eos cell, /afs/eos.ncsu.edu/users/ (also accessed by the shorter pathname, /afs/eos/users/).

User directories are further organized alphabetically starting by the first letter of the Unity ID. For example, the home directory for John Q. Public, or jqpublic, is located in /afs/unity/users/j/, not in the p directory for his last name. The full pathname of jqpublic’s home directory is /afs/unity.ncsu.edu/users/j/jqpublic/. Most accounts are
in Unity file space, not Eos, but you can check [https://sysnews.ncsu.edu/user-lookup/](https://sysnews.ncsu.edu/user-lookup/) to find this and other information about your account.

### AFS File Tree: NCSU Cells (bp, eos, unity) and the Unity users Directory

```
/afs/
  athena.mit.edu  bp.ncsu.edu  cmu.edu  eos.ncsu.edu  umich.edu  unity.ncsu.edu...
    contrib  dist  engwww  courses  lockers  lockers  users
      jdk  openoffice  pine  ansys  matlab  sas  acc...e...z
        acc100...acc630  e115  zo150...zo0885
          bin...src
        archived  common  lec  prep
          e115_00112002...e115_00482003  EcsLabs  Review  www  001...624
            index.html
                graded  submitted
                  assignment  assignment
                    userid  userid
                      graded-file.xxx  submitted-file.xxx
```

### Access to Your Home Directory on Solaris and Linux

On Solaris and Linux, there are shortcuts to your home directory, just like on Windows and Mac platforms.

However, you can also access your home directory from the command line at the `unity%` or `eos%` prompt in a terminal window. The `cd` command typed by itself will always return you to your home directory. The `pwd` (path of working directory) command will display the path of the directory you are in. When you save files, they are saved by default to your AFS home directory, unless you change the path to save elsewhere.
Your personal web pages are also delivered from your home directory. If you have a www subdirectory or folder in your home file space (/afs/unity/users/a-z/unityid/www/) that contains an index.html or index.htm file, the campus web servers will find it on their next update and automatically deliver the page from http://www4.ncsu.edu/~unityid.

To move through all the directories to get to your home directory, start in the root of the AFS file tree, or /afs. List (ls) or change directories (cd) in a terminal window to move through directories. For example, to navigate to /afs/unity/users/x/xman/:

The Permission denied error means that you cannot go any farther because you are not xman. Your own home directory is one of many user directories in AFS, and only you can access it.

Access to Your Home Directory (K: Drive) on Windows

On campus Windows machines, the path to your home directory is mapped (shortcut) to the K: drive, so it acts like your local C: drive. When you save files to the K: drive, you are saving to your home directory in AFS.
The top level of the AFS file tree, or /afs, is mapped to the J: drive, or all on (J:), on Windows. The AFS path /afs/unity/users/x/xman/ is J:unity/users/x/xman/ on Windows. In the terminal window of Solaris and Linux workstations, you cd through directories to get to this space. Working through the graphical interface on Windows and Linux workstations, you simply open folders. Again, if you are trying to access a home directory that is not your own, you will get an "access denied" message and will not be able to move down the tree.
Access to Your Home Directory on Mac

On Mac computers in Unity labs, your home directory is easy to locate on the Desktop as MyAFS.
Backups and Restores

All user volumes (home directories) and user IMAP mail are backed up nightly on campus servers. However, because every user’s space is a limited resource, users should get rid of files they do not need and routinely back up files of importance on a removable storage medium. All lab workstations have a variety of drives and USB ports for you to use.

Preserving files that are important (an end-of-the-semester project, dissertation, important research, etc.) is ultimately the responsibility of the users who create them. However, if you happen to lose a file, there are procedures in place to help you restore from backup.

Backup Procedures

All user volumes are backed up every 24 hours. Part of the backup process is the generation of backup volumes. Backup volumes are generally created shortly after midnight, and they exist unaltered until the next time a backup volume is created. Backups are made from a snapshot of your files as they exist on or around midnight of that day. For example, files you restore on a Thursday are as they existed when you quit working on Wednesday.

In order to restore a deleted file, the file must have been copied to backup at some time. It is not possible to restore a file that was never backed up. In other words, if you delete a new file that you just created, you will not be able to restore it because it has never been copied to backup.

Restore Procedures

Tape backups exist for the previous 28 days. You can do your own restore if you need a backup from yesterday. If you need a backup from days prior to yesterday, you will need to request a restore. Nothing older than 28 days can be restored. If you need to restore files, follow the instructions at these locations:


Restoring files from tape backups is a labor-intensive and time-consuming process. As a result, system administrators are limited to performing only two restores per person. **Please note that backups are only kept for 28 days.** When you write to help@ncsu.edu, please provide:

• your Unity ID
• name of the file
• name of the directory in which it resides
• the date when the file was last known to be on the system


This help solution will enable you to restore your own files, but only from the previous day's backup.
Personal Web Pages

The university provides software and servers to enable students, faculty and staff to create a presence for themselves on the web. These personal web sites are generally used to present the academic work and professional efforts of the individual, e.g., portfolios, resumes, etc. Because personal web sites are served to the web under the university's name, users should make sure that the material presented is appropriate.

From OIT's statement on *What's Allowed on Web Pages*:

Authorized users may access University computing equipment, systems and networks for personal uses if the following conditions are met:

1. The use is **lawful under federal and state law**.
2. The use **does not violate any policy or directive** of the Board of Governors, the NC State Board of Trustees, the UNC General Administration, or the NC State administration.
3. The use **does not overload the University computing equipment or systems, or otherwise negatively impact the system's performance**.
4. The use **does not result in commercial gain or private profit**, except as allowed under University intellectual property policies and the external activities for pay policy. However, in no case may University computing resources be used for solicitation of external activity for pay.
5. The use **does not violate any** University licensing agreements or any law or University policy on **copyright and trademark**.
6. The use **does not state or imply University sponsorship or endorsement**.
7. The use **does not violate laws or University policies against race, sex, religious, disability, or age discrimination, or harassment**.
8. The use **does not involve unauthorized passwords or** identifying data that attempts to **circumvent system security** or in any way attempts to gain unauthorized access.
9. The use **does not involve sending or soliciting chain letters**, nor does it involve sending unsolicited bulk mail messages (e.g., "junk mail," or "spam," or "MLM.").
10. The use **does not result in any direct cost to the University**.
11. Any creation of a personal World Wide Web page or a personal collection of electronic material that is accessible to others must include a **disclaimer** that reads as follows: "The material located at this site is not endorsed, sponsored or provided by or on behalf of North Carolina State University."
12. University computers must be registered with NC State in the ncsu.edu domain. **It is forbidden to register a non-ncsu.edu domain for any computer which is connected to the NC State network** without prior approval of the Associate Vice Chancellor for Finance and Information Systems or the Vice Provost for Information Technology. If such approval is given, it must be made clear that the non-ncsu.edu address is using NC State resources for delivery.

For security reasons, the www4 servers do not support the use of scripts (e.g., CGI, Perl, PHP). This means that your personal Web pages on these servers cannot contain features such as:

- Blogs
- RSS feeds
- Forms

College of Engineering faculty, staff and students have support for **personal web space** (http://people.engr.ncsu.edu/unityid/), which permits the use of scripts, forms, feeds, blogs, databases, etc., but the same policies as above apply on engineering Eos web servers as well.
Publishing Your Web Pages on www4

You can publish your own web pages from your home directory in AFS via the www4 server provided by the Office of Information Technology (OIT). You create your home page and other web pages in a www directory in your home directory, e.g., /afs/unity/users/j/jqpublic/www/. Then you set the access rights on the directory so that other people can read it at its web location (URL) at http://www4.ncsu.edu/~unityid/. OIT has a very helpful web resources at

http://oit.ncsu.edu/afs/www-setup

Using the WWW Setup Utility

You can use a web tool at SysNews to set up your web site and assign proper access rights automatically:

https://sysnews.ncsu.edu/tools-bin/www-setup

Welcome to the WWW setup utility. This utility will set up your www directory so it works properly with our web servers. To use it, you will need to enter your unity password in the field below, and click on Set Up My Web Space. Afterwards, your web space will be accessible via http://www4.ncsu.edu/~mcdaniel. Whatever you put in your www directory at that point will be visible by the rest of the world.

Note: This utility will not harm anything that is currently in your www directory.

If you are ready to get started, enter your password below and click the button.

Password: 

Set Up My Web Space

This utility will set up your www directory so it works properly with campus web servers. To use it, you just enter your Unity password in the field provided at the web page and click the button, Set Up My Web Space. Afterwards, your web site will be displayed at http://www4.ncsu.edu/~unityid. Whatever you put in your www directory will be visible to the rest of the world.

Note: This utility will not harm anything that you might already have in your www directory.

Your Personal URL

All NCSU people (faculty, staff and students) with personal web pages are on the www4 server, so the http://www4.ncsu.edu/ part of the URL is the same for everyone.
The ~ stands in place of the full directory path, assuming that your web pages are in the www subdirectory of your home directory. Web servers are set up to display index.html or index.htm automatically if this file exists in your/unityid/www/ directory.

**Note:** In fall 2010, students will be able to use Google Apps @ NC State, which includes Google Sites for creating web sites. Please watch [http://google.ncsu.edu/](http://google.ncsu.edu/) for more information.

**Responsibility for Web Pages**

In creating documents for the web, remember that your information is being served from university computers, and your URLs bear the university's name. For this reason, please make sure that what you present in your pages is appropriate since the content and use of your pages are subject to university policy. The intent of the university in providing these facilities and encouraging student use of the web is educational. Please keep your activities within that arena so that these facilities remain available to others in the future with minimal need for supervision and restriction.

**Publishing Web Pages at http://people.engr.ncsu.edu (Engineering only)**

If you are a student, staff, or faculty member in the College of Engineering, you can publish your web pages at [http://people.engr.ncsu.edu/unityid/](http://people.engr.ncsu.edu/unityid/).

Request a **Personal** locker at

[http://www.eos.ncsu.edu/services/web/](http://www.eos.ncsu.edu/services/web/)

Two directories are automatically created in the locker when it is requested:

- `www` for holding content delivered to the web at [http://people.engr.ncsu.edu/unityid/](http://people.engr.ncsu.edu/unityid/):
  
  /afs/eos/lockers/people/a-z/unityid/www/

  e.g.,

  /afs/eos/lockers/people/j(jqpublic/www/ (delivered as [http://people.engr.ncsu.edu/jqpublic/](http://people.engr.ncsu.edu/jqpublic/))

- `private` for non-web AFS space

  /afs/eos/lockers/people/a-z/unityid/private/

  e.g.,

  /afs/eos/lockers/people/j(jqpublic/private/

PHP and MySQL databases are permitted in this web space.

**Creating HTML Documents**

Although this guide does not offer a full explanation of how to write HTML documents, a list of HTML tags follows that will help you as a reference after you learn the basics.

The Windows and Mac labs also have popular web tools in them, including the Adobe Creative Suite suite with full versions of **Dreamweaver, Flash, Fireworks, Photoshop, Illustrator, InDesign, Contribute, Acrobat Professional**, and others.
HTML is a system of nested tags that open and close; every open tag < > must have a close tag </ >. An HTML document is generally set up on a page with these minimal elements:

```html
<html>
<head>
<title> </title>
</head>
<body>
</body>
</html>
```

The whole document is placed inside the <html></html> tags. Make sure that there is a clear, descriptive title between the <title> </title> tags, which is placed inside <head> </head>. Between the <body> </body> tags, you create your document.

For help in creating pages on Solaris/Linux, you may want to explore the following lockers:

```bash
add webbrowsers
cd /ncsu/webbrowsers/bin/
add imagetools
cd /ncsu/imagetools/bin/
```

And other tools at /afs/bp/contrib/

**Some HTML tags:**

- `<address>` Address or signature for a document, italicized
- `<a href=" "> Hyperlinked reference, e.g., `<a href="reffile.html">link</a>`
- `<b>` Bold text
- `<blockquote>` Quoted passage
- `<body>` Document body
- `<br>` Line break, single spacing
- `<cite>` Name or title of cited work
- `<code>` Short words or phrases of source code
- `<dd>` Definition of a term in a definition list
- `<dl>` Definition list or glossary
- `<dt>` Term in a definition list
- `<em>` Emphasized phrase
- `<h1>` Heading, level 1
- `<h2>` Heading, level 2
- `<h3>` Heading, level 3
- `<h4>` Heading, level 4
- `<h5>` Heading, level 5
- `<h6>` Heading, level 6
<head></head> Document head
<hr> Horizontal ruled line
<html></html> HyperText Markup Language Document
<i></i> Italic text
<img> Link to image, e.g., <img src="file.gif">
<li> List item, used with ordered <ol> or unordered <ul>
<ol></ol> Ordered or numbered list
<p> Paragraph, double spacing
<pre></pre> Preformatted text
<strong></strong> Strong emphasis
<title></title> Title of document (Important! Every document needs one.)
<ul></ul> Unordered or unnumbered list, with bullets
Software on Eos/Unity

One of the greatest strengths of the Eos/Unity environment is its suite of application software. Applications are available in many disciplines to support productivity computing, computing in the major, and research computing. All combined, there are hundreds of applications across the platforms: Solaris, Windows, Linux and Mac. Because students will use these programs again in the professions they enter after graduating, their introduction to this software at NCSU is a valuable addition to their education. The principal web sites for application software on Eos/Unity are:

http://www.ncsu.edu/software/
http://www.eos.ncsu.edu/software/

Individual applications are usually available in more than one lab, so getting access when you need it is fairly easy. Also, some software applications are available on more than one and sometimes all platforms, so you can move among platforms to work on your files.

• **Windows applications** are listed on the **Start** menu under **Programs**.
• **Solaris applications** can be found on the **Launch** menu and by typing **add** on the command line.
• **Linux applications** can be found on the **Applications** menu and by typing **add** on the command line.
• **Mac applications** are in the **Admin Launcher** (there are no Macs in Eos labs).
• Applications via remote access also run in the **Virtual Computing Lab (VCL)** at [http://vcl.ncsu.edu](http://vcl.ncsu.edu).

Documentation to support Eos/Unity software applications is often online inside the program under **Help**. If there are manuals available in PDF or HTML versions, they will be identified at [http://www.eos.ncsu.edu/software/](http://www.eos.ncsu.edu/software/).

Applications available for download to personal computers are at:


Graphical User Interfaces and Windowing Environments

The “look and feel” of the workstation environment is defined by the operating system and its interface software. This software governs how the user interacts with the workstation to access Eos/Unity resources and run applications. Sun Solaris, Red Hat Enterprise Linux (RHEL), Microsoft Windows 7 and Vista, and Apple Mac OS X have all been adapted and configured for Eos/Unity workstations. Although they connect to many of the same resources, they have substantially different user interfaces. You can move among them fairly easily, but you have to learn to do many things in different ways.

The first thing you see after you log in is the user interface. All Eos/Unity workstations, no matter the operating system, support a **graphical user interface**, or **GUI** (pronounced “gooey”). The appearance of windows on the user interface, or of screens within a screen, is created by a **window manager**. Windows are the **modus operandi** for displaying and running applications and for communicating with the operating system. Although the dominant metaphor of the graphical environment is the window, the interface also employs the metaphor of the **desktop**. The desktop is the screen background, or **root window**, and windowed applications and icons are displayed on top of it.
Solaris Applications

Solaris is the oldest realm platform and principally used by faculty and students in engineering and the sciences. The software applications in Eos Solaris labs usually require the exceptional graphics and processing speed you find on Sun workstations.

No applications are displayed on the Solaris desktop by default when you log in. Instead, the most common applications on this platform are brought up from the Launch menu in the lower left of the screen.

Note: When launching an application on a Sun workstation, you often must wait awhile before it appears on-screen (more than a minute at times). Be patient. Do not keep launching it again and again. If you do, you will get multiple copies of the program running on your machine and slowing down its processing.
The add Command

Not all applications are available from the Launch menu. Most are launched from the command line in an Xterm window (right-click background and select Open Terminal).

Typing `add` on the command line brings up a full list of the main applications that run on Solaris workstations. It usually takes two commands to launch an application. The first command is `add` followed by the name of the software you want to use. This command attaches the software locker and sets up the application on your workstation. It also runs any startup programs that are in the locker.

The second command (shown after the comma below) is the command to execute the program. For example, to launch Matlab:

```
add matlab
matlab
```

The following applications are on Solaris 10 workstations.

- Acrobat (Adobe) Reader 7.0 (add acroread, acroread [file])
- Adams 2010 (add adams, adams2010)
- Eclipse GANYMEDE 3.4.1 (add eclipse, eclipse)
- Eos Editors (add eoseditors)
  - emacs2220 (add emacs2220 emacs)
  - eclipse (add eclipse, eclipse)
  - nano (add nano, nano)
  - nedit (add nedit, nedit)
  - pico (add pico, pico)
  - vim (add vim, vim)
  - slickedit (add slickedit, vs)
  - zile (add zile, zile)
- Eos PostScript and PDF Tools (add eospsutils)
  - a2ps (add a2ps)
  - putils117 (add putils117)
  - ghostscript (add ghostscript)
  - enscript (add enscript)
  - gv (add gv, gv)
  - xpdf (add xpdf)
  - pstoedit (add pstoedit, pstoedit)
- Fortran95 NAGware Compiler 5.1 (add nagf95, f95 input_file)
- Fortran95 NAGware Compiler 5.0 (add nagf95_50, f95 input_file)
- GIMP GNU Image Manipulation 1.2 (add gimp, gimp)
- GMag Screen Magnification 0.2 (add gmag, gmag-gnome)
- GNU binutils 2.18 (ld linker + others) (add binutils)
- GNU CC (GCC) 3.4.6 (add gcc346, gcc/g++)
- GNU CC (GCC) 2.95.3 (add gcc295, gcc/g++)
- GNU Debugger gdb 6.7.1 (add gdb, gdb gdbtui)
- GNU make 3.80 (add make, make)
- GNUplot 4.2.6 (add gnuplot, gnuplot)
- ILOG CPLEX 12.1 (add ilog, cplex)
• ILOG OPL Studio 6.3 (add ilog, oplrun)
• ILOG CPLEX 11.0 (add ilog110, cplex)
• ILOG OPL Studio 5.5 (add ilog110, oplrun)
• Image and Graphics Tools (add imagetools)
• Java Developer's Kit 6.0 (1.6.0) (add jdk)
• Java Developer's Kit 5.0 (1.5.0) (add jdk50)
• LaTeX Document Preparation 3.14159 (add tetex3, latex)
• Maple Symbolic Math Computation 13.0 (add maple130, xmaple)
• Maple Symbolic Math Computation 12.0 (add maple120, xmaple)
• Maple Symbolic Math Computation 11.0 (add maple110, xmaple)
• Maple Symbolic Math Computation 10.0 (add maple, xmaple)
• Mathematica 5.2 (add mathematica, mathematica)
• Math Libraries and Tools (add mathtools)
• MATLAB Matrix Computation 7.8 R2009a (add matlab78, matlab)
• MATLAB Matrix Computation 7.6 R2008a (add matlab76, matlab)
• MATLAB Matrix Computation 7.2 R2006a (add matlab, matlab)
• NeXS Spreadsheet 1.6 (add nexs, nexs)
• OpenOffice.org 3.2.0 Office Suite (add openoffice)
• OpenOffice.org 3.1.1 Office Suite (add openoffice311)
• OpenOffice.org 3.1.0 Office Suite (add openoffice310)
• OpenOffice.org 3.0.1 Office Suite (add openoffice301)
• OPNET Network Modeler 14.0 (add opnet140, modeler)
• OPNET Network Modeler 11.5 (add opnet115, modeler)
• Pro/ENGINEER Wildfire 4.0 (add proe, proe)
• Remote Desktop for VCL 1.6.0 (add rdesktop, rdesktop [ops] [server])
• Remote Desktop for VCL 1.5.0 (add netutils, rdesktop [ops] [server])
• Ruby programming language (add ruby186, ruby)
• SlickEdit Program Editor 11.0 (add slickedit, vs)
• Tecplot 360 2010 (add tecplot, tec360)
• Tecplot 360 2009 (add tecplot3602009, tec360)
• Tecplot 360 2008 (add tecplot3602008, tec360)
• Tecplot 360 2006 (add tecplot3602006, tecplot)
• Xfig 3.2.4 (add xfig, xfig)

Sun Solaris: X, Java Desktop, and Command Shell

The default user interface for the Solaris workstation is created by the Java Desktop System (based on GNOME) for the X Window System, Version 11. The X Window System was developed at MIT and is now distributed by X.org. Also called X Windows, or X11, this software is similar to Microsoft Windows. However, X can support many window managers, which is the software that is responsible for making the windows look and operate in the same way. Together, X with the Java Desktop and Metacity window manager create the look and feel of Eos/Unity on the Sun Solaris workstation.

The background is the desktop, or root window, on which all windows, icons, and screen contents are displayed. Users of Solaris workstations also routinely use a command-line interface, whereby they interact with the computer and its operating system through commands issued at a shell prompt (appears as unity% or eos%) in an Xterm terminal window. These commands are interpreted, executed, and passed to the Solaris operating system by the shell program.
Background and Foreground Processes

Programs running on your computer are called *processes*, and they exist in one of three states: *background*, *foreground*, or *stopped*. *Multitasking* makes it possible to run a number of programs at the same time on the same machine.

When a program is started from the command line, it becomes a *child process* of the shell program running in the terminal window. The shell has to keep track of the program because it is running in the foreground. A foregrounded process has read and write access to the controlling terminal window, so the shell must wait until the processing is finished before returning the prompt. However, if you add an ampersand (&) after the executing command (*matlab &*), it tells the shell to run the program in the background so it does not tie up the shell. The shell returns the prompt, and you can use the terminal window to run other commands.

If you decide you want to background a process that has already been launched in the foreground, type **Control+z** (hold down the *Control* key and type *z*). This command puts the process in a stopped or suspended state and gives you back the prompt (**Control+c** aborts a process).

To background the process:

```
bg
```

To bring a stopped process to the foreground:

```
fg
```

Solaris assigns a unique reference number, called a *process identification* (*PID*) number, to each process running. Users refer to the process identification number (*PID*) when they want to affect a process in some way. To see what processes are running on your workstation:

```
ps -e (or -ef)
```

To end or “kill” a process running:

```
kill pid#
```

Windows Applications

Users will find the Windows interface more familiar to them than the interfaces of other Eos/Unity platforms because of the widespread use of Windows at home and in the workplace. Windows workstations run Vista or Windows 7 and Microsoft Active Directory, developed in the Wolftech Active Directory project by the Department of Electrical and Computer Engineering.

To launch a program you want to use, select it from the *Programs* list on the Windows Start icon at the bottom of the screen.
Windows applications vary from lab to lab because colleges and departments provide different software for their students, e.g., engineering applications will only be in Eos labs. However, the applications in Unity labs are generally available to everyone, regardless of lab or location.

Applications and processes are identified and monitored on Windows by the Task Manager, which is brought up by right-clicking in the gray area of the task bar at the bottom of the screen. Selecting the Applications tab shows you what applications are running. The Processes tab shows all background and foreground programs running and provides a full accounting of session activity. To quit an application or process, select it and then select the End Task button.

You should always save your files to your Documents (K:) folder, which points to your Unity (AFS) home directory (your K:\ drive). You can also choose to save your file to another medium (e.g., external hard drive, USB memory disk, CD, DVD).

**Note:** Be careful not to save any files to the local workstation. Files stored locally are not backed up and could be deleted if the machine gets re-installed.
Linux Applications

Campus Linux Services, or CLS, supports the Linux Realm Kit, or Realm Linux. The most up-to-date information can be found at http://www.linux.ncsu.edu. Executing applications on Linux can be done by typing add, as on Solaris. Programs can also be launched from the bar at the top of the screen; there are pull-down menus for Applications, Places, and System.

The GNU Network Object Model Environment (GNOME) is the desktop environment that runs on the campus Eos/Unity Linux platform and creates the graphical user interface. It has been customized to give users easy access to applications and utilities that run under Linux.

You can type add in a terminal window to display a list of applications on the workstation, just as you do for Solaris. Like Solaris, the user can add and launch software with the two commands provided in the list, e.g.,

```
add matlab
matlab &
```

The handling of processes is identical to the way they are handled on Solaris. A Windows-style task bar appears at the bottom of the screen to show what is running.

The following applications are on Linux workstations.

- Abaqus 6.8 (add abaqus, abaqus cae)
- Abaqus 6.7 (add abaqus67, abaqus cae)
- Acrobat (Adobe) Reader 7.0 (add acroread, acroread file.pdf )
- Acrobat (Adobe) Reader 5.0 (add acroread50, acroread file.pdf)
- Acrobat (Adobe) Reader 4.0 (add acroread40, acroread file.pdf)
- Adams 2010 (add adams, adams2010 )
- Agilent ADS/RFDE 2006A (add ads2006a)
- Agilent ADS/RFDE 2006A Update 2 (add ads2006au2)
- Ansoft HFSS 11 (add hfss11, hfss)
- ANSYS Finite Element Analysis 12.1 (add ansys, launcher121)
- Cadence Circuit Design Toolkit 2008 (add cadence)
- Cadence Circuit Design Toolkit 2005 (add cadence2005)
- Eclipse GANYMEDE 3.4.1 (add eclipse, eclipse)
- Eos Editors (add eoseditors)
• cooledit (add cooledit)
• emacs2220 (add emacs2220)
• nano (add nano)
• nedit (add nedit, nedit)
• pico (add pico, pico)
• vim (add vim)
• slickedit (add slickedit, vs)
• zile (add zile, zile)

• Eos PostScript and PDF Tools (add eospsutils)
  • a2ps (add a2ps)
  • psutils117 (add psutils117)
  • ghostscript (add ghostscript)
  • enscript (add enscript)
  • gv (add gv, gv)
  • xpdf (add xpdf)
  • pstoedit (add pstoedit, pstoedit)

• Fortran95 NAGware Compiler 5.1 (add nagf95, f95 input_file)
• Fortran95 NAGware Compiler 5.0 (add nagf95_50, f95 input_file)
• GIMP GNU Image Manipulation 1.2 (add gimp, gimp)
• GMag Screen Magnification 0.2 (add gmag, gmag-gnome)
• GNU binutils 2.18 (ld linker + others) (add binutils)
• GNU CC (GCC) 3.4.6 (add gcc346, gcc/g++)
• GNU CC (GCC) 2.95.3 (add gcc295, gcc/g++)
• GNU Debugger gdb 6.7.1 (add gdb, gdb gdbtui)
• GNU make 3.80 (add make, make)
• GNUplot 4.2.6 (add gnuplot, gnuplot)
• Grace 5.1.17 (add grace, mgrace)
• HSPICE Elec. Circuit Simulator (add hspice, hspice)
• ILOG CPLEX 12.1 (add ilog, cplex)
• ILOG OPL Studio 6.3 (add ilog, oplrun)
• ILOG CPLEX 11.0 (add ilog110, cplex)
• ILOG OPL Studio 5.5 (add ilog110, oplrun)
• Image and Graphics Tools (add imagetools)
• Java Developer's Kit 6.0 (1.6.0) (add jdk)
• Java Developer's Kit 5.0 (1.5.0) (add jdk50)
• Java Developer's Kit 1.4.2 (add jdk142)
• Java Developer's Kit 1.4.0 (add jdk140)
• Java Developer's Kit 1.3.1 (add jdk131)
• LaTeX Document Preparation 3.14159 (add tetex3, latex)
• Maple Symbolic Math Computation 11.0 (add maple110, xmaple)
• Maple Symbolic Math Computation 10.0 (add maple, xmaple)
• Maple Symbolic Math Computation 9.5 (add maple95, xmaple)
• Maple Symbolic Math Computation 9 (add maple90, xmaple)
• Maple Symbolic Math Computation 8 (add maple80, xmaple)
• Maple Symbolic Math Computation 6 (add maple60, xmaple)
• Mathematica 5.2 (add mathematica, mathematica)
• Math Libraries and Tools (add mathtools)
• MATLAB Matrix Computation 7.2 R2006a (add matlab, matlab)
• MATLAB Matrix Computation 7.1 Rel 14 (add matlab7sp3, matlab)
• MATLAB Matrix Computation 5.3 (add matlab53, matlab)
• Mentor Graphics Tools (add mg_info)
• NeXs Spreadsheet 1.6 (add nexs, nexs)
• OpenOffice.org 3.2.0 Office Suite (add openoffice)
• OpenOffice.org 3.1.1 Office Suite (add openoffice311)
• OpenOffice.org 3.1.0 Office Suite (add openoffice310)
• OpenOffice.org 3.0.1 Office Suite (add openoffice301)
• OPNET Network Modeler 15.0 (add opnet150, modeler)
• OPNET Network Modeler 14.5 (add opnet, modeler)
• OPNET Network Modeler 14.0 (add opnet140, modeler)
• OPNET Network Modeler 12.1 (add opnet120, modeler)
• OPNET Network Modeler 11.5 (add opnet115, modeler)
• Remote Desktop for VCL 1.6.0 (add rdesktop, rdesktop [ops] [server])
• Remote Desktop for VCL 1.5.0 (add netutils, rdesktop [ops] [server])
• Ruby programming language (add ruby186, ruby)
• Second Life (add secondlife, secondlife)
• Silvaco Int. Circuit Design 2008 (add silvaco)
• Silvaco Int. Circuit Design 2006 (add silvaco2006)
• SlickEdit Program Editor 11.0 (add slickedit, vs)
• Synopsys Suite of Tools (add synopsys_info)
• Tecplot 360 2010 (add tecplot, tec360)
• Tecplot 360 2009 (add tecplot3602009, tec360)
• Tecplot 360 2008 (add tecplot3602008, tec360)
• Tecplot 360 2006 (add tecplot3602006, tecplot)
• Virtutech Simics 3.0.8 (add simics308, simics)
• Virtutech Simics 2.0.12 (add simics, simics)
• Xfig 3.2.4 (add xfig, xfig)

Mac Applications

There are Mac workstations in all Unity labs but not in Eos labs. There are also Mac workstations in many college labs. They are available for use by all students, faculty and staff who have active Unity accounts.

When you log in to a Mac OS X workstation, you will see an Admin Launcher window from which you can view and launch available applications. Additionally, you can access applications from the Applications folder on the Macintosh HD.
Commercial and Non-Commercial Software

Commercial software is purchased and licensed by NCSU upon recommendation by faculty for use in classes and research. For these packages, NCSU offers support and maintenance.

Non-commercial software is not covered by an explicit contractual agreement with NCSU. It includes freeware, shareware, public-domain software, and software that is freely available for non-commercial or academic use. It may or may not be licensed, copyrighted, or in other ways protected by law. These packages are installed on the Eos/Unity system by NCSU staff, but in general are not developed or distributed by NCSU. Also, no upgrades or new versions are guaranteed. Many of these programs are excellent, but you must use them at your own risk.

Software for Download

NCSU and the College of Engineering have licensed software for use on student- and faculty-owned computers. You must meet the requirements set by the vendor in order to download software. The requirements vary by application. All download pages are WRAP-protected and require your Unity ID and password to log in.

Unity software downloads: http://www.ncsu.edu/software/get-software/
Eos software downloads: http://www.eos.ncsu.edu/software/downloads/
Printing

Thanks to Kathy Mayr and Jessie Henninger for their contributions to this chapter.

Printing is a network service on Eos/Unity, called WolfPrint (http://print.ncsu.edu). There is no printer connected to individual workstations in the labs. Rather, every lab has at least one high-end laser printer that handles the printing requirements of all of the lab’s workstations. Printers are provided and maintained by the campus WolfCopy department.

A full list of printers in labs can be found at:

http://print.ncsu.edu/listofprinters.php

WolfPrint charges individual users per printed page. WolfCopy uses this revenue to cover the cost of paper, toner, maintenance, and repairs.

http://www.fis.ncsu.edu/materialsmgmt/wolfcopy/wolfprint

Contact WolfCopy if you have problems with the printing hardware or print quota issues, wolfcopy@ncsu.edu (515-2197). The printers are complex and expensive pieces of equipment that users should not try to fix themselves.

Contact IT help at help@ncsu.edu for problems with printing from applications.

Your WolfPrint Quota Account

All Unity users have a WolfPrint Quota Account, which is charged for any printing that users do in the labs. Most printing is $0.06/page, $0.25/page for color, and $0.80/page for large format.

All Eos/Unity labs and workstations use the same print quota debit system. To print from an Eos or Unity lab workstation, you must first purchase print quota, which you can buy online with a credit card. You can purchase a minimum of $5.00 and a maximum of $100.00 of print quota in one transaction. Purchases can be made using a credit/debit card bearing a Visa or Mastercard logo.

A complete list of printers, models, locations, and cost of printing on each is at:

http://print.ncsu.edu/listofprinters.php

If you are unable to process an online transaction, you may be able to get a temporary IOU for print quota. See Buying and Checking Quota on page 44.

WolfPrint Online

The opening page of the WolfPrint web application at http://print.ncsu.edu/ has links that enable users to handle routine print tasks from the web, such as:

• Buy quota online.
• Check your print quota.
• Print to a file and send the file to a specific printer.
• Check print queues, re-route and remove print jobs.
• Report printing problems and find solutions to common problems.
Buying and Checking Quota

You can buy and manage your print quota and purchases from the links, **Buy Quota Online** and **Quota Details**. Your print quota fees pay for printer maintenance and support, including paper and toner.

**Buy Quota Online**

The link, **Buy Quota Online**, takes you off site to **infiNET QuikPAY** for credit/debit card purchases of additional print quota. You can only pay with Visa or MasterCard.

You can purchase a minimum of $5.00 and a maximum of $100.00 in print quota in one transaction. You can purchase print quota for yourself or someone else, so long as there is not a privacy block. If you have a privacy block on your directory information, no one else can buy print quota for you.

If you have a problem with print quota purchase, you can report the problem online at **http://print.ncsu.edu/reportaproblem.php**

**REPORT A PROBLEM**

**Quota Related Problems**

- dispute a charge
- haven't been charged
- money added hasn't shown up
- iou problems

A complete list of printers and the cost of printing to each is at:

**http://print.ncsu.edu/listofprinters.php**
Once you make your purchase, and check out, your print quota is increased immediately and displayed at the left of the web page under Last Quota Addition and My Print Quota.

Quota Details and IOU

Quota Details is a check you are likely to run frequently. You have to have print quota in order to print, and the Quota Details web page shows you your quota balance and the jobs you have printed. You can see from the Logs when and where you printed each job, how much it cost, and the number of pages.
The Quota IOU feature is important in case you run out of quota at a time when WolfCopy Centers are not open for you to purchase more. You can get an IOU of $10 worth of printing (about 166 pages) through the web page. Only one $10 IOU is permitted per user at a time.

Important Notes:
- If you are over $10 in debt, you may not request a Quota IOU.
- If your balance is positive when the IOU’s $10 is deducted from your account, the IOU flag will be removed.

Print a File
Most of the time, to send a print job directly to the printer in the lab you are in, you simply select Print from the File pull-down menu of your application. The Print... option on your File menu provides additional print options to adjust default settings, change number of copies, range of pages, etc.

However, sometimes you need to route your file to another printer. To do this, use the Print a File tool, browse for and select the file, and choose the printer you want from the pull-down list. You can also print more than one copy by selecting Show Options to bring up Copies.
To use **Print a File**, the file must first be formatted for printing as PostScript (.ps), Portable Document Format (.pdf), or plain text (.txt). Whatever application you are in, you must first create a print file before using the **Print a File** tool to route the file to an Eos/Unity printer.

---

**Check Queues and Cancel Printing**

Whether you print directly to your local lab printer from File -> Print or use the **Print a File** tool, you can check on the status of your print job with the **Check Queues** tool. Windows uses a different printing system from the three other platforms (Solaris, Linux, Mac), which is the reason you see two print queues listed for each printer. With this tool, you can see what jobs are ahead of yours so you can estimate how long you have to wait.

To cancel a print job, select **Check Queues** to bring up the print jobs you have in the queue. Select **Cancel Job** in the lower left corner of the job you wish to cancel, or click the **Job ID**. You can only remove jobs that you own. Because you had to log in to WolfPrint with your Unity ID, the system knows who you are and will not let you remove anyone’s print jobs but your own.
Reporting Problems and Getting Help

There is good support from both WolfCopy and Office of Information Technology (OIT) for networked printing, so use the reporting and documentation tools to help you if you have problems.

Report a Problem

If you have any difficulty with the WolfPrint tools, select the Report a Problem link. You can report problems about charges, printer hardware, print jobs, etc.

Help

However, first look at Help before you report a problem to make sure you have not missed something that will help you solve the problem on your own.

Color Printing, Plotting, and Scanning

Color printing is offered in several computing labs. You can select these printers from the printer list at http://print.ncsu.edu/listofprinters.php.

For more in-depth scanning services, plotting, large-format printing, and other digital media resources, visit the NCSU Libraries Learning Commons, 1st floor, East Wing of D. H. Hill Library.

Print Tools on Solaris and Linux

There are additional tools on Solaris and Linux, both UNIX-based platforms, which help you print and run checks from the command line. The http://print.ncsu.edu web application actually runs on top of some of these commands and tools. If you prefer, you can use them directly rather than through the web application.
Print a File (lpr)

Although most printing can be done from inside applications, there are times when you need to print a print-formatted file from the command line. Most applications let you print to a file, which means that you can send your output to a file rather than to a printer. Then you can print the file whenever you want without having to open the application.

On UNIX, to print a file that has been formatted for printing, generally a PostScript (.ps) or Portable Document Format (.pdf) file, type lpr (line print) followed by the file name or the path to the file:

```
lpr file.pdf
```

The workstation will automatically print your file to the local printer in your office or lab. However, if you want to route your print job to another printer, add -P after the lpr command, followed immediately (no space) by the name of the printer you want to use and the specific print-formatted file you want to print. For example, if you want to print file.pdf to the color printer in D.H. Hill library:

```
lpr -Pdhl-2413-color1 file.pdf
```

For printer names, see [http://print.ncsu.edu/listofprinters.php](http://print.ncsu.edu/listofprinters.php).

Check Print Queue and Remove Jobs (lpq, lprm)

All jobs are numbered. To remove a job from the queue, type lprm followed by the number of the job:

```
lprm job#
```

You can only remove your own print jobs, not those belonging to other people. If you have been quick enough to catch it, the lprm command will remove the file from the print queue and keep it from printing. To remove all of your print jobs from the queue:

```
lprm -
```

Print Preview

Before sending a job to the printer, check your file carefully to make sure that it is ready to print so that you do not waste your print quota. Most programs have a Print Preview capability, generally available from the File -> Print... menu. If you have a PostScript (.ps) or PDF file to preview before printing, you can view it with one of the viewers on the system, e.g., `gv file.ps` or `gv file.pdf`, at Launch -> Applications -> Graphics. PDF files can be viewed with `gv` or in a browser with the Acrobat Reader. The Acrobat Reader can also be brought up from Launch -> Applications -> Graphics -> PDF Document Viewer.

Setting Printer Variables

On UNIX, the default printer is set in the PRINTER environment variable. To find out your default printer, type printenv PRINTER. You can change the default printer by typing setenv PRINTER followed by the name of the printer you want to use. Using the -P option will always override the default setting.

Print Screen and Screen Captures

To capture screens on Solaris and Linux, use the gimp application at Launch -> Applications -> Graphics -> Image Editor, or `xv` from the command line:

```
add imagetools
```

```
xv &
```

Right-click the `xv` window to bring up `xv Controls` and select the Grab button. Follow the instructions provided to capture a window, area, or whole screen, and then save to a file.
Creating PDF Files

Invented by Adobe Systems over 15 years ago, Portable Document Format (PDF) lets you capture and view information on any computer system. PDF files are:

• readable by anyone with the free Acrobat Reader
• not easily altered
• platform and software independent
• compliant with assistive technology for people with disabilities
• searchable
• virus-free, secure
• like original in appearance, no matter the application
• smaller file size than original
• both a web and print standard

Creating PDF Files on Windows

The full version of Adobe Acrobat is installed on Windows workstations, so you can use this program to create and work with files in Portable Document Format, or PDF. Acrobat is installed as a printer in Windows applications, so when you are working in an application, e.g., Word or Open Office, you can print or save a file to PDF (file.pdf).

Acrobat and Acrobat Reader are separate products. You need Acrobat to manipulate PDF documents and create PDF forms. Reader is a plug-in to the browser that only allows you to read, search and print PDF files and enter content into forms.

Creating PDF Files on Solaris and Linux

On Solaris and Linux, when you print to a file in an application, the default file format may be PostScript, which has the extension of .ps, e.g., file.ps. You can send the file to a printer using the Print a File tool at http://print.ncsu.edu. Or, you can print the file from the command line:

lpr file.ps

If you need to convert a PostScript file to PDF:

add eosutils

ps2pdf file.ps newfilename.pdf

You will also find other PS and PDF tools in the eosutils lockers

cd /ncsu/eosutils/bin/

To print the file:

lpr newfilename.pdf

You can also view/print the pdf file via a browser that has the Acrobat Reader plug-in. Or, launch the reader with the following commands:

add acroread

acroread file.pdf
**Conserving Print Resources**

The following advice will help you conserve your print quota and share printers with others who use the Eos/Unity networked printing system. Please plan ahead for your printing since facilities are shared. Also, be courteous of others who must use these facilities, too.

1. Accustom yourself to working on-screen rather than on paper. Read and edit online and print final copies only. Send and share files via email, AFS file-sharing, and posting to the web rather than making paper copies.

2. Check files with available **Print Preview** utilities, editors, and viewers before you print them. Make PDF files and view them with **Acrobat Reader** in your browser.

3. Only print pages that you have changed, not the whole document. This will save paper and keep you and others from having to wait long for output.

4. Check your print settings carefully before you print. For example, if you have just changed a setting to print three copies of a document, make sure you change the print setting back to one before printing again.

5. Do not use the printer as a copier. Copying costs as little as 3 cents a page. Printing is 6 cents a page.

6. Remember how to cancel print jobs. Type `lpq` to show the print queue, find your print job, and then remove it with the command `lprm job#`. On Windows, select **My Computer -> Printers -> Document -> Cancel**. Or use the facility for checking and removing jobs at [http://print.ncsu.edu/checkqueues.php](http://print.ncsu.edu/checkqueues.php)

7. Turn off header and banner pages.

8. Be considerate of other users. Break up big print jobs into several shorter jobs so you do not monopolize the printer.

9. If you are not in a hurry, choose times when the lab is not busy to print large documents.

10. Save your documents to external media and use your home computer and printer for cheaper printing and convenience.
Email, Messaging, and Calendar

Most users of electronic mail want to be able to read and send email no matter where they are, at home or school, when they travel, or in non-traditional work and study settings. Starting in fall 2010, all NCSU students will have their email accounts in Google, with access through the web address, http://gmail.ncsu.edu.

Faculty and staff on campus are generally users of GroupWise, which has its own web interface. With these web interfaces, users do not have to come to campus to use specific mail clients or download their mail to a local computer in order to read it.

http://webmail.ncsu.edu (no longer usable once user is moved to NCSU Google email)
http://gwweb.ncsu.edu

More information on campus email, including messaging services, can be found at:
http://oit.ncsu.edu/email/

At the time of this guide's publication, Novell GroupWise (named Wolfwise) is the standard shared calendar for faculty and staff. For students, the common calendar will be Google Calendar at http://gcal.ncsu.edu.

E-mail Addresses

From: http://oit.ncsu.edu/email/

In August 13, 2007, the Unity email address, unityid@ncsu.edu, was made the NCSU student's official campus email address for university communication. NC State sends certain important and timely information to students and University employees by email only. This includes information about classes, student accounts, eBILLS, employment, benefits, etc.

In fall 2010, students will have new Google Apps @ NC State accounts provisioned by the Office of Information Technology, and they will be moved off of the existing Unity/Webmail system. However, they will continue to use the unityid@ncsu.edu address. It will just send and receive through the Google service at http://gmail.ncsu.edu.

To ensure that you receive all University communication, check your Self Service -> Personal Information -> E-mail Addresses at MyPack Portal and make sure it is using the correct unityid@ncsu.edu address.

Google Mail

Google has become the official student e-mail system for NC State, which means all official communication from the university will be sent through that e-mail system. The student's e-mail address will remain unityid@ncsu.edu, but mail login is at http://gmail.ncsu.edu (not http://webmail.ncsu.edu).

The announcement to move students to Google Apps was made in January 2010, after an agreement was reached with Google, Inc. to provide their services to students. This action was recommended in the Student E-mail Task Force 2009 report. Google Apps @ NC State (http://google.ncsu.edu) will provide students e-mail and other popular hosted services designed to improve collaboration, communication and education.
Why is NCSU outsourcing email to Google?

Google is able to provide:

- 7+ GB of e-mail storage per account
- World-class spam and virus protection
- Integrated communication features that include e-mail, chat, and scheduling
- Secure (SSL) connections
- Mobile access to e-mail and applications
- NCSU-centered collaborative tools
- Retention of the unityid@ncsu.edu e-mail address

What about data security?

- Google will not sell your data.
- Google does not own your data.
- Google will not show advertisements in NCSU Google Apps.
- Google encrypts all communication and filters for spam, viruses, and phishing.

Setup for mobile phones and computers

Before you can access your Google Mail @ NCSU account from anywhere other than the web interface at http://gmail.ncsu.edu, you must sync your password at http://www.ncsu.edu/password. Enter your current password in all three of the password fields (Current Password, New Password, New Password) and select Change Password.

For settings for mobile phones--Androids, iPhones, Blackberries, etc.-- see documentation at http://wic.ncsu.edu/wrap2/google_email.html. Whether you are setting up an iPhone or Thunderbird on your computer, you will need to configure incoming settings for imap.gmail.com. Outgoing settings must be set to smtp.gmail.com.

Is my Unity/Webmail connected to my NCSU Google account?

No, your Google Apps @ NC State Gmail account is not at all connected to your personal Gmail account. Google does not allow personal Gmail accounts to be linked or combined with Gmail accounts in its Google Apps for Higher Education, which Google Apps @ NC State is a part of. You have to give up Unity/Webmail when you move to Google Apps @ NC State. Your existing Unity/Webmail will be migrated into your University Gmail account (not the personal Gmail account you may already have). Before the migration begins, you will be advised about deleting unwanted e-mail, handling your address book, and updating e-mail forwarding.

Mail Attachments

Mail attachments are limited to 15MB in Unity/Webmail and 25MB in Google. This size limit includes the message itself and any encoding. The most common mail attachments are Microsoft Office files, particularly Word files. Unfortunately, these attachments cannot be opened by people who do not have MS Office or Open Office installed locally.

Also, people are often suspect of attachments because they historically have been the transmitters of viruses and worms. As a result, some people are unwilling to open attachments, particularly if they do not know the sender. For example, an unsolicited resume sent as a Word attachment may never be opened by its receivers if they are not expecting it and the sender is unknown to them.
If the document is text only, you may wish to copy it as text directly into the email. However, if you need the formatting preserved, your best option is to convert your document to Portable Document Format (PDF). PDF has several advantages as a mail attachment:

- Reduced chance of carrying a virus or worm.
- Readable on any computer via a web browser and the Adobe Reader plug-in. The recipient does not need to own the application the file was created in to read the file.
- Smaller file size for sending/receiving. NCSU has a limit on the size of mail attachments you can send, so PDF can help keep your attachments smaller.
- Preservation of document’s look and layout across multiple media, e.g., handhelds, web, print.

Adobe Acrobat, the application used to make PDF, is in all Eos and Unity labs and widely available across campus. In most applications, you select File -> Print -> Acrobat to print a file to PDF. In other applications, you select File -> Save As and choose PDF as the format to save to.

Viruses and Spam

From OIT web pages at  http://oit.ncsu.edu/email/spam

Spam is unwanted junk email. A virus is a program that makes copies of itself and spreads, often by email, by attaching itself to other programs to infect computers with malware. The campus email administrators filter mail to remove as much spam as they can and to prevent the spread of viruses. However, individuals can protect themselves from viruses and spam by following the advice below:

- Do not reply to spammers, and do not become a spammer yourself by broadcasting mail, see http://www.ncsu.edu/rulesregs/.
- Never unsubscribe to spam mail. Offering you the opportunity to unsubscribe is a ruse to see if your mail account is alive and therefore valuable to other spam lists the spammer may sell to.
- Do not post your email address on web pages. Do not give out the email addresses of others when web pages ask for them. Be careful with free email accounts, email groups, web hosting, open lists, shareware, etc. All want your email address. Keep a personal email for non-NCSU activities. Keep your NCSU mail address as private as possible.
- Before opening an attachment, scan it to ensure that it is not infected. If you do not know the source of a file, do not open it. Even if you know the person who sent the file, if you were not expecting it, contact the person before opening it. Many viruses automatically send themselves out to addresses they find in files on the infected computer.

NCSU implements a number of strategies and technologies to prevent spam and viruses from getting to you.

- Manages block lists for the campus mail relays to stop viruses, mail loops, bad hosts, and spam directed at our entire user installation.
- Periodically scans the network for machines accepting mail and performs third party (open) relay checks.

AntiVirus Software

Most viruses find their way to your account via e-mail and e-mail attachments. NCSU purchases Trend Micro OfficeScan (for Windows) and Intego Virus Barrier (for Mac) and makes them and other anti-virus and anti-spam tools available at http://www.ncsu.edu/antivirus/. They are free for download by students, faculty and staff to their on-campus and personal computers.

For faculty and staff Wolfwise users, antispam and antivirus protection is handled by M+Guardian.
PureMessage Spam Filtering

**PureMessage** is a mail filtering agent that attempts to identify spam and viruses. When an email passes through NCSU’s mail relay system, it is processed by the PureMessage daemon, which attempts to determine if it is spam or contains a virus. If an email message satisfies one or more of the definitions used by PureMessage, it is assigned a hits percentage. The greater the percentage, the more likely it is that the message is spam or virus-contaminated. For setting up PureMessage, consult the pages at [http://oit.ncsu.edu/email/puremessage-nc-state](http://oit.ncsu.edu/email/puremessage-nc-state).

Calendar

*From [http://oit.ncsu.edu/wolfwise/](http://oit.ncsu.edu/wolfwise/).*

For a number of years, two co-existing, centrally supported, but incompatible calendaring systems have been used at NCSU, GroupWise and Oracle. To improve campus-wide scheduling and communication, a decision was made by OIT to consolidate and use only Novell’s GroupWise 7.0 for faculty and staff and to refer to this new implementation as **WolfWise**. The campus stopped offering Oracle calendar accounts on Jun 1, 2009. Faculty and staff can request GroupWise calendars, but students cannot. However, at the time of this guide’s publication, OIT was progressing toward a Google Calendar implementation for students. More on that can be found at [http://gcal.ncsu.edu](http://gcal.ncsu.edu) and [http://oit.ncsu.edu/h/welcome-email-calendaring](http://oit.ncsu.edu/h/welcome-email-calendaring).
Wolfware Course Management

Historically on campus, course management has been done in a university-created system called Wolfware. Wolfware runs on the campus Eos/Unity and AFS infrastructure and provides a basic set of online tools for class email, message board, homework submission/return, and a gradebook that interfaces with campus Registration and Records.

Wolfware has been running continuously since fall 2000, when its first production version was made available for general campus use. Although development has been frozen since 2004, it was officially deprecated at the end of fall 2009 and re-branded as Wolfware Classic. At the time of this guide's publication, there was no official date for the phase-out and removal of Wolfware Classic, but it will certainly run in the 2010-11 academic year.

Also in 2000, WebCT, a commercial learning management system (LMS), was introduced to campus by the newly created Distance Education and Learning Technology Applications (DELTA) organization. It has run continuously as WebCT, WebCT Vista, and most recently as Blackboard Vista after Blackboard Inc. acquired WebCT in 2006. Blackboard has ended its support for Vista, so Vista is in its last year at NC State and will go offline in summer 2011. Faculty will be able to migrate their Blackboard Vista classes between spring 2010 and spring 2011, and they are strongly encouraged to move to Moodle.

Moodle, an open source LMS, was selected in 2008 as a replacement for Wolfware and Blackboard Vista. A pilot installation was put in place to evaluate it, which continued through the academic year, 2009-10. This fall 2010 will be its full production release for all of campus. It joins the other campus tools, including the Elluminate software for synchronous learning management, at the newly created http://wolfware.ncsu.edu web site.
The original Wolfware was moved to http://classic.wolfware.ncsu.edu. The "new" Wolfware is Wolfware Moodle, see NC State to Migrate to Moodle Learning Management System for an explanation of future Wolfware development. The migration of faculty from WolfWare Classic to Wolfware Moodle has begun but will be implemented gradually since the Vista migration is more urgent and there still is work to be done to integrate Moodle's tool set with Wolfware.

At the time of this guide’s publication, the following are the entry addresses for campus course management tools, but please check the http://wolfware.ncsu.edu web site for updated information:

- **Wolfware Classic**: http://courses.ncsu.edu and http://classic.wolfware.ncsu.edu
- **Moodle**: http://moodle.wolfware.ncsu.edu
- **Blackboard Vista**: http://vista.ncsu.edu
- **Elluminate**: http://elluminate.wolfware.ncsu.edu/
- **WebAssign**: http://webassign.ncsu.edu/

The following image is the Browse Courses link at http://wolfware.ncsu.edu, which has most of these tools and instructions for use listed at the right.

Since most NC State courses still use Classic Wolfware as the preferred LMS, the remaining pages in the chapter provide basic instructions in using it.
Wolfware and http://courses.ncsu.edu

Wolfware lockers are accessed from http://courses.ncsu.edu. The web site lists all the departments with Wolfware lockers. The following departments have courses in Wolfware Classic in Summer II 2010.

Wolfware uses course-catalog and Registration and Records information to automatically create a boilerplate home page for each course so that it has a presence on the web. This course URL is the initial point of entry to the course locker with links to every active section. Wolfware also automatically generates rolls and class mailing lists for each course and section. It provides tools for discussion, secure homework submission and retrieval, and restricted access to web pages.

Finding Your Wolfware Classes and Links

Wolfware is platform and browser independent, and course lockers are listed at http://courses.ncsu.edu/. Students access their class content and tools through the Links column of the course boilerplate page at http://courses.ncsu.edu/crsnum, e.g., http://courses.ncsu.edu/e115. At this time, there are five links possible: Home Page, Message Board, Submit Assignments, Retrieve Assignments, and Grade Book.

To access/use any of these, the student locates his/her class in the Course-Section column and selects the appropriate link from the Links column. The following URLs follow the pattern set by Wolfware for all classes, if you substitute your course number and section for E115-002.

Course location: http://courses.ncsu.edu/e115/
Web site for all course sections: http://courses.ncsu.edu/e115/common/
Section web site (lecture): http://courses.ncsu.edu/e115/lec/002/
Secure section content: http://courses.ncsu.edu/e115/lec/002/wrap/

Course Homepage

NC STATE UNIVERSITY

WolfWare

E 115

Introduction to Computing Environments

Course Home Page

Student Links: MyPack Portal | Policies | My Library
Faculty Links: WolfWare Toolbox | Reg & Records

E 115 | Introduction to Computing Environments | 1(0-2-0) F,S,Sum

Introduction to the NC State computing system, and to student-owned computing resources. Includes topics such as maintaining your own computer, learning about campus-based computing resources and applications (how to access and use them), ethics and professionalism in the use of computing resources, introduction to web development and other campus resources.

Current Sections

<table>
<thead>
<tr>
<th>Course - Section</th>
<th>Instructor</th>
<th>Days</th>
<th>Time</th>
<th>Room</th>
<th>Links</th>
</tr>
</thead>
</table>
| E115 - 053       | SANDERS    | T    | 1:30P-3:20P | 201 DAN | [Home Page](http://courses.ncsu.edu/crsnum/lec/sec/)
|                  |            |      |           |      | [Submit Assignments](http://courses.ncsu.edu/crsnum/lec/sec/)
|                  |            |      |           |      | [Grade Book](http://courses.ncsu.edu/crsnum/lec/sec/) |
| E115 - 054       | MARINI     | T    | 6:00P-7:50P | 201 DAN | [Home Page](http://courses.ncsu.edu/crsnum/lec/sec/)
|                  |            |      |           |      | [Submit Assignments](http://courses.ncsu.edu/crsnum/lec/sec/)
|                  |            |      |           |      | [Grade Book](http://courses.ncsu.edu/crsnum/lec/sec/) |

Course Home Page

The Home Page link takes you to course content for the course. Here you get the syllabus and class materials as the instructor makes them available to you in Wolfware. The course content is generally delivered from the [http://courses.ncsu.edu/crsnum/lec/sec/](http://courses.ncsu.edu/crsnum/lec/sec/) but not always. Some of the content may be at [http://courses.ncsu.edu/crsnum/common/](http://courses.ncsu.edu/crsnum/common/) or from another location altogether.

Sometimes you must log in with your Unity ID and password to access class materials. As a rule, all Home Page content is world readable unless the instructor has specifically placed material in a secure folder and set access for viewing by the section only, all course sections, or all of NCSU. This material may be unpublished research, copyrighted content, or sensitive in some way that it requires secure access by authorized individuals through
the NCSU Web Realm Authentication Protocol (WRAP). Any materials that have been placed by the instructor in http://courses.ncsu.edu/crsnum/lec/sec/.wrap/ will require a login and password to view and use.

Message Board

Wolfware uses Message Board for class discussion. The instructor sets up discussion forums, and students participate in the online discussion by posting topics and replying to posts within these forums. Put simply, faculty create Forums, and students create Topics, although faculty may define other ways to use the tool.

For example, in the class below, the instructor has set up a Forum called Revised Bloom's Taxonomy Questions. To participate in this forum, a student clicks the link, and on the web page that comes up can Post a New Topic or a Reply.
Submit Assignments

Submit Assignments is a tool in Wolfware for the secure submission of student files into the course locker. Assignments are added when the instructor uses the Submit Admin tool to name the assignment, set inclusive time/dates for assignment submission, and identify the users who can submit. When the instructor sets up an assignment for submission, it will appear as a Submit Assignments link on the boilerplate course page in the section’s Links area.

Students select this link and log in to go to the submission page (the system lets through only those students enrolled in the class and able to submit). Once there, students see a list of assignments they can submit to. If the assignment cannot be submitted to, it will say CLOSED.

A Browse button appears that allows the student to locate the file on their local or network drives. Once the file is selected (it must appear in the field beside the Browse button to be selected), the student selects Upload File to transfer the file. Any type of file can be submitted to the locker, but only one file at a time. If a folder or multiple files need to be submitted, they would need to be zipped or tarred first before submission as a single file.

The file is uploaded to a secure submitted directory in the course locker. This directory is automatically created by Wolfware when the locker is generated.

The AFS location of the student’s submitted file is:

/afs/eos/courses/crs/crsnum/lec/sec/submitted/assignment/userid/file

The Submit tool creates the assignment directory (e.g., Homework3), and all students who submit files to this assignment will have directories created for them inside this directory, e.g.,
Students cannot delete a submitted file, but they can overwrite it by submitting a file of the same name. If the upload is successful, students are returned to the page showing a listing of all the files they have uploaded, the date of the upload, and the size of the file as saved in the locker (see above).

If the instructor chooses to grade and return assignments through Wolfware, students can pick up their returned work via the Retrieve Assignments link on the course boilerplate page. The same is true with grades, if the instructor chooses to use the Grade Book. Grades and submitted assignments are restricted to access by the authorized student only (login required).

Class Mail

Wolfware lockers are set up automatically with downloaded rolls from Registration and Records (R&R). Professors also use automatically generated class mail lists to communicate with their classes, e.g.,

crsnum-sec@wolfware.ncsu.edu
e115-001@wolfware.ncsu.edu

You may not write to the class email address unless the instructor sets it up for you to do so. Default class mail is one-way, from the instructor to the class.

In fall 2007, the Unity email address became the official mail address of all NCSU users. By fall 2010, all students will have been moved to Google mail but will still use the unityid@ncsu.edu address.
Remote Access and Virtual Computing Lab

Thanks to Tony Baumann, Robbie Little, Jason Maners and Mike Vysocka for their contributions to this chapter.

All NCSU students, faculty and staff can access the campus network from their home and non-Eos/Unity computers through campus and college remote-access services and the Virtual Computing Lab (VCL) (see http://www.eos.ncsu.edu/remoteaccess/ and http://vcl.ncsu.edu). To protect the privacy of those who use our services, all NCSU remote-access services use secure, encrypted communication. They also employ open-source technologies wherever possible.

Common Uses of Remote Access

The most common uses of remote access are for:

- **File transfer** - copying files between a user's computer and the campus AFS file system. Secure Copy (SCP) and Secure File Transfer (SFTP) clients for Windows, Macintosh and Linux computers are available for free download from campus and other locations.

- **Running applications** - accessing campus computers to run software that the user needs for class, homework, research, etc. Online software catalogs at http://www.eos.ncsu.edu/software/, http://www.ncsu.edu/software/, and http://vcl.ncsu.edu will tell you what applications are available and how you can run them, either by connecting to Remote Access Servers on page 65 or to the http://vcl.ncsu.edu.

A high-speed broadband connection is recommended to perform either of these tasks, particularly if you are transferring large or multiple files, or if the applications you run are complex and graphically intensive. Connection over the campus wireless network is supported, but usually slower.

Transferring Files Securely

The purpose of running a Secure Copy (SCP) or Secure File Transfer (SFTP) program is to transfer files from one computer to another over the Internet. You use a Secure Shell (SSH) program on your Windows, Macintosh or Linux computer to connect to special remote-access servers on campus or computers in VCL.

Most users need file transfer to copy files between their non-Eos/Unity computers and the campus AFS file system. They are generally getting files from or putting files into their:

- Unity account file space (/afs/unity/users/a-z/unityid/)
- Wolfware locker (/afs/eos/courses/dept/crs/...)
- Engineering people locker (/afs/eos/lockers/people/a-z/unityid/)
- Engineering course workspace locker (/afs/eos/lockers/workspace/dept/crs/sec/)
- Web sites and other lockers, share drives, and directories in AFS

In general, file-transfer programs allow you to copy files from one location to another, not open and edit them.

Running Solaris/Linux Applications Remotely

NCSU and its colleges license many Solaris and Linux applications, which are available in labs, can be downloaded to individually owned computers, and can be run by remote access. Applications that run via remote access
execute on a remote computer but display back to the user’s computer screen. The experience is close to that of using the application in a lab.

You use a Secure Shell (SSH) program on your Windows, Macintosh or Linux computer to connect to Solaris and Linux applications in the Virtual Computing Lab (VCL), (http://vcl.ncsu.edu). If you are in engineering, you can also connect to applications on remote.eos.ncsu.edu running Solaris and remote-linux.eos.ncsu.edu running Linux. Users may not always be able to tell the difference in a program running locally or remotely. However, because of the network-intensive requirements to move data across remote connections, users can experience sluggishness if they do not connect at high speed.

Running Windows Applications in VCL

The only way for users to run Windows applications remotely from their own Windows, Mac and Linux computers is via the Virtual Computing Lab (VCL) at http://vcl.ncsu.edu. VCL gives the user a dedicated computer on which to run the application. However, before you can connect to a Windows computer in VCL, you need to configure your own computer to make a remote desktop connection.

Secure Connections: SSH and RDP

Two principal technologies govern how remote-access connections are made to campus resources:

• Secure SHEll (SSH)
• Remote Desktop Connection (RDC)

Secure SHEll (SSH)

Secure SHEll (SSH) is a network protocol that allows data to be exchanged over a secure channel between two computers. All programs recommended by NCSU for use in remote access support SSH, as do the Remote Access Servers on page 65 to which they connect. SSH provides strong authentication and secure encrypted communications between two hosts over an otherwise insecure network.

Developed by SSH Communications Security Ltd., SSH is generally used to log into another computer over a network, execute commands on a remote machine, and copy files from one machine to another. SSH can also be used to tunnel applications and data across the network securely. SSH replaces telnet, rlogin, rsh, rcp, and rdist as the means to connect to the campus network. Secure Copy (SCP) and Secure FTP (SFTP) are SSH file-transfer protocols.

Remote Desktop Connection

Remote Desktop Connection (RDC) is client software from Microsoft that runs on the user’s computer (Windows, Mac or Linux). It enables the user to connect to computers in the Virtual Computing Lab (http://vcl.ncsu.edu) for the purpose of running Windows applications remotely.

The connection is made through an open multi-channel protocol called Remote Desktop Protocol (RDP) to Windows servers that run Microsoft Terminal Services. These multiple channels allow you to tunnel resources from the server to your computer. The graphical interface (GUI) of the remote computer can be displayed on your personal computer. You can tunnel drive access, printing, and even sound, which enables you to print to your local printer, save to the hard drive on your own machine, and listen to any sound generated on the server.

To connect to VCL Windows computers, make sure that your computer has a RDC client installed. Connections through older protocols to remote-access services will be refused, so users may need to change or upgrade the software they use.
Remote Access Servers

Some remote-access services on campus grant access to the whole NCSU community. Others are restricted to colleges, departments, distance students, etc., depending on who runs the service and provides the support.

The following are known services from the Office of Information Technology (OIT) and Information Technology and Engineering Computer Services (ITECS). All are configured for secure connection using Secure SHell (SSH) or Remote Desktop Protocol (RDP). In the Virtual Computing Lab (VCL), you are assigned a dedicated computer to run an application, just like sitting down at a computer in a lab. On the other servers, you connect to a pool of computers running shared processes, so performance might be a little slower.

- **Virtual Computing Lab** (OIT) - Solaris, Linux Windows computers available to all NCSU students, faculty and staff. RDP needed to connect to Windows applications and SSH to connect to Solaris and Linux lab machines in VCL.
- **ftp.ncsu.edu** (OIT) - Secure ftp server for all NCSU students, faculty and staff. SSH to connect and transfer files.

  **Note:** login.ncsu.edu and ssh.ncsu.edu no longer exist. In their place, please use ftp.ncsu.edu, or one of the servers below, if you are in engineering.

- **remote.eos.ncsu.edu** (ITECS) - Solaris 10 server available to College of Engineering students, faculty and staff. SSH to connect to Solaris workstations for applications, file transfer, command-line access, etc.
- **remote-linux.eos.ncsu.edu** (ITECS) - Linux RHEL5 server available to College of Engineering students, faculty and staff. SSH to connect to Linux workstations for applications, file transfer, command-line access, etc.

Windows Remote Access to Eos/Unity

Most users run Windows on their personal and office computers. At times, they need to make remote-access connections from their Windows computers to the campus Remote Access Servers on page 65 or the Virtual Computing Lab (VCL) on page 91 to:

- transfer files to/from campus AFS file space.
- run commands and applications on Linux or Solaris workstations.
- run Windows applications they do not have on their local machines.

To perform these tasks, Windows users need to download, configure and run one or more of the following programs

- ExpanDrive or WinSCP for secure file transfer.
- PuTTY for command (terminal) access and X-Win32 for Solaris/Linux applications with graphical interfaces.
- Remote Desktop Connection (RDC) to run Windows applications in the Virtual Computing Lab (VCL).

Connecting from Windows to AFS for Secure File Transfer

To transfer files securely between the user's Windows computer and the campus AFS file system, the user will need to download and install ExpanDrive or WinSCP. ExpanDrive has the advantage of being able to map AFS drives to your local machine.
**What is ExpanDrive?**

ExpanDrive is commercial software licensed to North Carolina State University for use in coursework, teaching, degree-related research, and non-commercial research. ExpanDrive may be used on the university and personal computers of currently employed faculty and staff and currently enrolled students. ExpanDrive acts like a USB drive plugged into your Windows or Mac computer to open, edit and save files on remote computers. AFS lockers (e.g., K: and J:) can also be mounted as drives on your local machine.

**Installing ExpanDrive**

To install ExpanDrive:


2. Using the **Install** instructions provided at the web site, run the file you downloaded, **ExpanDriveNCSU.exe**.

3. If you see a security warning, click **Continue** or **Run**.

4. At the **Welcome to the ExpanDrive Setup Wizard** screen, click **Next**.

5. At the **License Agreement** screen, click **I Agree**.

6. At the **Choose Components** screen, you may choose to accept the default of checked **Start Menu Items**, **Check for Updates** should be unchecked (updates for the NCSU-configured version would only be available from this download site). Then click **Next**.

7. At the **Choose Install Location** screen, accept the default and click **Install**.

8. You may be prompted to reboot. You have the option to wait and reboot later.

9. At the **Completing the ExpanDrive Setup Wizard** screen, choose whether you would like to Open ExpanDrive, then click **Finish**

If you had chosen to open ExpanDrive, the program will open and you can configure it.

To open **ExpanDrive**, select **Start -> Programs -> ExpandDrive**
Configuring ExpanDrive

1. To configure ExpanDrive to connect to your personal AFS home directory (/afs/unity/users/...), or K: drive:

- **Drive Name**: Your choice
- **Server**: ftp.ncsu.edu (for campus). Use remote.eos.ncsu.edu (preferred) or remote-linux.eos.ncsu.edu, if in engineering.
- **Port**: 22
- **Username**: Your Unity ID
- **Password**: Your Unity password. Check the **Save Password** box, or leave blank to be prompted for your password on connection.
- **Authentication**: Use a password to log in (default)
- **Directory**: Show only my home directory (default)
- **Drive Letter**: Your choice (this drive letter will map to your home directory in AFS, the K: drive).
- **Reconnect at Logon**: Check the box to have your drive automatically connect on startup. Leave blank if your computer does not automatically connect to networks on startup.
- **Save Drive**: Leave checked
- When you click **Connect**, your AFS home directory will be added to Windows Explorer (right-click **Start** -> **Explore**).

2: To configure ExpanDrive to connect to the AFS root directory (/afs), or J: drive:
• **Drive Name**: Your choice

• **Server**: ftp.ncsu.edu (for campus); remote.eos.ncsu.edu or remote-linux.ncsu.edu (for engineering)

• **Port**: 22

• **Username**: Your Unity ID

• **Password**: Your Unity password. Check the **Save Password** box, or leave blank to be prompted for your password on connection.

• **Authentication**: Use a password to log in (default)

• **Directory**: Show only my home directory

• **Drive Letter**: Your choice (this drive letter will map to the root directory in AFS, the J: drive).

• **Reconnect at Logon**: Check the box to have your drive automatically connect on startup. Leave blank if your computer does not automatically connect to networks on startup.

• **Save Drive**: Leave checked
• When you click Connect, the AFS root directory will be added to Windows Explorer (right-click Start -> Open Windows Explorer).

**Running ExpanDrive**

To run ExpanDrive and connect to the AFS drives you have set up:

• Select Start -> Programs -> ExpanDrive. ExpandDrive will appear as a red magnet in your taskbar at the bottom right of your screen.

• Select the drive you want and Connect.

**What is WinSCP?**

WinSCP is software that Windows users can use for transferring files to/from the campus AFS file system. WinSCP is a freeware SCP (Secure CoPy) client for Windows 95/98/ME/NT/2000/XP using SSH (Secure SHell). It was developed by Martin Prikryl, [http://winscp.net](http://winscp.net).

**Installing WinSCP**

To install WinSCP:

2. Using the Install instructions provided at the web site, select Save File and save WinSCP.msi to your Desktop or another location you prefer.

3. Double-click the WinSCP.msi icon.
4. In the WinSCP InstallShield Wizard that comes up, select Next to start installing.
5. After the software installs, select Finish in the InstallShield Wizard Completed screen.

The WinSCP application icon will appear on the Desktop.

**Running WinSCP**

To launch and run WinSCP on your Windows computer:

1. Double-click the winscp.exe icon to bring up the WinSCP Login window.

2. Select one of the Stored sessions (e.g., ftp.ncsu.edu, remote.eos.ncsu.edu, etc.).
3. Select the server you want and **Login**. You will be prompted for your Unity ID and password. The window that comes up is split, displaying the contents of your local drive on the left and the contents of your home directory in AFS on the right (other drives are available on the pull-down).

4. Click-and-drag files and/or directories between panes to copy files from one file system to the other.

5. Consult **Help** inside the program to bring up the WinSCP manual, or see the WinSCP manual at [http://winscp.net/eng/docs/start](http://winscp.net/eng/docs/start).

---

**Connecting from Windows to Solaris/Linux Applications**

Because of fundamental differences in the operating systems, remote access from Windows to Solaris/Linux can be problematic. Also, the X Window System, used in both realm Solaris and Linux, is not included in any version of Microsoft Windows.

Therefore, to access UNIX-based resources remotely from your Windows computer requires installing PuTTY for a secure terminal connection, and X-Win32 to display back windowed applications on your computer. To run an application that has a graphical user interface (GUI), you also need **Running PuTTY and X-Win32** on page 75, even if you are using the Virtual Computing Lab (VCL). The role that PuTTY plays as your Secure SHell (SSH) client is to forward the data that the X-Win32 X-Server uses to display the graphical interface on your computer.

**What is PuTTY?**

PuTTY is the recommended software to download and use for terminal access and running command-line applications. PuTTY is a free implementation of Telnet and SSH for Windows, including an Xterm terminal emulator. It is written and maintained by Simon Tatham, [http://www.chiark.greenend.org.uk/~sgtatham/putty/](http://www.chiark.greenend.org.uk/~sgtatham/putty/).

PuTTY enables access from Windows to a remote Solaris or Linux computer so that the user can execute commands and run applications from the command line. The user can run programs and save files on the remote computer but cannot transfer files between computers. To transfer files, the user must run a SFTP program like WinSCP. PuTTY also cannot run full-screen graphical applications unless used with X-Win32.
**Installing PuTTY**

To install PuTTY:

2. Using the **Install** instructions provided at the web site, select **Save File** and save *Putty.msi* to your Desktop or another location you prefer.

3. Double-click the *Putty.msi* icon.
4. In the **PuTTY InstallShield Wizard** that comes up, select **Next** to start installing.
5. After the software installs, select **Finish** in the **InstallShield Wizard Completed** screen.

The PuTTY application icon will appear on the Desktop.

**Running PuTTY**

To launch and run PuTTY on your Windows computer:

1. Double-click the *putty.exe* icon to bring up the **PuTTY Login** window.

2. Select one of the **Saved sessions** (Eos connects to remote.eos.ncsu.edu, Linux connects to remote-linux.ncsu.edu, Vcl connects to an IP address provided via a VCL reservation).
3. Select **Load** to bring up a terminal window to the host computer you selected. Log in with your Unity ID and password.

**What is X-Win32?**

**X-Win32** is the recommended software to download and use to connect from Windows to a remote Solaris or Linux application that has a graphical user interface (GUI). X-Win32 enables your personal Windows computer to display the full windowed application locally, just like you were sitting in front of a workstation in an Eos or Unity lab. (The Secure SHell (SSH) client, PuTTY, is also required.)

X-Win32 is a commercial application made available for free to all NCSU faculty, staff and students through licensing arranged by the College of Engineering and Starnet Communications ([http://www.starnet.com](http://www.starnet.com)). Since X-Win32 sends graphical information over the network, it requires a fast connection. The user should also run only one application at a time through X-Win32.

**Installing X-Win32**

To install X-Win32:

2. Using the **Install** instructions provided at the web site, select **Save File** and save *x-win.exe* to your Desktop or another location you prefer.
3. Double-click the *x-win.exe* file that you downloaded. Select English or the language of your choice in the **Choose Setup Language** window.
4. Select **Next** at the **Welcome to InstallShield Wizard** to install the program.
   - Accept the terms in the license agreement, and click **Next**.
   - Enter your **Name** and organization, **NCSU**. Select the radio button to **install the application for all users**, and click **Next**.
   - At the **destination folder** screen, select a destination or use the default `C:\Program Files\StarNet\X-Win32\` directory, and click **Next**.
   - Choose the **Setup Type** of **Complete**, and click **Next**.
   - At the **Ready to Install the Program** screen, click **Install**.
   - At the **InstallShield Wizard Completed** screen, click **Finish**.

**Register X-Win32 (one time only)**

When you run XWin-32 for the first time, you will be asked to register the application. If you don’t register, you will have a 30-minute trial of the application.

1. Start X-Win32 from **Start -> Programs -> X-Win32**. If you see a Windows Security Alert screen stating that Windows Firewall has blocked some features of this program, choose **Unblock**.
2. In the **X-Win32 License Wizard** window, select **Nodelocked (VN)** option, and click **OK**.

3. Enter the **Validation Number (VN)** in the **VN** field (you can find it on the **X-Win32** download page at [http://www.eos.ncsu.edu/software/downloads/](http://www.eos.ncsu.edu/software/downloads/)). Make sure **Automatic** is selected, and click **Next**.
4. The registration server at StarNet will display the message *Got a license key from the server* in the **Status:** field. Click **Next**.

5. At the **Success** screen, click **Finish**.
Running PuTTY and X-Win32

To run graphical Solaris and Linux applications remotely from your Windows computer requires Installing PuTTY on page 71 and Installing X-Win32 on page 72 and running them together.

1. Run Start -> Programs -> X-Win32

   Note: IMPORTANT! You must run X-Win32 EVERY time you want to run a GUI application remotely. If running X-Win32 for the first time, you will be asked to register the application. Select the Register button and enter the license number available from http://www.eos.ncsu.edu/software/downloads (login required).

2. Locate the X icon at the bottom right of your screen to confirm that X-Win32 is running.

3. Run your SSH Client, PuTTY.
   - Double-click the putty.exe icon to bring up the PuTTY Configuration window.
   - Select and Load one of the Saved Sessions: Eos to connect to the Solaris 10 remote.eos.ncsu.edu server; Linux to connect to the RHEL 5 remote-linux.eos.ncsu.edu server.
   - Select Open to open a terminal window (accept the PuTTY security alert, if prompted).
   - Log in with your Unity ID and password in the terminal window that comes up.

4. Run applications just as you would on Solaris and Linux workstations. Type add on the command line to get instructions. Accept the "Allow connection from host 'IP'?” prompts.

5. When you are finished using the application, type logout at the prompt.

Connecting from Windows to Solaris/Linux Applications in VCL

Users can also connect from their Windows computers to VCL to run Solaris or Linux graphical applications.

1. Make sure that PuTTY and X-Win32 are running on your computer.


3. Select Connect! when prompted.


5. Open PuTTY and select Vcl under Saved Sessions and Load (or create a VCL session and save, then load).

6. Paste the IP number into the Host Name (or IP address) field and Open.
7. Select Yes to the PuTTY security alert.
8. Log in with your Unity ID and password in the terminal window that comes up.
9. Run applications just as you would on Solaris and Linux workstations. Type `add` on the command line to get instructions. Accept the "Allow connection from host 'IP'?" prompts.
10. When you are finished using the application, type `logout` at the prompt.

**Connecting from Windows to Windows Applications in VCL**

The only way to run Windows applications remotely from the user's Windows computer is through the Virtual Computing Lab (VCL) on page 91 using a Remote Desktop Protocol (RDP) connection to:

- load in the connection settings from the VCL RDP file, and
- connect to the IP address of the remote Windows computer that has been installed with the requested application.

**Remote Desktop Connection**

Remote Desktop Connection (RDC) is client software from Microsoft that runs on the user's computer (Windows, Mac or Linux). It enables the user to connect to computers in the Virtual Computing Lab (http://vcl.ncsu.edu) for the purpose of running Windows applications remotely.

The connection is made through an open multi-channel protocol called Remote Desktop Protocol (RDP) to Windows servers that run Microsoft Terminal Services. These multiple channels allow you to tunnel resources from the server to your computer. The graphical interface (GUI) of the remote computer can be displayed on your personal computer. You can tunnel drive access, printing, and even sound, which enables you to print to your local printer, save to the hard drive on your own machine, and listen to any sound generated on the server.
To connect to VCL Windows computers, make sure that your computer has a RDC client installed. Connections through older protocols to remote-access services will be refused, so users may need to change or upgrade the software they use.

**Installing a Remote Desktop Client on Windows**

On newer versions of Windows (XP, Vista), the Remote Desktop Connection (RDC) is already installed at:

*Start -> Programs -> Accessories -> Remote Desktop Connection*


**Remote Desktop Connection to VCL Windows Applications**

To connect from your computer to a remote VCL Windows computer:

1. Go to [http://vcl.ncsu.edu](http://vcl.ncsu.edu) and log in through NCSU WRAP with your Unity ID and password.
2. Make a New Reservation for an application, or select a Current Reservation you have already made.
3. Select the Connect! button to connect to the reserved application. A "Connect!" page will display with the temporary password you need to connect to the remote computer.
5. Select Connect in the Remote Desktop Connection box to open a window to the remote computer.
6. Log in with the user name and temporary password provided to you on the Connect! page (also sent to you in email). The desktop of the remote Windows computer will appear in the window.
7. Double-click the icon of the application you reserved to open it and begin working.

**Note:** If the RDP file fails to log you in automatically, run Remote Desktop Connection and enter the IP address provided to you on the VCL Connect! page into the Computer: field. Select Connect to open a window to the remote computer, and log in with the user name and temporary password provided on the Connect! page (also sent to you in email).
Connect!

Use the following information when you are ready to connect:

Remote Computer: 152.46.16.136
User ID: mcdaniel
Password: 7wMjxy

Get RDP File

What is an RDP file?
Mac Remote Access to Eos/Unity

Many faculty, staff and students are choosing to run Mac OS X laptops and desktops, which have the same ability as Windows and Linux computers to connect to the campus Remote Access Servers on page 65 or the Virtual Computing Lab (VCL) on page 91 to:

- transfer files to/from campus AFS file space.
- run commands and applications on Linux or Solaris workstations.
- run Windows applications.

Mac users need to run one or more of the following programs:

- ExpanDrive for secure file transfer.
- SSH for command (terminal) access, and X11 to run Solaris/Linux applications with a graphical (windowed) user interface (OS X 10.4 Tiger only; X11 is built in to OS X 10.5 Leopard and OS X 10.6.3 Snow Leopard).
- Remote Desktop Connection (RDC) to run Windows applications in the Virtual Computing Lab (VCL).

The following group provides support for NCSU Mac users:

OIT Macintosh Support Site: http://oit.ncsu.edu/macintosh/

Connecting from Mac to AFS for Secure File Transfer

To transfer files securely between the user's Mac OS X computer and the campus AFS file system, the user will need to download and install ExpanDrive.

What is ExpanDrive?

ExpanDrive is commercial software licensed to North Carolina State University for use in coursework, teaching, degree-related research, and non-commercial research. ExpanDrive may be used on the university and personal computers of currently employed faculty and staff and currently enrolled students. ExpanDrive acts like a USB drive plugged into your Windows or Mac computer to open, edit and save files on remote computers. AFS lockers (e.g., K: and J:) can also be mounted as drives on your local machine.

Installing ExpanDrive for Mac

To install ExpanDrive:

1. Log in to http://www.eos.ncsu.edu/software/downloads/ and select the ExpanDrive link for Macintosh. Follow instructions to download.
2. Using the Install instructions provided at the web site, unzip the file you downloaded, ExpanDriveNCSU.zip.
3. Drag and drop the ExpanDrive application into your Applications folder.
4. Double-click the NCSU.ExpanDriveLicense file. After the license installs, click OK in the Thank You! dialogue box.
5. Double-click the ExpanDrive icon in your Applications folder to launch ExpanDrive.

6. The first time you run ExpanDrive, you will be prompted to upgrade MacFuse (a component that ExpanDrive relies on for operation). This procedure will either update the current install of MacFuse or install a fresh copy for you. Click the Upgrade MacFuse button to continue. When prompted, enter in your administrator password. When the upgrade has completed, click Continue in the Success window.

Configuring ExpanDrive on Mac

To access ExpanDrive, either double-click the icon in the Applications folder, or locate the ExpanDrive icon in the menu bar at the top of the screen. You will first need to open the Drive Manager.
Select **New Drive** or the + button to add/configure a new drive.

1. To configure ExpandDrive to connect to your personal AFS home directory (/afs/unity/users/...), or K: drive:

- **Drive Type**: SFTP (SSH)
- **Server**: ftp.ncsu.edu. Use remote.eos.ncsu.edu (preferred) or remote-linux.eos.ncsu.edu, if in engineering.
- **Username**: Your Unity ID
- **Password**: Your Unity password
- **Save**: Select the checkbox to save the password in your OS X keychain.
• **Nickname**: Your choice  
• **Remote Path**: Leave blank to default to your home directory.  
• **Port**: 22 (default)  
• **Reconnect at Login**: Check the box to have your drive automatically connect on startup and appear as an icon on the desktop. Leave blank if your computer does not automatically connect to networks on startup.  
• When you click **Connect**, your AFS home directory should appear as a drive on your desktop and in **Finder**.

2. To configure ExpandDrive to connect to the AFS root directory (/afs), or J: drive:

```
Drive Type: SFTP (SSH)  
Server: ftp.ncsu.edu  
Username: unityID  
Password: ************  
Nickname: AFS  
Remote Path: /afs/  
Port: 22  
Reconnect at Login  
```

• **Drive Type**: SFTP (SSH)  
• **Server**: ftp.ncsu.edu. Use remote.eos.ncsu.edu (preferred) or remote-linux.ncsu.edu, if in engineering.  
• **Username**: Your Unity ID  
• **Password**: Your Unity password  
• **Save**: Select the checkbox to save the password in your OS X keychain.  
• **Nickname**: Your choice  
• **Remote Path**: /afs  
• **Port**: 22 (default)  
• **Reconnect at Login**: Check the box to have the drive connect automatically on startup and appear as an icon on the desktop. Leave blank if your computer does not automatically connect to networks on startup.  
• When you click **Connect**, the NCSU AFS root directory should appear as a drive on your desktop and in **Finder**.

**Running ExpanDrive on Mac**

To run ExpanDrive and connect to the AFS drives you have set up:

• If your computer connects to a network automatically on startup, you will see the following drives on your desktop to open.
• Or, select a drive from the menu at the top of the screen.
• If you need to reconfigure a drive, select the Drive Manager from the menu. Select the drive, then open the menu and select Edit.

Connecting to Solaris/Linux Applications from OS X 10.5 (Leopard)

Connecting to Solaris/Linux applications from Mac OS X 10.5 (Leopard), or OS X 10.6.3 (Snow Leopard) is fairly easy since all of the technology is fully integrated into the operating system. To connect for simple terminal access or to run Solaris/Linux applications:

1. Go to Finder -> Applications -> Utilities and double-click on the Terminal application.
2. In the window that appears type: `ssh -X unityid@hostname`

   **Note:** Enter your own Unity ID, the "@" symbol, and the server to which you wish to connect, e.g., `remote.eos.ncsu.edu`, `remote-linux.eos.ncsu.edu`, or IP address provided by VCL.

3. Enter your Unity password when prompted. You will be logged in to the Eos/Unity environment and placed in your home directory, where you can run UNIX and AFS commands and command-line programs. Type `add` or see [http://www.eos.ncsu.edu/software/](http://www.eos.ncsu.edu/software/) for commands to launch graphical applications.

**Connecting to Solaris/Linux for Terminal Access from OS X 10.4 (Tiger)**

To connect to campus remote-access servers from Mac OS X 10.4 (Tiger) to run commands and programs in a terminal window:

1. Go to Finder -> Applications -> Utilities and double-click on the Terminal application.

2. In the window that appears type: `ssh -X unityid@hostname`

   **Note:** Enter your own Unity ID, the "@" symbol, and the server to which you wish to connect, e.g., `remote.eos.ncsu.edu`, `remote-linux.eos.ncsu.edu`, or IP address provided by VCL.

3. Enter your Unity password when prompted. You will be logged in to the Eos/Unity environment and placed in your home directory, where you can run UNIX and AFS commands and command-line programs.

**Connecting to Solaris/Linux Applications from OS X 10.4 (Tiger)**

To run a Solaris or Linux application back to a Mac computer running OS X 10.4 (Tiger) requires the X Window System (X11).

1. Install X11 from Optional Installs on your OS X 10.4 (Tiger) installation disk.
2. Go to Finder -> Applications -> Utilities and double-click on the X11 application.
3. In the window that appears type: `ssh -X unityid@hostname`

   **Note:** Enter your own Unity ID, the "@" symbol, and the server to which you wish to connect, e.g., `remote.eos.ncsu.edu`, `remote-linux.eos.ncsu.edu`, or IP address provided by VCL.

4. Enter your Unity password when prompted. You will be logged in to the Eos/Unity environment and placed in your home directory, where you can run UNIX and AFS commands and command-line programs. Type `add` or see `http://www.eos.ncsu.edu/software/` for commands to launch graphical applications.

### Connecting from Mac to Windows Applications in VCL

The only way to run Windows applications remotely from the user's Mac computer is through the [Virtual Computing Lab (VCL)](http://vcl.ncsu.edu) on page 91 using a Remote Desktop Protocol (RDP) connection to.

- load in the connection settings from the VCL RDP file, and
- connect to the IP address of the remote Windows computer that has been installed with the requested application.

### Remote Desktop Connection

**Remote Desktop Connection (RDC)** is client software from Microsoft that runs on the user's computer (Windows, Mac or Linux). It enables the user to connect to computers in the Virtual Computing Lab ([http://vcl.ncsu.edu](http://vcl.ncsu.edu)) for the purpose of running Windows applications remotely.

The connection is made through an open multi-channel protocol called **Remote Desktop Protocol (RDP)** to Windows servers that run Microsoft Terminal Services. These multiple channels allow you to tunnel resources from the server to your computer. The graphical interface (GUI) of the remote computer can be displayed on your personal computer. You can tunnel drive access, printing, and even sound, which enables you to print to your local printer, save to the hard drive on your own machine, and listen to any sound generated on the server.

To connect to VCL Windows computers, make sure that your computer has a RDC client installed. Connections through older protocols to remote-access services will be refused, so users may need to change or upgrade the software they use.

### Installing a Remote Desktop Client on Mac

Mac users must download and install the **Remote Desktop Connection (RDC) Client 2** for Mac OS X in order to connect to Windows computers in VCL.
To install the client, follow the instructions and make sure your computer meets the minimum specifications provided by Microsoft on the download page at:

http://www.microsoft.com/mac/products/remote-desktop/default.mspx

**Remote Desktop Connection to VCL Windows Applications**

To connect from your computer to a remote VCL Windows computer:

1. Go to [http://vcl.ncsu.edu](http://vcl.ncsu.edu) and log in through NCSU WRAP with your Unity ID and password.
2. Make a **New Reservation** for an application, or select a **Current Reservation** you have already made.
3. Select the **Connect!** button to connect to the reserved application. A "Connect!" page will display with the temporary password you need to connect to the remote computer.
4. Select the **Get RDP File** on the Connect! page to download a Remote Desktop Protocol (.rdp) file.
5. Select **Connect** in the Remote Desktop Connection box to open a window to the remote computer.
6. Log in with the user name and temporary password provided to you on the Connect! page (also sent to you in email). The desktop of the remote Windows computer will appear in the window.
7. Double-click the icon of the application you reserved to open it and begin working.

**Note:** If the RDP file fails to log you in automatically, run **Remote Desktop Connection** and enter the **IP address** provided to you on the VCL Connect! page into the **Computer:** field. Select **Connect** to open a window to the remote computer, and log in with the user name and temporary password provided on the Connect! page (also sent to you in email).
Connect!

Use the following information when you are ready to connect:

- **Remote Computer:** 152.46.16.136
- **User ID:** mcdaniel
- **Password:** TumJxy

[Get RDP File] [What is an RDP file?]
Linux Remote Access to Eos/Unity

Many faculty, staff and students are choosing to run Linux laptops and desktops, which have the same ability as Windows and Mac computers to connect to the campus Remote Access Servers on page 65 and the Virtual Computing Lab (VCL) on page 91 to:

• transfer files to/from campus AFS file space.
• run commands and applications on Linux or Solaris workstations.
• run Windows applications.

Linux users need to make sure that they have the following programs:

• SSH installed and configured to connect to remote-access servers.
• SCP or SFTP for secure file transfer.
• X11 installed and configured to run graphical applications back to your computer.
• Remote Desktop Connection (RDC), called rdesktop, to run Windows software in the Virtual Computing Lab (VCL).

The following group provides support for Linux users:

NCSU Campus Linux Services: http://www.linux.ncsu.edu

Connecting from Linux to AFS for Secure File Transfer

Linux users will connect to remote-access servers through SCP or SFTP. These tools are recommended over conventional ftp because they encrypt and transfer data securely, whereas ftp passes everything in the clear, including passwords.

Recommended Open SSH Settings

A Secure SHell (SSH) connection is required to execute UNIX and AFS commands and run applications remotely. SSH is recommended over the older protocols of telnet and rlogin. Linux OSes have SSH and X11 built in, but there are certain configuration settings that you are going to want to set and certain information you will need to know prior to connecting to the Remote Access Servers on page 65.

Trusted vs. Untrusted X11 Forwarding

Due to security concerns, OpenSSH (as of version 3.8) supports both untrusted (-X) and trusted (-Y) X11 Forwarding. The difference is what level of permissions the client application has on the X-server running on the client machine. Untrusted (-X) X11 Forwarding is more secure, but unfortunately, most applications do not support running with fewer privileges. When accessing applications remotely, using Trusted (-Y) X11 Forwarding, which was introduced in 3.8, will have fewer problems.

Command Line Options

The following command sets up the needed settings for remote access:

```
ssh -XC -c cipher -l unityid host
```

or

```
ssh -YC -c cipher -l unityid host
```

Where -X enables X11 Forwarding, -Y enables Trusted X11 Forwarding, -C enables compression, -l unityid specifies the user account you wish to log in as (since the user accounts on most personal machines will not match the UnityID), plus the following values:
Remote Access Servers on page 65
- `cipher` - 3des, blowfish (optional)

Config File Options
Instead of entering the command-line arguments each time you wish to connect, you can enter in the following lines into one of these configuration files:

```
$HOME/.ssh/config or /etc/ssh_config
```

Host login.ncsu.edu remote.eos.ncsu.edu remote-linux.eos.ncsu.edu
Compression yes
ForwardX11Trusted yes
ForwardX11 yes
Cipher blowfish

Connecting to Campus Servers
Once you have created the config file, you can connect to campus Remote Access Servers on page 67 with the following command:

```
ssh -l unityid host
```

More information is available in the SSH man page.

SecPanel SSH-GUI
Graphical tools are also available for Linux that manage SSH (Secure Shell) and SCP (Secure Copy) connection to the campus remote-access servers. A recommended application is SecPanel, which can be downloaded and installed from the SecPanel web site at [http://secpanel.net/](http://secpanel.net/).

OpenSSH SCP/SFTP Command Line
SCP and SFTP use options specified in the SSH config file, so instead of entering the command-line arguments each time you wish to connect, you can modify the config file, see Recommended Open SSH Settings on page 88.

SFTP Command Line Options
SFTP is used for interactive file transfer between the local computer and a remote server. The following command sets up the needed settings for remote access:

```
sftp -C [unityid@]host
```

Where `-C` enables compression, `unityid` specifies the user account you wish to log in to, and `host` is the specific Remote Access Servers on page 65 you want to log in to.

Use `get` and `put` commands to transfer files. See the man sftp page for more information on using SFTP.

SCP Command Line Options
SCP is used for copying file(s) between locations. It can be used where both source and target are local, remote, or a combination of the two. The following command sets up the needed settings for remote access:

```
scp -C -c cipher [[user1@]host1:]file1 [[user2@]host2:]file2
```

Where `-C` enables compression, and
To upload a file from the current directory to your AFS home directory:

```
scp -C file unityID@host:file
```

To download a file from your AFS home directory to the current directory:

```
scp -C unityID@host:file file
```

See the `man scp` page for more information on using SCP.

## Connecting from Linux to Solaris/Linux Applications

If you have set up your Linux computer using the instructions in *Recommended Open SSH Settings*, you will be able to execute UNIX and AFS commands and to run both command-line and graphical applications from the Remote Access Servers on page 65.

Connect to the either `remote.eos.ncsu.edu` for Solaris applications and `remote-linux.eos.ncsu.edu` for Linux applications. Type `add` at the command line to get a list of available software.

## Connecting from Linux to Windows Application in VCL

The only way to run Windows applications remotely from the user's Linux computer is through the Virtual Computing Lab (VCL) ([http://vcl.ncsu.edu](http://vcl.ncsu.edu)) using a Remote Desktop Protocol (RDP) connection to:

- load in the connection settings from the VCL RDP file, and
- connect to the IP address of the remote Windows computer that has been installed with the requested application.

### Remote Desktop Connection

**Remote Desktop Connection (RDC)** is client software from Microsoft that runs on the user's computer (Windows, Mac or Linux). It enables the user to connect to computers in the Virtual Computing Lab ([http://vcl.ncsu.edu](http://vcl.ncsu.edu)) for the purpose of running Windows applications remotely.

The connection is made through an open multi-channel protocol called **Remote Desktop Protocol (RDP)** to Windows servers that run Microsoft Terminal Services. These multiple channels allow you to tunnel resources from the server to your computer. The graphical interface (GUI) of the remote computer can be displayed on your personal computer. You can tunnel drive access, printing, and even sound, which enables you to print to your local printer, save to the hard drive on your own machine, and listen to any sound generated on the server.

To connect to VCL Windows computers, make sure that your computer has a RDC client installed. Connections through older protocols to remote-access services will be refused, so users may need to change or upgrade the software they use.

### Installing a Remote Desktop Client on Linux

Linux users must download and install the Remote Desktop Connection (RDC) client for Linux called `rdesktop`. ([http://www.rdesktop.org](http://www.rdesktop.org))

`rdesktop` supports all features of RDP, including mapping local drives and printers to the remote computer:

```
rdesktop [options] server
```

A full list of options are documented in the `rdesktop` man page, but a sample command line might look like the following:

```
rdesktop -g 1024x768 -a 24 -r disk:home=/home/<userid> -r disk:root=/ -r printer:<localqueue>
```
Users may be interested in the GTK frontend, tsclient for rdesktop at http://www.gnomepro.com/tsclient/. However, it does not support all of the features that rdesktop supports, specifically device redirection for printers, disks, and COM/LPT ports.

Linux Remote Desktop Connection to VCL Windows Applications

To connect from your Linux computer to a remote VCL Windows computer:

1. Select Make a VCL Reservation or Current Reservations at http://vcl.ncsu.edu and log in with your username and password.
2. Select the Connect! button for the Windows reservation you made.
3. On the command line of your local computer, run rdesktop followed by the IP address of the remote computer provided to you on the VCL Connect! web page, e.g., rdesktop 152.1.14.32.

   Note: If you are on a Linux lab computer, first type add netutils before running rdesktop.

4. In the Windows login screen, type in the temporary Password provided on the VCL Connect! page for the specific reservation.

Virtual Computing Lab (VCL)

The Virtual Computing Lab (VCL), http://vcl.ncsu.edu, is an on-demand, 24/7 facility that connects NCSU users to high-end computers for the purpose of running software applications remotely. The VCL is a joint project of College of Engineering ITECS and Office of Information Technology (OIT). It was designed to address the computing needs of both local and distance students and faculty, who require round-the-clock access to university-licensed software to conduct their studies and research.

See the VCL site at http://vcl.ncsu.edu/help/ for complete help documentation.

Reserving a VCL Computer

To connect to the Virtual Computing Lab (VCL) to schedule and run an application on a dedicated remote computer:

2. Log in through NCSU WRAP with your Unity ID and password.
3. Select New Reservation.
4. Choose the application and operating system environment (Solaris, Linux, Windows) from the pull-down list of available applications.
5. Select the radio button beside Now if you wish to use the application immediately. Select the radio button beside Later to run the application in the future, and enter the day and time.
6. Select the Duration for how long you need the application: 30 minutes, 1 hour, 2 hours, or 4 hours.
7. Select Create Reservation.

If you choose to use an application now:

You will be taken to a Current Reservations page with a note in red that says Pending.... When the application is set up on the remote computer (requiring as much as 1 to 20 minutes to load), the Pending... note will be replaced by a Connect! button.

If you schedule to use the application later:
You will get a reservation confirmation by email. Return to http://vcl.ncsu.edu at the specified reservation time and select the Current Reservations link to connect to the application.
AFS File System

Adapted from the Open AFS Guide -- http://openafs.org/doc/

AFS is the campus file system that everyone shares. AFS makes it easy for people to work together on the same files, no matter where the files are located. AFS users do not have to know on which computer their files are stored, and administrators can move files from computer to computer without interrupting user access. While AFS makes file-sharing easy, it does not compromise the security of the shared files.

As a distributed file system, AFS joins together the file systems of multiple file servers. A distributed file system has two main advantages over a conventional centralized file system:

- **Availability**: Copies of files can be stored on many file servers. An outage on a single server or even multiple servers does not necessarily make a file or application unavailable. Instead, user requests for the file or application are routed to accessible servers.
- **Efficiency**: In a distributed file system, the workload is distributed over many smaller computers. AFS also relies on the power of the user’s client workstation for computation, so increasing the number of users and workstations does not slow AFS performance appreciably.

AFS Cells and Sites

Just like the UNIX file system, AFS uses a hierarchical file structure (a tree). Under the /afs root directory are cells. A cell is the administrative domain in AFS and can be owned by a company, a university, or any defined group of users. Each cell is autonomously administered. Cell administrators determine how workstations are configured, how directories are organized, and how much storage space is available to each user. While organizing and maintaining its own file space, each cell can also connect with the file space of other cells running AFS.

The result is a huge file space that enables file sharing within and across cells. The cell to which your client computer belongs is your local cell. All other cells in the AFS file space are termed foreign cells, such as athena.mit.edu or umich.edu. An AFS site is a grouping of one or more related cells. For example, the bp.ncsu.edu, eos.ncsu.edu, and unity.ncsu.edu cells at NCSU form a single site.

**AFS File Tree: NCSU Cells (bp, eos, unity) and Selected Branches**

```
/afs/
  athena.mit.edu  bp.ncsu.edu  cmu.edu  eos.ncsu.edu  umich.edu  unity.ncsu.edu ...
    contrib  dist  engwww  courses  lockers  lockers  users
      jdk  openoffice  pine  ansys  mailab  sas  acc ... e ... zo  a ... j ... z
       bin ... src  e115 jsonpublic
```
AFS Volumes and Mount Points

The storage disks in a computer are divided into sections called partitions. AFS further divides partitions into units called volumes.

An AFS volume is a container for storing a subtree of related files and directories. It also has a completely independent size limit, or quota. Each user home directory is housed in one volume, which keeps its contents together on a file-server partition. Your system administrators can move volumes from one file server to another without your noticing because AFS automatically tracks a volume's location.

AFS tracks and accesses the contents of a volume by its mount point. An AFS mount point is a special file system element that looks and acts like a regular directory but tells AFS the volume's name and location. Your own volume resides on one of many file servers, and the mount point is the pointer that AFS uses to find and retrieve it for you.

For example, the volume for the user jqpublic in the unity.ncsu.edu cell is called user.jqpublic. A mount point exists in the /afs/unity.ncsu.edu/users/ directory named jqpublic. It points to the volume user.jqpublic. The convention NCSU follows in naming user volumes is user.unityid.

AFS Volume Quotas

Each AFS volume has its own size restrictions, or quota, assigned by the system administrator. A volume's quota determines the maximum amount of disk space the volume can consume.

A volume's quota, measured in 1 kilobyte (1024 bytes) blocks, determines the storage space allowed in the volume. When users exceed their quota, they will receive error messages. As a result, users should check their quotas often by logging in at http://sysnews.ncsu.edu/ and checking User Info and Quota Manager.

Each user's home directory (volume) is located on a disk partition with many other users. The quota command shows both percent of volume and percent of partition used, e.g.,

Volume Name: users.m.mcdaniel
Quota: 50000
Quota Used: 25000
Percent Used: 50%
Partition: 98%

The Quota Used and Percent Used of volume are the critical numbers to watch. The Partition does not affect your account, even if it is as high as 98%, which on a large partition still leaves ample disk space to use. However, if Partition reaches 100%, please contact your system administrator at help@ncsu.edu.

Locker: An AFS Volume

Locker is a non-technical name for an AFS volume. An AFS volume is a container for storing a subtree of related files and directories. It also has a completely independent size limit, or quota. Each user home directory is housed in one volume, which keeps its contents together on the file system. The terms directory and locker are often used interchangeably and actually look the same to the user on the system, but a volume is used for very targeted kinds of file storage and access.

Users often call their home directories their "lockers," which they are because they are unique and separate from directories above or beside them. Permissions and quota are individually set for each home directory, and the user alone is in control of what happens in his or her locker. Likewise, software is stored in individual lockers, which can be restricted to certain users.
**AFS Cache Manager**

The *cache manager* is your agent in accessing information stored in AFS. When you access a file, the cache manager on your client machine requests the file from the appropriate file server machine and stores, or *caches*, a copy of it on your client machine’s local disk. Application programs on your client machine use the local, cached copy of the file. This improves performance because it is much faster to use a local file than to send requests for file data across the network to the file server.

Saving your file sends the changed file back to the appropriate file server where the file is stored. In campus labs, you cannot save files to the workstation’s local drive. When you log out, the C: drive or local disk is cleared. However, because files are saved by default to your home directory in AFS, unless you change the path, your files are safely stored on network file servers, which are also backed up nightly.

Just remember to save often, which writes your data to permanent storage on the file server, and do not use the local drive for more than temporary storage.

**AFS Security and Tokens**

To identify yourself to AFS, you enter your Unity password to prove that you are who you say you are. When you provide this password, you become *authenticated*, and your cache manager receives a *token*.

A *token* is a package of information that is scrambled by an AFS authentication program using your AFS password as a key. Your cache manager can unscramble the token because it knows your password and AFS’s method of scrambling. The token acts as proof to AFS server programs that you are an authenticated user. The token is also used for *mutual authentication*. When your cache manager contacts a file server, it also sends your token. Under mutual authentication, both parties communicating across the network prove their identities to one another. AFS requires mutual authentication whenever a server and client communicate with each other.

**AFS Access Control Lists**

AFS uses an *access control list (ACL)*, pronounced “ackle”) to determine who can access an AFS directory and what actions they can perform on its files, e.g., read, write, administer, etc. Each directory has its own ACL, either individually defined or inherited, and up to 20 users or groups can be assigned unique rights to the space. Two general types of AFS commands can be run from the command line in a terminal window: file server (*fs*) commands and directory protection commands (*pts*).

It is important to know that in setting or understanding access permissions in AFS:

- AFS assigns permissions at the directory level, not the file level. As a result, you organize your files into directories in order to grant others access to them.
- Subdirectories inherit the ACL of the parent directory, but subdirectory ACLs can be changed by the owner to differ from the parent directory. When you grant access to a directory, you also grant access to all new subdirectories created under it. In addition, if a file is moved to a directory where the access permissions are different, the file will inherit those new settings.
- The lowest level “lookup” setting is *I*, and it must be combined with the other settings for them to work. Also, a user must have *I* permission on the parent directory to reach its subdirectories. The *I* setting permits the user to move through directories to get to ones below it. Otherwise, the user will be stopped in his/her navigation with a “permission denied” error.
Levels of Access on AFS Directories

AFS assigns permissions at the directory level, not the file level. You set permissions for directory access in the access control list (ACL). A directory's ACL is a list of users and groups and the rights they have to access and use the files in that directory, specifically, r-Read, l-Look, i-Insert, d-Delete, w-Write, k-Lock, and a-Administer. The owner of a directory (and anyone who has administer rights) can set and manipulate the ACLs for a directory.

r - read (and copy) the contents of files in the directory.

l - look (not read access). Can list (ls) directory and look at its ACL. You must have l access to use other access rights, e.g., to read you must have rl.

i - insert files or subdirectories (create new files, move existing ones).

d - delete files or subdirectories from the directory.

w - write or edit the contents of files in the directory.

k - lock. Sets an advisory lock on a file (not used often).

a - administer or change permissions in the ACL. Owner has administer rights.

Aliases for Access Settings

Aliases have also been set up for common levels of access, i.e., read, write, and administer. These can be used in place of the letter abbreviations.

read = rl (read and look)

write = rlidwka (all rights but administer)

all = rlidwka (full owner's permissions including right to administer)

none = remove all rights, e.g., fa sa directory username none

Note: Be careful giving all rights. Use write instead.

Viewing an Access Control List in AFS

A directory's access control list (ACL) is a list of users and groups and the rights they have to access and use the files in that directory, specifically, r-Read, l-Look, i-Insert, d-Delete, w-Write, k-Lock, and a-Administer. To look at the access rights on your home directory, type cd to return to your home directory and type the file server command, fs la (file server listacl). By default, this command shows you the access control list for the current (.) directory, e.g.,

% fs la

Access list for . is

Normal rights:

www: servers l

system: administrators rlidwka

mcdaniel rlidwka

You can also specify a path to a directory, e.g., fs la /path/to/directory/.

The output above tells you that system: administrators have full rights to administer your home directory, just as you do as owner of the directory (your user ID would replace mcdaniel): r-Read, l-Look, I-Insert, d-Delete, w-Write, k-Lock, and a-Administer. The campus web servers (www: servers) also have permission to pass through
your home directory to get to any subdirectories you have set up for the web, e.g., your www subdirectory.

Remember that AFS requires that the parent directory has I in order to read any subdirectories below it.

There are very few people with system administrator privileges, and they are carefully screened, full-time employees of the university computing staff. It is necessary for them to have access rights in order to assist you if you have problems with your account. It is not a good idea to change or remove the administrators’ permissions on your directories.

**Setting Access Control Lists in AFS**

A directory’s access control list (ACL) is a list of users and groups and the rights they have to access and use the files in that directory, specifically, r-Read, l-Look, i-Insert, d-Delete, w-Write, k-Lock, and a-Administer. To grant someone access to a directory, you must set access to it with the fs sa command (file server setacl). Use the following command syntax to set new access rights on a directory:

```
fs sa directory userid access
```

where directory is the name of or path to the directory to which access is being granted, userid is the login name of the person to whom you are granting access, and access is the permission being granted to userid.

For example, if jqpublic wants to give jouser full access rights to his ~/bin directory (except for administer rights), he would type the following at the prompt:

```
fs sa . jouser rlidwk
```

or

```
fs sa ~/bin jouser rlidwk
```

Or, he could use the alias write for rlidwk:

```
fs sa . jouser write
```

To take away or remove these rights, jqpublic would use the none access setting.

```
fs sa . jouser none
```

Fewer rights can be given than these. If jqpublic wants jouser to be able to read and copy his files but nothing else, he would set rl permission on the directory.

```
fs sa . jouser rl
```

Or, he could use the alias read for rl:

```
fs sa . jouser read
```

**AFS PTS Groups**

Another refinement to the standard UNIX protection scheme is that users can define their own protection groups, or pts groups. A pts group is a defined list of individual users that you can place on the access control list (ACL) of your directories. Instead of adding and removing individuals separately, you can add/remove them as a group.

Each user who belongs to a group inherits all of the permissions granted to the group on the ACL. AFS permits only 20 users or groups for each directory. As a result, if you want to grant access to 25 people, you could not do so unless you put them in a group.

When you create a group, you automatically become its owner. You create a group with the pts creategroup command (or pts cg):

```
pts cg owner:group
```

where owner is your Unity ID and group is a name you make up for the group. Most groups have these two parts: the part before the colon tells who owns the group, and the part after is the group’s name.
Groups that do not have an owner prefix are special groups created by system administrators. All of the groups you create must have an owner prefix and a colon before the group name.

You add a member to a group with the `pts adduser` command (or `pts ad`).

```
pts ad userid owner:group
```

where `userid` is the Unity ID of the person you want to add, and `owner:group` is the name of the group you have created. This command places that user in the group. There is no restriction on the number of members in a group.

You check who is in the group with the `pts membership` command (or `pts m`).

```
pts m owner:group
```

You remove a member from the group with the `pts removeuser` command (or `pts rem`).

```
pts rem userid owner:group
```

You delete a group with the `pts delete` command (or `pts del`).

```
pts del owner:group
```

To get a full listing of `pts` commands:

```
pts help
```

---

**PTS Example**

In the following example, `jqpublic` makes a `classproj` directory that he and three classmates (Unity IDs: moe, larry, and curly) can all work in together. `jqpublic` creates the group `jqpublic:projgroup` and adds moe, larry, and curly to it. He adds this group to the ACL of the `classproj` directory with the `fs sa` command and gives the group write access (rlidwk).

```
mkdir classproj
cd classproj
pts cg jqpublic:projgroup
pts ad moe jqpublic:projgroup
pts ad larry jqpublic:projgroup
pts ad curly jqpublic:projgroup
```

Or, to add all three users in one command:

```
pts ad -user moe larry curly -group jqpublic:projgroup
```

You grant access for a group the same way you would for an individual:

```
fs sa . jqpublic:projgroup write
```

To check the membership of the group:

```
pts m jqpublic:projgroup
```

Members of `jqpublic:classproj` are:

```
moe
larry
curly
```
AFS Directories

The AFS file-management software on Eos/Unity builds a tree hierarchy of all user and software directories, plus hundreds of other specialized directories for courses, projects, and university units. It is this shared file space that makes the Eos/Unity system unique. Everything is somewhere represented as a branch on the tree. AFS stores all these directories on network server machines and then retrieves them for the user, no matter when or where s/he is logged in, or on which realm platform.

For example, users who log in to the system are automatically placed in their home directories, where the files they create are collected and stored. Each home directory, identified by the user’s Unity ID, defines a branch in the tree that belongs to that user alone, e.g., /afs/unity/users/j/jqpublic/. However the user is free to move around the tree and go wherever access is granted, to locate software, class information, user tools, and other resources.

All directories in AFS branch from the root directory, /, the top-most directory in the tree. A subdirectory is a child directory to the parent directory just above it in the hierarchy. Every directory, except the root directory, has one parent, and directories can be nested to any depth.

An AFS mount point is a special type of directory that connects a location in the AFS file space with a volume. A mount point looks like a standard directory. Listing the directory shows the contents of the volume. Each mount point corresponds to a single volume.

AFS Paths

You generally work in one directory or folder at a time. Whatever directory you are working in at the moment is called the working or current directory.

A default directory is the directory that the system puts you in automatically. For example, when you log in, you are placed by default in your home directory. On Solaris and Linux, if you are working outside your home directory, you can type cd by itself or cd ~ to take you back to the default directory (the tilde ~ is the symbol for your home directory). On Windows, you are placed by default on the desktop, and your home directory is the K: drive and My Documents.

Absolute Path

The path to a directory in the campus AFS file tree originates in the root directory, /. Other slashes join the names of subsequent subdirectories until the working directory is reached, e.g., /afs/unity/users/j/jqpublic/ or /afs/eos/courses/e/e115/. This full or absolute pathname of a directory always starts at the root directory. No matter how long the path is, it always has the same starting place.

On Windows, /afs has been mapped to the J: drive, so the absolute path will be J:\unity\users\jqpublic or J:\eos\courses\e\e115.

On Solaris and Linux, the user can change the eos% or unity% prompt to show the path of the working directory. If the path is displayed, the user does not have to type the pwd command to see where s/he is. In an editor, open the file .mycshrc in your home directory (e.g., nedit .mycshrc) and add the line:

\[\text{set prompt}=\text{“%/ %”}\]

(percent, forward slash, space, percent)

Save the file, and the path of the working directory in AFS will always display as the prompt.
Relative Path

A relative pathname begins in the working or current directory, so the part of the path above the working directory is not referenced. A relative path is used to refer to file and directories below the working directory, which acts as the root. For example, if jqpublic is in his home directory, the relative path to his personal web page is www/index.html. The absolute path would be /afs/unity/users/j/jqpublic/www/index.html.

If you are granted access to other parts of the AFS tree, you will be able to move through and look at other directories. You may even be able to read and write in other directories if explicit permissions are set to grant you that access.

The whole campus is interconnected through AFS, making possible a lot of common access and file-sharing. The key to getting where you want to go in AFS is the pathname of the desired location (i.e., file or folder) and the permission to access it. AFS pre-dates the World Wide Web but works in much the same way, that is, know the pathname (address) of what you want and have the authorization to access it.

A pathname is simply a map that shows you how to get to a file through levels of nested subdirectories. It is like a route charted through a maze of streets that takes you to the address you want to reach.

AFS on Windows

The Windows workstations in Eos and Unity labs are full AFS clients, but the way they interface to the campus file system is different from Solaris and Linux. Once again, nothing is command driven in Windows. AFS control is available from the main File -> AFS menu on system directories. Remember that access control is set at the directory (folder) level, not on individual files.

If you have used Windows computers before, you will not have seen AFS on the File menu. It is a special customization that was done to make the Windows platform fit into the Eos/Unity AFS infrastructure so that files could be accessed and shared easily.

Your K: drive is mapped to your home directory in AFS. Right-clicking the K: drive brings up the File menu, and selecting AFS brings up a submenu of AFS functions.

1. Select drive or folder.
2. File -> AFS

When the Access Control List is selected from the menu, the AFS ACL dialog box pops up showing the same permission settings on your home directory that you see from the command line with the fs la command.

If you were to give someone read permission on your home directory or, preferably, a subdirectory, you would do the following:

1. Select File -> AFS -> Access Control List
2. Type a user’s Unity ID in the Name field.
3. Select the checkboxes for permissions (e.g., r and l for read access). Select OK.

Other tools and checks can also be selected from the AFS menu. For example, the user can check the quota on his/her home directory, or user volume, by selecting File -> AFS -> Volume/Partition. It is the same as typing the quota command on Solaris and Linux workstations, or fs lq.

A Help system is available for the Windows AFS client with information on how to work with AFS functions and tools. It can be brought up by selecting the Help button on any of the AFS tool bars and dialog boxes.

It is also possible to use the fs and pts commands from the MS-DOS command. Start -> Programs -> Accessories -> Command Prompt. At the command prompt, you can change to one of the AFS drives and run your AFS commands from there. Type K: or J: and press Enter to change to that drive.
Use the commands `dir` (not `ls`), `fs`, `pts`, `mkdir`, `cp`, `rm`, etc., as you are used to. Consult Help for more on using AFS commands at the prompt.

OpenAFS: Native Access to AFS

NCSU has a large AFS network, which is used to serve user home directories, course lockers, research and project file space, and software. It is possible for users to gain access to AFS by running an OpenAFS client (http://www.openafs.org) on their personal computers.

The OpenAFS client, working with Kerberos, joins the file system of your local computer with the campus AFS file system. It allows you to access AFS on your personal computer in ways you are familiar with (K: and J: drives on Windows, /afs on Unix/Linux), and you can work with the files on those drives just as you would in an Eos or Unity lab. You can open, edit, and save files as if they were on your local computer, while the client takes care of transferring them to and from the campus network. In short, the AFS file system comes to you through the OpenAFS client, and you do not have to go to a lab to have direct access to AFS.

OpenAFS is the open-source organization that maintains and distributes clients for AFS. OpenAFS provides clients for many operating systems, but the three most commonly used by students at NCSU are the ones for Windows, Linux, and Mac OS X. Kerberos is built in to Linux and Mac OS X, but Windows users will have to use the Kerberos for Windows software.

Important! For the user who needs routine access to AFS, the methods described at http://www.eos.ncsu.edu/remoteaccess/ are recommended over running an AFS client. The ExpanDrive software at http://www.eos.ncsu.edu/software/downloads/ can be used to map AFS drives to your local computer and works very well.

AFS and UNIX

AFS is designed to be similar to the UNIX file system. For instance, many of the basic UNIX file commands (cp for copy, rm for remove, and so on) are the same in AFS as they are in UNIX.

However, AFS augments and refines the standard UNIX scheme for controlling access to files and directories. Instead of using mode bits to define access permissions for individual files, as UNIX does, AFS stores an access control list (ACL) with each directory. The ACL defines which users and groups can access the directory and the files it contains, and in what manner. The following list summarizes the differences between the two methods:

- UNIX mode bits specify three types of access permissions: r (read), w (write), and x (execute). An AFS ACL specifies seven types of access permissions: r (read), l (lookup), i (insert), d (delete), w (write), k (lock), and a (administer).
- The three sets of mode bits on each UNIX file or directory enable the user to grant permissions to three users or groups of users: the file or directory's owner, the group that owns the file or directory, and all other users. An AFS ACL, on the other hand, can accommodate 20 entries on a directory, each of which extends permissions to a user or group. Unlike standard UNIX, a user can belong to an unlimited number of groups, and groups can be defined by both users and system administrators.
- UNIX mode bits are set individually on each file and directory. An AFS ACL applies to all of the files in a directory. While at first glance the AFS method possibly seems less precise, in actuality (given a proper directory structure) there are no major disadvantages to directory-level protections, and they are easier to establish and maintain.
- To access a file in a remote computer's UNIX file system, you must log into the remote machine or create a mount point on the local machine that points to a directory in the remote machine's UNIX file system. To access a file on a remote machine in AFS, you simply specify the file's pathname.
AFS Glossary

access control list (ACL): A list associated with an AFS directory that specifies what actions a user or group is permitted to perform on the directory and its files.

cac entry: An entry on an ACL that pairs one user or group of users with specific AFS access permissions. An entry can be normal, granting the user or group specific permissions, or negative, denying the user or group specific permissions.

afs uid: An identification number assigned to each AFS user and group. It is guaranteed to be unique.

Andrew File System (AFS): A file service that joins the local file systems of several file server machines. Files are stored (distributed) on different machines in the computer network but are accessible from all machines.

authenticated: The state of a principal whose identity has been verified by AFS.

authentication: Verification that a user or process is presenting a valid identity. Authentication involves certifying that a password provided by the user is correct.

cache manager: The portion of an AFS client machine that communicates with AFS server processes by translating file requests made locally into remote procedure calls. It stores the requested files in a cache on the local disk, from which it makes the files available to local users.

cell: An administratively independent site running AFS and consisting of a set of file server machines and client machines. A machine can belong to only one cell at a time.

file server: A type of machine in AFS used to store files and transfer requested files to client machines.

foreign cell: An AFS cell other than the one to which the local (client) machine belongs. The local machine's cell is referred to as the local cell.

local cell: The cell to which the local client machine belongs. Even though a user can authenticate in a foreign cell or fetch files from it, the identity of the local cell remains the same throughout a logon session.

mount point: A special type of directory that connects a location in the AFS filespace with a volume. A mount point looks like a standard directory. Listing the directory shows the contents of the volume. Each mount point corresponds to a single volume.

network drive: A connection to the hard drive of a remote computer, allowing you to access shared files and directories. You can establish a network drive connection to a directory in the AFS filespace.

partition: A logical section of a disk in a computer.

password: A unique, user-defined string of characters that validates the user's system identity. The user must enter the password to become authenticated.

quota: The size limit of a volume assigned by the system administrator and measured in kilobyte blocks.

token: A set of data that is granted after a user authenticates to AFS. A token is used by the cache manager when requesting services from AFS servers. A token has an associated lifetime and expires after a set period of time. If your token expires, you no longer have authenticated access to AFS.

volume: A "container" that keeps a set of related files and directories together on a disk partition that is specific to AFS.

volume location server: An AFS server process that maintains the Volume Location Database, which records location and other status information about all volumes in the cell.

UNIX Operating System

UNIX was the original operating system for Eos/Unity and has been supported for nearly 19 years as its principal platform. A mainstay of high-end computational computing, UNIX is powerful, secure, and robust. The UNIX on Eos/Unity is Sun Solaris. Linux, a UNIX variant for the Intel PC, shares the strengths of UNIX, but is cheaper, open source, and runs on personal computers. The Linux on Eos/Unity is Red Hat Enterprise Linux.

UNIX and its applications are not widely known in the world of personal computing, which mainly belongs to Microsoft. However, educating students in computing technology means exposing them to operating environments they do not already know. Also, much high-end engineering computing runs on UNIX.

UNIX Shortcuts

The following suggestions will make working on UNIX easier.

Copying and Pasting Between Windows

One of the most useful functions is the ability to copy and paste information from one windowed application to another:

1. Hold down the left mouse button and drag over the content you want to copy.
2. Put the cursor at the place where you want the content copied and click the middle mouse button.

You cannot do this quite as easily on Windows. You must use the standard copy and paste methods

Completing Command Entry with Typing

You can use the Tab key to save you time in typing commands, pathnames, or data. For example, if you issue a command that affects the file softwarelist, you do not need to type all the characters in this long filename. You can simply type the first characters in the name, until it is distinguished from all other files in the directory, and then press the Tab key to let the system finish the typing for you.

For example, if softwarelist is the only file that begins with the letter s in the directory, then the s and Tab keys are all you would have to type to expand this filename on the command line, e.g.:

more s[Tab]

Repeating Commands with Typing

To repeat a command that you have typed previously in a session, press the up-arrow cursor key until you find the command again. To execute the command after you have found it, press the Return key. If you want to modify the command before executing it, use the right and left cursor keys to position the cursor and type in or delete characters as appropriate.

The history command also displays the last commands you typed in a session up to whatever number is specified in the shell environment (type set to see the setting for savehist). If the savehist variable is set to 100, your last 100 commands have been recorded and can be displayed with the history command.

Commands are numbered in the order you typed them. If you want to execute the last command you typed, type two exclamation marks (!!) at the prompt, or use the up arrow key as described above.

!!
If you want to execute an earlier command in the list, type an exclamation mark ! (sometimes called a "bang" or a "shriek") followed by the line number of the command, line 34 for example.

!34

**Aliases**

Often, you find yourself typing the same commands, filenames, and paths over and over. Or, you find that you confuse UNIX commands with the commands of another operating system you know better. If you wish, you can create substitutions or aliases for these files, paths, and commands, using something shorter and easier to remember. For example, to type `portfolio` instead of `cd /afs/unity/users/u/unityid/www/portfolio/` to change to that directory:

```
alias portfolio cd /afs/unity/users/u/unityid/www/portfolio/
```

The command `alias` is followed by the substitution you want to use and then the original path, filename, or command (or a combination of these) that you want the alias to replace. If you have aliases that you want to use all the time, put them in your `~/.myschrc` file, which is read when you log in.

To take out an alias, use the `unalias` command. For example, to undo the portfolio alias you created (remove the alias from your `~/.mycshrc` file if you put it there):

```
unalias portfolio
```

**Useful Key Combinations**

Individual keys and key combinations will perform particular operations and functions that can help you or save you time. When you see instructions that tell you to press some kind of `Ctrl+character` combination, it means to hold down the `Control` key (or the `Ctrl` key on some keyboards), and press the character key indicated. The action is similar to holding down the `Shift` key and pressing a key to make an uppercase letter.

- `Ctrl z` Suspend a process
- `Ctrl c` Cancel or abort a process

**Wildcards and Metacharacters**

Wildcards are special characters designed to work in place of other characters and strings of characters in command arguments. They save you time when you are trying to work with a number of files at once.

The asterisk `*` (called a "star") can be used in place of any string of characters. For example, to list (command `ls`) only the files in a directory with the extension `.doc`:

```
ls *.doc
```

Use the wildcard with any command that operates on files: copy, remove, print, etc. This way, you do not have to work with files individually but can manage them as groups. The `*` by itself stands for all files. As a result, if you type `rm *`, you will remove all the files in a directory. Be careful with wildcards, and use the `-i` (interactive) option with commands like `rm`. This option asks the user for confirmation before removing each file.

The question mark `?` represents a single character.

```
ls essay?
```

lists all the files you named `essay` followed by a single character, such as,

```
e ssay1 essay2 essay3 essay4
```
Redirection of Input and Output

The keyboard and terminal screen are UNIX's standard input and output devices, respectively. UNIX expects input from the keyboard and always sends output to the screen, unless told to do otherwise. Redirection is the process of changing the source and destination of input and output.

To UNIX, your screen is just another file. When a command generates output, the shell writes it to a standard output (abbreviated stdout) file, which puts the data on your screen.

However, you can redirect this output if you wish, sending it to another file instead. For example, if you want a directory listing sent to a file rather than to your screen, you might type

```
ls -al > myfile
```

where *myfile* is the name of the file that receives the directory-listing output. The right-angle bracket (>) tells the shell to perform the redirection. If *myfile* does not exist, it will be created. If it does exist, its contents will be overwritten by the new data. To append the data to the contents of a file rather than overwriting them, use two right-angle brackets instead of one. The following command places the directory listing at the end of any data already in the *myfile* file.

```
ls -al >> myfile
```

To merge the contents of files together, that is, concatenate them, use the `cat` command and redirection. For example:

```
cat file1 file2 > file3
```

merges *file1* and *file2* into a new file called *file3*. The right angle bracket tells the system to send the result of the concatenation to *file3*.

Pipes and Pipelines

The process of piping sends output to a command or a series of commands. A series of commands is called a *pipeline*. You pipe data from one command to another by entering the commands on a single line with a vertical bar between them. In this way, the output of one command becomes the input to another command.

Say you list (`ls`) a directory with many files in it, so many that they scroll off the screen before you can read them. You can pipe the *ls* command through `more` to move through the directory listing page by page instead, e.g.,

```
ls -l | more
```

Command Options and Arguments

Commands tell the computer what actions to perform. However, if you want a command to behave in a particular way on a certain file, you must add that information to the command as *options* and *arguments*.

The portion of a command that names the file(s) or entity to be affected by the command is called an argument, e.g., `rm file`, where `rm` is the command and `file` is the argument. It is also common to add options after a command. Options (often single characters or a whole word preceded by a hyphen) specify a variation in the basic command, telling it to do something in a specific way. For example, you can add the option `-I` to be prompted before removing a file, or `-f` not to be prompted, or `rm -I file` or `rm -f file`, respectively.

Example of Options and Arguments

A full command consists of a command, followed by zero or more options, followed by zero or more arguments.
command option argument

For example, if you type the command `ls` to list the files in a directory, the system will display a multi-column list of files and subdirectories. If you want more information about these files, e.g., when they were created or how big they are, you would add the `-l` option to specify a long listing. If you want hidden files (dotfiles) listed as well, you would add the option `-a` for all. If you want to know which listings are actually subdirectories rather than files, you would add the `-F` option. The directory name or path to the directory is the argument, e.g.:

```
ls -alF /path/to/directory/
```

UNIX File Naming

Operating systems have conventions that users need to adhere to in naming their files and directories. File names can be up to 256 characters in length; however, as a rule, they should be relatively short, unique, easy to remember, and accurately descriptive of the file contents.

**UNIX file-naming, like command entry, is case sensitive**. For example, the files--`file.txt`, `FILE.txt`, and `File.txt`--are three different files, not one. Also spaces are not accepted in UNIX files names. By contrast, Windows file naming is tolerant of spaces and is not case sensitive. Users should be aware that even if they work primarily on the Windows platform, the Eos/Unity backend and file system are UNIX based. The safest practice is to leave out spaces in file names and be careful with capitalization.

If you use a period as the first character of a file name, you create a dotfile. Dotfiles are hidden files--often configuration files--that will not appear in an ordinary directory listing.

**Characters to Avoid in File Names**

Although most characters will be accepted in a file name, many should be avoided since they can cause problems or confusion. Some characters have already been assigned special meaning. For example, you should not use the "slash" character (`/`), which is the symbol for a directory.

- Ampersand `&`
- Asterisk `*`
- “At” sign `@`
- Brackets `[ ]` `{ }`
- Caret `^`
- Dollar sign `$`
- Parentheses `( )`
- Percent sign `%`
- Period `.` (except to create dotfiles or extensions)
- Pipe `|`
- Quotation marks `" "`
- Tilde `~`
- Slashes `/`
**Naming Conventions for Extensions**

The period should be used with caution since it has its own special meaning in a file name. The period is used to add an extension to a file name, additional characters that tell what kind of file it is or to identify it further. For example, the extension identifies file.c as C code, file.xls as an Excel file, and file.txt as ASCII text.

- .bmp bitmap (graphics)
- .c C (program)
- .C C++ (program)
- .doc document
- .f Fortran (program)
- .gif Graphics Interchange Format
- .html HyperText Markup Language
- .jpg Joint Photographic (graphics)
- .pdf Portable Document Format
- .ps PostScript (print)
- .tar Tar (archive)
- .tex TeX (document)
- .txt ASCII (text)
- .Z compressed

**UNIX Man Pages**

Information is available online to explain how to use most of the commands you encounter on the system. In fact, all UNIX commands are described in the online documentation called the UNIX Man(ual) Pages. A separate man page exists for every command. The man command followed by the name of a UNIX command will bring up that command’s man page in a more display format. Man pages can also be found online on the web.

**man command**

Most man pages provide the following information:

**Name**: A simple definition of the command.

**Syntax**: The correct way to type the command and its options and arguments.

**Description**: A longer explanation of how to use the command and in what situations.

**Options**: The options (characters or terms preceded by a hyphen) that may be combined with the command and what effect they have.

**Restrictions**: Known limitations on the use of the command.

**See Also**: A list of cross-references to other commands that are related to or can shed light on the use of the command.

Commands have a numerical argument, such as `chmod(2)`, which refers to the type of command it is:
1. User Commands
2. System Commands
3. Library Calls
4. Devices
5. File systems
6. Games
7. Miscellaneous
8. System Administration

- l - Local Commands
- n - New Commands

Most of the commands the general user will be referencing will be of the (1) User Command variety, so this is the default. Some commands, such as chmod, have multiple usages.

To look up a set of commands of a particular type, use man with the option -k for keyword, which lets you to specify a keyword to search for. For more information on the man command, a logical place to look is man man, which displays the UNIX manual page on man itself.

The C Shell

UNIX is composed of two main layers, a kernel and a shell. The shell surrounds the kernel, which is the core programming that is responsible for machine-level operation and connection to hardware devices. Few users ever communicate directly with the kernel. Instead, users send instructions to the shell, an outer layer of software that interprets and executes commands, passing on to the kernel any further processing that may be required. For example, a user may give the lpr command to print a file, which the shell interprets and executes. However, the actual connection and transmission to the printer itself is handled by the kernel.

When you log in, the operating system starts a shell for you. The characters you type are entered into a command-line buffer. When you press the Return key at the end of a line, the operating system accepts the contents of the buffer as the command and then interprets it. If it cannot tell what the command means, it delivers an error message back to the user. For example, if you type copy instead of cp when you try to copy a file, you will get the message:

copy: Command not found

A command to the shell, or shell command, actually tells the shell to run a program. The cp command tells the shell to run the copy program.

The user enters instructions and commands to the shell at the shell prompt. The percent character (%) in the prompt is not an arbitrary character. It stands for the particular kind of shell the system is running, in this case, a C shell, or tsch, the enhanced version of the Berkeley UNIX C shell. If the symbol were a dollar sign ($), then it would mean that a Bourne shell is running.

More than one shell can run at a time. Each time the user opens an Xterm terminal window, a new shell is created to accept user input.
Environment and Shell Variables

Your environment is determined by the behavior of the shell and other programs that interact with it. The shell has a facility for storing data in variables. There are two categories of variables: environment variables and shell variables.

Environment Variables (printenv, setenv)

Environment variables contain information about your working environment. They are "global" variables, that is, the values or settings for these variables are the same throughout all the shells you create. Environment variables determine the default operation of all shells and are also passed on to application programs. The list of environment variables is fairly lengthy and includes settings for a default printer, a default editor, a default path, etc. These variables are set by system administrators but can be changed by the individual user. To list them, type the command

```
printenv
```

To check the setting for a particular variable (variables are typed in uppercase letters):

```
printenv *PRINTER*
```

The format for setting the values of variables is:

```
setenv VARIABLE value
```

The setenv command is followed by the variable name in caps, followed by the value the variable should receive, e.g.,

```
setev *PRINTER* dan118
```

To undo a value setting for an environment variable:

```
unsetenv VARIABLE
```

Shell Variables (set)

Shell variables are specific to each shell; in other words, each window has its own shell variables that can be set. Shell variables work like environment variables, except for the following differences.

A set of shell variables is used by a single C shell only.

- Shell variable names are written in lowercase.
- Shell variables are displayed, set, and changed with the `set` command.
- Shell variables do not propagate to new shells or other programs.

Generally, shell and environment variables are independent, although they may look and behave similarly, both in name and purpose. Shell variables may also obtain their initial values from environment variables. However, once values are set for a shell, they will not be affected by changes in environment variables. Setting shell variables is a way of overriding environment settings in a shell.

To display shell variables (the equivalent of `printenv`):

```
set
```

To set or change a value for a variable, type the `set` command followed by the variable name (in lowercase), an equals sign (=), and the value assigned to the variable.

For example, to replace the eos% or unity% with ncsu:

```
set *prompt=ncsu*
```
If the value has internal spaces, you must put it inside quotations marks, e.g., to set the prompt to “You rang?”:

```bash
set prompt="You rang? ">
```

Or, to show the path of the working directory (pwd) as a prompt:

```bash
set prompt="%/
```

You can place this command in your .mycshrc file to have it come up with every terminal window all the time, not just for one shell or session.

To undo a value setting for a shell variable:

```bash
unset variable
```

### UNIX Directory Commands

Directory commands that users need to work on Solaris and Linux are typed in a terminal (Xterm) window on the command line after the shell prompt. Check the path (pwd) to make sure you are creating, listing, or removing directories where you intend.

#### Make Directory (mkdir)

The `mkdir` command creates a directory. Type the command mkdir followed by a space and the name you want to give to the directory. For example, if you are in your home directory and want to make a subdirectory called `homework`, type:

```bash
mkdir homework
```

UNIX creates a new subdirectory named `homework` and places it one level below the working directory. The relative pathname is `~/homework` (the tilde is the symbol for your home directory). It will appear as the `homework` folder on your K: drive on Windows.

#### Change Directory (cd)

The `cd` command changes or moves you into another directory. When you "cd" to a directory, you change your current working directory to the one you specify. For example, after creating the `homework` subdirectory in your home directory, you change into that directory by typing:

```bash
cd homework
```

The subdirectory `homework` is now your working directory, and the files you create will reside in this subdirectory. To change back to your home directory (the parent directory), type `cd` followed by a space and two periods. The two periods tell the system to take you up one level in the directory tree:

```bash
cd ..
```

or

```bash
cd ~
```

or

```bash
cd
```

The command `cd` by itself always returns you to your home directory (~) no matter where you are in the AFS tree.
List Files in a Directory (ls)

The `ls` command lists the names of all of the files in a directory. If you are in your home directory, `ls` will give you a directory listing of all of your files and subdirectories. If you want to see what files are in a subdirectory you created, either change into that subdirectory with the `cd` command and type `ls` to see a listing of its contents, or type `ls` followed by the absolute or relative pathname to the directory:

```
cd /path/to/directory
ls
```
or

```
ls /path/to/directory
```

You can also use the UNIX special symbols for directory-listing shortcuts. The command `ls ..` lists the files in the directory one level up (the parent directory). The `ls ~` command lists the files in your home directory, no matter where you are on the system. To list a subdirectory in your home directory, `ls ~/subdirectory`.

You can also tailor commands with options. For example, to list all files in a directory, including hidden files or dotfiles, add the `-a` option for all.

```
ls -a
```

To get more information about your files, including when they were made, their size, etc., use the `-l` option for long format listing.

```
ls -l
```

Or, type `ls -al` for both.

Copy Directories

To copy directories, use the `cp` command, the same command you use to copy files. However, you must add the `-r` option for recursive to copy the directory and all of its files and subdirectories to the specified target.

```
cp -r directory1 directory2
```

Remove Directory (rmdir)

The `rmdir` command removes or deletes a directory. UNIX will not remove a directory that you are currently working in or a directory that contains subdirectories, files, or dotfiles. You must completely empty a directory before you can remove it.

For example, if you want to remove the `subdirectory` homework from your home directory, first `rm` all files and subdirectories inside it. Then, type

```
rmdir homework
```

If you get a message, `rmdir: directoryname: Object is remote`, the system is telling you that the directory still has files in it. Use `ls -a` or `ls -al` rather than `ls` to view all the files. Sometimes, software will write dotfiles to your directories that a simple `ls` will not show. Remove them in the same way you remove an ordinary file.

```
rm file
```

```
rm * (to remove all files)
```

To remove a directory and all of its files and subdirectories (be careful with this!):

```
\rm -r directory
```
The add and attach Commands

`add` and `attach` are special commands on the system (not standard UNIX commands), which simplify locker access on Solaris and Linux. These commands allow users to attach a remote file system to a directory hierarchy on their workstations and then map the path to it to a shorter name space. They create a link from the longer pathname to the shorter one and also obtain AFS tokens that allow access to the files in that locker. As a result, instead of typing the long pathname (beginning with `/afs`) to change into the directory you want, you `add` or `attach` the locker you want and change directories into it using the short pathname, `/ncsu`.

`add` and `attach` are very similar. In fact, `add` calls the `attach` command but adds the `bin` directory to your path for that locker. Usually, you `attach` user and course lockers because you are not likely to want to execute any files in those directories. For example, to attach the locker for E115, where information about the E115 course is kept, type:

```
attach e115
```

Then change into that directory with the command `cd /ncsu/e115` rather than `cd /afs/eos.ncsu.edu/courses/e/e115/`. However, because you DO want to run all necessary programs in a software locker, you `add` software.

```
add matlab
```

However, the act of attaching/adding a locker does not necessarily mean that you can use the files in it. The e115 locker permits you to read and copy its files; however, you cannot change or delete them. Other lockers you cannot access at all. Permissions to use a locker must be set by its owner or administrator. As a result, you are only likely to attach/add lockers that you know have been set up for you to use.

So, what really happens when you `add` a locker, for example, `add gnu`?

1. `add` creates a symbolic link for the locker in `/ncsu`, that is, `/ncsu/gnu -> /afs/eos/contrib/gnu` by means of the `attach` program. To find out the path to the `gnu` locker before adding it, type `hes gnu`. After you `add` and `cd` into the `gnu` locker, type `pwd` to find out the path.
2. It updates your PATH and MANPATH environment variables to put all of the locker’s executables in your directory path (at the beginning) and all of the locker’s UNIX manual pages in the path where the `man` family of commands looks for them.
3. It executes commands found in a file called `.environment` located in the root directory of the locker. This file is generally used to display information about the locker’s contents and to configure any additional environment parameters as necessary.

UNIX File Commands

A command is simply a program that the computer runs. The following are the most frequently used commands for working with files on UNIX.

Display File Commands (more, less, head, tail)

The `more` command displays the contents of a file one screenful of text at a time in a terminal window (see help page, `man more`).

```
more file
```

`more` normally pauses after each screenful, printing --More-- at the bottom of the screen. If the user presses the spacebar, another screenful is displayed. The user can also move forward one page at a time by pressing the `f` key and backward by pressing the `b` key. The `q` key quits or closes the file, the `h` key brings up a help screen, and the `Return` key scrolls the text line by line. When more reaches the file’s end, it exits and returns the prompt. The `less` program is similar to more (see help page, `man less`).
However, instead of printing --More-- at the bottom of each screen, less tells the percentage of the file that has been displayed up to that point, giving you some idea about how much of the file is left to page through. The less program also does not exit when you reach the end of the file. You must type q to exit.

To display the first and last ten lines of a file:

head file
tail file

Concatenate Files (cat)

The cat command (short for concatenate, to link together) will also display the contents of a file on your screen (see help page, man cat). This command dumps the contents of a file in one burst onto the screen, so if the file is very long, it will scroll past faster than you can read it.

To merge or link two files together and create a third file:

`cat file1 file2 > file3`

To append two files to the contents of a third file:

`cat file1 file2 >> file3`

See Appendix A

To merge or link two files together and overwrite a third file:

`cat file1 file2 >>! file3`

In addition to these commands, the cat command can also be used to read input directly from the keyboard to create a new file.

`cat > file`

When finished with direct keyboard input, press Control d to quit. The cat command can also append what is typed to the contents of an already existing file.

`cat >> file`

Copy Files (cp)

The cp command copies the contents of one file to another (see help page, man cp). The file name and contents remain unchanged in the source file, and a copy of them is placed in the target file. The target file may have the same name or a new one, but the contents of the two files will be identical.

`cp file1 file2`

If file2 does not exist, it will be created and will contain the contents of file1. If it does exist, its contents will be overwritten by the contents of file1. However, if file2 is a directory, the system will know that and will place a copy of file1 in that directory, file2/file1. The file is the same in both places.

If you want to copy files from one directory to another, you must specify a path.

`cp olddir/file1 newdir`

This command copies file1 in the olddir directory to file1 in the newdir directory. Both directories will have a copy of file1, i.e., olddir/file1 and newdir/file1.

To copy a complete directory with all its files, add the -r option.

`cp -r directory1 directory2`
Move Files (mv)

The `mv` command is used both for moving and renaming files. The `mv` command moves the contents of the source file to a target file and then erases the source file. The effect is essentially that of renaming the original file (see help page, `man mv`).

`mv file1 file1old`

will give `file1` the new name `file1old`. The contents of the `file1old` file are the same as they were in `file1`; only the name of the file is different.

The `mv` command also moves files as well as renames them. To move `file1` from the `newdir` directory to the `olddir` directory

`mv newdir/file1 olddir`

The system knows that `olddir` is a directory and will move `file1` from `newdir` to `olddir` and preserve the name `file1`. `file1` is no longer in `newdir`.

Remove Files (rm)

To remove files from your account, use the `rm` command (see help page, `man rm`).

`rm file`

Caution! This command will permanently remove the files from your directory space and cannot be undone.

On the Eos/Unity system, the `rm` command is "aliased" to `rm -i` (-i for interactive) so that `rm` will prompt the user for confirmation before removing any files. This safeguard is good to maintain. However, if you want to remove files without prompting, you can unalias `rm` with `\`

`\rm file`

or

`\rm *`

to remove all the files in the directory you are working in. Use `rm` with care
Glossary

access control list (acl)
a list that specifies what access privileges users have to a directory, specifically, the right to lookup, insert, delete, read, write, lock, or administer files in a directory (abbreviated as l, i, d, r, w, k, a).

alias
an alternate name or abbreviation (usually short and easy to remember) that substitutes for a pathname, command, list, or expression (usually long and hard to remember).

Andrew File System (AFS)
a distributed file system that distributes, stores, and joins files on networked computers. It is a client-server architecture for file sharing, location independence, scalability, and transparent migration capabilities for data. see AFS Glossary on page 102.

argument
information the shell needs to perform a command, usually the file(s) or entity that will be affected by a command. In a command statement, the argument follows the command, e.g., delete file, where delete is the command and file is the argument.

ASCII
American Standard Code for Information Interchange, a standard computer code used to facilitate the exchange of information on various types of data-processing equipment. Files are produced in or converted to ASCII code to make them easier to move into or out of software applications running on different machines.

Athena Project
the joint project of MIT, Digital Equipment Corporation, and IBM in the 1980s that developed a distributed academic network for the MIT campus.

authentication
the recognition of a user as having a valid account on the system with legitimate access to its resources, usually determined during login by username and password.

background process (bg)
program that runs without interfering with command entry and processing taking place in other windows. The & character added after a command will run that process in the background.

cache manager
a program on a client machine that accesses files stored in AFS. When a user requests a file, the cache manager retrieves it from the appropriate file server and stores or “caches” a copy of it on the client workstation’s local disk for the user to use.

cache memory
a mechanism interposed in the memory hierarchy between main memory and the CPU to improve effective memory transfer rates and raise processor speeds.

cell
an independently administered site running AFS and consisting of a collection of file server and client machines defined as belonging to the cell. A machine can belong to only one cell at a time.
client

a program or machine that performs for a user, requesting files and information from a server program or computer in order to complete its function.

client-server

a model for distributed network computing that relies on server computers to supply software and services to client computers that request them.

cluster

a group of client workstations, usually close together, that connect off the same subnet.

command line interface

terminal-type means for sending commands to the shell and entering data into the computer. The command line is indicated by a symbol, or prompt (e.g., >, %, $), showing the user where to enter commands. Unlike a graphical user interface, this interface requires that commands be typed in and written in a precise syntax in order for them to be interpreted correctly by the shell.

C shell (csh)
a UNIX shell developed by the University of California at Berkeley

daemon

a UNIX system task that runs as a background process (usually initiated at system boot time) to perform a particular system function. Common UNIX daemons control spooled printer output, accept incoming telnet requests, activate time-of-day scheduled tasks, etc.

default

an automatic setting, mode, or action. Usually, there are alternative ways to perform any action in a computer program, but the default action is what will occur automatically if no other alternative is selected.

detached process

a process that continues to run in the background after the user has logged out. Generally, a detached process is started when a user does not expect the process to finish during a session.

dialog box

a small window-like box that opens after an operation has been selected. In it, you select options and settings to tailor the operation before it proceeds.

directory

a special kind of file that points to or contains others files and directories. Directories can be nested to any depth. Some software may refer to directories and subdirectories by other names, such as, folders, lockers, drawers, cabinets, etc.

distributed file system

a file system that joins together the file systems of individual machines. Files are stored (distributed) on different machines in a computer network but are accessible from all machines.

domain name system (DNS)
a general-purpose distributed, replicated, data query service chiefly used on Internet for translating hostnames into Internet addresses.

dotfile

see hidden file.

environment variables
global values or settings that determine the default operation of all shells and are also passed on to application programs. Environment variables contain information about your working environment. These are set by system administrators but can be changed by the individual user (printenv and setenv).

Eos
name of the development project and the distributed AFS-based computing network in the NCSU College of Engineering. The technology is based on the Athena Project technology.

executable
a statement or procedural step in a programming language that calls for processing action by the computer, e.g., performing arithmetic, reading data from an external medium, making a decision, etc. An executable file is a file with its mode is set to executable, making it a file that performs a process rather than simply holding data.

expression
a series of fundamental elements making up a command statement that a compiler can use to produce a value. Expressions have one or more operands and, usually, one or more operators.

file
a collection of information stored and retrieved under a single name.

file server
a computer used to store files and transfer requested files to client machines. Also, the AFS fs command stands for "file server."

file system
a set of many files organized in a hierarchical tree of directories and subdirectories.

filter
a command that reformats or removes unwanted data from its input and writes the rest as output.

ftp
Internet file transfer protocol for transferring files from one computer to another.

foreground process (fg)
a process that engages the terminal so that it cannot be used for anything else until the foreground process has finished running. The shell must wait for the process to finish before prompting for another command.

gateway
a device linking two networks that use different protocols. It accepts all packets from each network addressed to the other, buffers them, converts them to the next format, and re-transmits them to the other network.

graphical user interface (GUI)
picture-based software, such as Windows, that employs window frames, icons, and pointers to interface with files and directories rather than commands. This graphical "front end" or GUI is designed to be easier for the user than issuing commands to the shell via the command line.

Hesiod
a name coined by Project Athena for the "name-server" services of the network, which keeps track of resources and translates a request for a logical destination to a physical location. Named after the Greek poet, Hesiod.

hidden file
a file that does not appear in directory listing, unless the user invokes the -a option, i.e., ls -a. Names of hidden files begin with a period, e.g., .mylogin; also called a dotfile.
home directory (~)
a directory in a file system owned by a single user and used by that person to store files that s/he creates or copies there. The home directory is the directory the user enters upon login. It is represented by the tilde (~) in commands.

hostname
the unique name by which a computer is known on a network, used to identify it in electronic mail, web, or other forms of electronic information interchange.

HTML

http
Hypertext Transfer Protocol, the client-server TCP/IP protocol used on the World Wide Web for the exchange of HTML documents. It conventionally uses port 80.

hypertext
information written, organized, and presented in an electronic "document" that has words or pictures linked to other documents. Hypertext is a document with embedded links that when selected connect the user to related text, graphics, or sound file.

icon
a symbol or small picture on the display screen representing a software application or operation. Typically, a user points to or selects the icon with a pointing device, such as a mouse, to manipulate the program or operation in specific ways.

init process
a process that begins execution when the system starts up and is responsible for creating login processes that wait for input from terminals. The init process is owned by the superuser and is controlled by the console.

Internet
a worldwide complex of computer networks, communicating at high speeds using the TCP/IP protocol, which universities, companies, and governments use to exchange information, electronic mail, etc.

Kerberos
a name coined by Project Athena for the authentication and security services of the network. Kerberos provides workstations and services with encrypted "tickets" to be used when requesting a service on the network. Named after Kerberos in Greek mythology, the three-headed dog that guards the gates of Hades.

kernel
the central program and core of the operating system responsible for all machine-level work, including connecting to hardware devices. The kernel cannot be modified by the routine user.

locker
a directory, often used to mean the collection of a main directory and the subdirectories and files under it.

man(ual) pages
online reference documentation for UNIX, organized by command into individual pieces or pages of explanation. For example, the command, man ls, brings up the man page on the ls command, which is further subdivided into parts covering the command's name, syntax, description, options, restrictions, etc.

metacharacter
special characters that are not letters or numbers but have special meaning either to the shell or operating system, e.g., > and <, which perform redirection, and |, which "pipes" commands. For a metacharacter to be interpreted literally and not for its special meaning, it must be placed in quotation marks, e.g., ’<’

**mode bits**

a set of access rights associated with a file or directory in the UNIX file system, which are shown with the ls -l command. The rights are read, write and execute (r,w,x). AFS combines their effect with AFS access rights in order to determine what type of access someone has to the files.

**mount point**

a special type of directory that connects a location in the AFS file space with a volume. A mount point looks like a standard UNIX directory. Listing the directory (ls) shows the contents of the volume.

**multitasking**

able to support the processing of numerous programs and computations at the same time. Programs process concurrently and, thus, more quickly, permitting the easy sharing and movement of data, graphics, and text among windowed applications on the screen.

**operating system (OS)**

software (programs and data) that initiates the interaction of the electronic and electromechanical components of a computer so that they constitute a useful system for carrying out calculations; a set of instructions that tells a computer how to work. The operating system is the means for processing programs and sharing equipment and computer services among users.

**operators**

symbols that represent processes to be carried out.

**option**

an argument that controls how the shell executes a command, e.g., in the command ls -l, the -l is an option that tells the shell to do a special kind of directory listing, that is, a long listing of files.

**partition**

an area of a computer disk used for storage and further subdivided into volumes.

**password**

a unique, user-defined string of characters validating the user's system identity. The user must correctly enter the password in order to be authenticated by the system.

**pathname**

the location of a file or directory in the system hierarchy. Files may be referred to by absolute pathname (also called full or complete pathname) or relative pathname. An absolute pathname is the full specification of a path beginning with the root directory ( / ). A relative pathname is the location of the file or directory relative to the directory in which the user is located (the current working directory).

**PDF**


**pid**

abbreviation for Process Identification Number (see process).

**pipe ( | )**

used to represent a pipe between two processes in a shell command line.

**pipeline**
a sequence of one or more shell commands separated by a pipe symbol ( | ). The standard output of each command is sent as standard input to the next command. Each command is run as a separate process, but the shell waits for the whole series to finish before issuing a new prompt.

PostScript
a page description language that codes files for printing on PostScript printers.

process
a program running on a computer. All processes are assigned a unique reference number called a process identification number (PID). Every process on the system has a parent except the init process (see init process). The Task Manager lists processes on Windows. The ps command lists processes on UNIX

protocol
a set of rules governing the communication and transfer of data between computers.

program
a logical sequence of coded instructions specifying the operations to be performed by a computer in solving a problem or in processing data; or, a series of operations which may be used to control the function of an electronic device.

prompt
a symbol, word, or message that the system displays to tell the user that it is ready for new input or commands, e.g., %, eos%, unity%.

quota
a limit set by a system administrator on such things as disk storage (measured in kilobytes) and printing.

redirection
the process of writing output from a command to a file using the right-angle bracket (>), or of reading input for a command from a file using the left-angle bracket (<).

remote access
connection to the network from outside the established realm of client and server machines.

root directory (/)
the top-level directory in the system's directory hierarchy, represented by the "forward slash" symbol (/). 

router
a dedicated computer that links, translates, and moves data in units called "packets" over networks.

server
a resource-sharing computer that shares its files and provides particular (usually specialized) support services to other computers on a network.

shell
a program that control user interactions with the kernel of the system by interpreting and executing commands. Sometimes called a command interpreter.

shell script
a file of shell commands, also known as a shell program or shell procedure. Files having the # character as the first character are interpreted as C shell scripts.

shell variable
a named storage location that contains a value. A value is assigned to a variable by using the set command. Shell variables work like environment variables, except that a set of shell variables is used by a single C shell only, and shell variables do not propagate to new shells or other programs.

**standard input**
Standard input (stdin) is the input stream into which text or other data can be entered into a program. Certain programs will use the standard input stream as a data source if not given a file to use as input.

**standard output**
Standard output (stdout) is the output stream into which data are written from a program. Data written to standard output are usually written to the screen unless redirected, such as to a file.

**subdirectory**
a directory that resides in another directory.

**TCP/IP**
Transmission Control Protocol/Internet Protocol, the formal rules (protocol) that the Internet uses to support such services as file transfer and mail.

**terminal**
the combined keyboard and monitor through which the user communicates with the computer system.

**token**
a set of data that indicates that a user has been authenticated and is authorized to request files and services on the system.

**Unity**
the NCSU computing environment, a network for distributed computing based on technology originally developed in MIT's Athena Project.

**UNIX**
a popular and mature operating system (of which there are many versions) that runs on many kinds of computers.

**URL**
Uniform Resource Locator is a standardized address for a resource (such as a document or image) on the Internet. It can be used to point to files and directories on any machine connected to the network.

**username, userid**
a short string of characters (usually 8), entered at login, that uniquely identifies a user. Also called the “login ID,” the username is the first thing typed into the computer and, together with the password, is used to authenticate user accounts on the system.

**variable**
a symbol whose value can be set.

**vi**
a full-screen editor available to UNIX users.

**volume**
a container that keeps a set of related files and directories together on a disk partition (specific to AFS), e.g., a user's home directory or a course in Wolfware. A volume has its own quota and access control list.

**wildcard**
a metacharacter that can be used in place of other characters or words in filename arguments. The asterisk (*) and question mark (?) are wildcards.

**working directory**

the directory the user is currently working in. Typically, when users log in, they are placed in their home directories, which would be their working directory. On Solaris/Linux, the command `pwd` (path of working directory) tells what the user’s working or current directory is.

**X11**

a network protocol and subroutine library used to create graphic images and windows.
Appendix A: Command Summary
Appendix B: Application Software Catalog

The application software listed in this appendix is installed in campus Unity labs (http://oit.ncsu.edu/n/welcome-labs-environments) and engineering Eos labs (http://www.eos.ncsu.edu/labs/). Additional software is available in realm-configured labs in other departments and colleges. Check the following web sites for complete software information:

http://www.ncsu.edu/software/
http://www.eos.ncsu.edu/software/

Applications available for download to personal computers are at:

http://www.ncsu.edu/software/get-software/
http://www.eos.ncsu.edu/software/downloads/

• **Windows applications** are listed on the **Start** menu under **Programs**.
• **Solaris applications** can be found on the **Launch** menu and by typing **add** on the command line.
• **Linux applications** can be found on the **Applications** menu and by typing **add** on the command line.
• **Mac applications** are in the **Admin Launcher** (there are no Macs in Eos labs).
• Applications via remote access also run in the **Virtual Computing Lab** (VCL) at http://vcl.ncsu.edu.

ABAQUS 6.8 - Dassault Systemes Simulia Corporation

ABAQUS is a suite of engineering simulation programs, based on the finite element method, for solving problems ranging from relatively simple linear analyses to the most challenging nonlinear simulations. The ABAQUS Teaching Edition was developed to be an ideal, cost effective tool for introducing students to the benefits of robust finite element analysis. Designed for classroom instruction, Abaqus Teaching Edition programs include 20 Abaqus/CAE tokens and 100 Abaqus analysis tokens, providing 20 users simultaneous access to the software. The ABAQUS Basic Teaching Edition License has a 20,000 node limitation.

**To run on Windows (in College of Engineering Eos labs only):**
Start -> Programs -> Abaqus

**To run on Linux:**
add abaqus
abaqus cae &

Adams 2010 - MSC Software

Adams is multibody dynamics simulation software that lets you build and test virtual prototypes, realistically simulating on your computer, both visually and mathematically, the full-motion behavior of your complex mechanical system designs. MSC Adams provides a robust solution engine to solve your mechanical system model. The software checks your model and automatically formulates and solves the equations of motion for kinematic, static, quasi-static, or dynamic simulations. With Adams, you don’t have to wait until the computations
are complete to begin seeing the results of your simulation. You can view animations and plots – and continue to refine your design – even as your simulation is running, saving valuable time. For design optimization, you can define your variables, constraints, and design objectives, then have Adams iterate automatically to the design, providing optimal system performance.

To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> MSC.Software -> Adams

To run on Solaris and Linux:
add adams
adams2010 &
MSC Adams 2008 R1 is no longer available.

Acrobat 9 Professional - Adobe Systems Incorporated

Adobe Acrobat lets you convert any document, including Microsoft Office documents, to Adobe Portable Document Format (PDF). Anyone can open your document across a broad range of hardware and software, and it will look exactly as you intended with layout, fonts, links, and images intact. With Acrobat 9 Professional you can organize content from a variety of sources, including documents, e-mail, images, spreadsheets, and web pages, in a single searchable PDF Portfolio, compressed for easy distribution. You can enable users of free Adobe Reader to digitally sign documents, participate in shared document reviews, and save forms locally.

The Acrobat Reader is a tool for viewing, navigating, and printing PDF documents and can be downloaded for free. It launches automatically in your browser, but on Solaris machines can also be launched as a separate application.

To run on Windows:
Start -> Programs -> Adobe Acrobat 9 Pro

To run on Solaris and Linux:
add acroread
acroread file.pdf

To run on Mac:
See http://oit.ncsu.edu/macintosh/unity-macintosh-lab-kit-fall-2010

Adobe CS5 (Creative Suite 5) - Adobe Systems Incorporated

Adobe Creative Suite is a collection of applications that enable you to design content for print, the web, film and video, and mobile devices. Applications include InDesign, Photoshop Extended, Illustrator, Flash Professional, Dreamweaver, and Acrobat Professional. More CS5 products, such as Contribute, Fireworks, and Soundbooth, can also be found in Unity and/or Eos labs.
To run on Windows:
Refer to the "How to Run" for each specific application.

To run on Mac:
See http://oit.ncsu.edu/macintosh/unity-macintosh-lab-kit-fall-2010

ANSYS 12.1 - Ansys Inc.

ANSYS is a general purpose finite element modeling and analysis tool. The ANSYS Workbench environment binds core applications together via the project page that introduces the project schematic, that presents a comprehensive view of the entire analysis project in flowchart form in which explicit data relationships are readily apparent. The ANSYS Workbench environment has been redesigned for an efficient multiphysics workflow by integrating the solver technology into one unified simulation environment. ANSYS 12 extends the distributed sparse solver to support unsymmetric and complex matrices for both shared and distributed memory parallel environments.

For a complete list of new features, visit the ANSYS 12 New Features page at http://www.ansys.com/products/ansys12-new-features.asp.

To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> ANSYS

To run on Linux:
add ansys
  launcher121 &

ArcGIS Desktop 9.3 - Environmental Systems Research Institute (ESRI)

ArcGIS Desktop is a collection of software products that runs on standard desktop computers. It is used to create, import, edit, query, map, analyze, and publish geographic information. There are four products in the ArcGIS Desktop collection; each adds a higher level of functionality.

• ArcReader is a free viewer for maps authored using the other ArcGIS Desktop products. It can view and print all maps and data types. It also has some simple tools to explore and query maps.
• ArcView provides extensive mapping, data use, and analysis along with simple editing and geoprocessing capabilities.
• ArcEditor includes advanced editing for shapefiles and geodatabases in addition to the full functionality of ArcView.
• ArcInfo is the full function, flagship GIS desktop. It extends the functionality of both ArcView and ArcEditor with advanced geoprocessing. It also includes the legacy applications for ArcInfo Workstation.

To run on Windows:
Start -> Programs -> ArcGIS
ArcInfo Workstation 9.3 - Environmental Systems Research Institute (ESRI)

ArcInfo is the most complete and extensible GIS available. It includes all the functionality of ArcView and ArcEditor and adds advanced geoprocessing and data conversion capabilities. Professional GIS users use ArcInfo for all aspects of data building, modeling, analysis, and map display for screen and output. Included with ArcInfo are the following tools:

• Arcdoc
• Arcedit
• Arcplot
• Arctools
• Formedit
• Grid

To run on Windows:
Start -> Programs -> ArcInfo Workstation

To run on Solaris:
add arcinfo9
arc
To bring up documentation:
arcdoc
Arcinfo 8.1 is available as:
add arcinfo

Arena 12 - Rockwell Automation, Inc.

The Arena graphics simulation system is a complete and flexible modeling environment combined with an easy-to-use graphical user interface. It is designed for building computer models that accurately represent an existing or proposed application. Arena integrates all simulation-related functions--animation, input data analysis, model verification, and output analysis--into a single simulation modeling environment.

To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> Rockwell Software -> Arena

To run in VCL (College of Engineering only):
http://vcl.ncsu.edu
aspenONE 7.1 - Aspen Technology, Inc.

Aspen products are available under AspenTech's University Program, which offers universities an integrated suite of products that allow professors to teach students how to optimize engineering. Aspen Plus is a process modeling tool for conceptual design, optimization, and performance monitoring for the chemical, polymer, specialty chemical, metals and minerals, and coal power industries. Aspen Properties provides state-of-the-art physical property methods, models, algorithms, and data that enables chemists and engineers to easily perform engineering calculations based on rigorous and proven thermophysical property models and data.

To run in VCL (College of Engineering only):
http://vcl.ncsu.edu

AutoCAD 2009 - Autodesk, Inc.

AutoCAD is an industry standard design and drafting package for the creation and manipulation of 2-D and 3-D line drawings and images. New features of AutoCAD 2009 include:

• a task-based user interface that has been optimized to reduce the number of steps it takes to reach commands.
• an action recorder that provides a simple to use macro recorder.
• an interactive layer manager that instantly makes changes appear in the drawing.

To run on Windows:
Start -> Programs -> Autodesk -> AutoCAD

To run in VCL:
http://vcl.ncsu.edu

AutoCAD Civil 3D 2009 - Autodesk, Inc.

AutoCAD Civil 3D is a design and drafting application that supports a wide range of civil engineering tasks, including site development and road design. New functions in AutoCAD Civil 3D 2009 include:

• a stormwater hydraulics and hydrology solution for storm sewer design
• watershed analysis
• detention pond modeling and culvert analysis
• survey functionality that allows users to directly import raw data
• criteria-based road design that follows local design requirements such as stopping and passing sight and headlight distances

To run on Windows:
Start -> Programs -> Autodesk -> AutoCAD Civil 3D
To run in VCL:

http://vcl.ncsu.edu

AVR Studio 4 - Atmel Corporation

AVR Studio® 4 is a professional Integrated Development Environment (IDE) for writing and debugging AVR® applications in Windows® environments. AVR Studio 4 includes an assembler and a simulator.

To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> Atmel AVR Tools -> AVR Studio

COMSOL Multiphysics 3.5 - Comsol, Inc.

COMSOL Multiphysics is a modeling package for the simulation of any physical process you can describe with partial differential equations (PDEs). The Chemical Engineering Module deals with the couplings of fluid flow, diffusion and reaction processes as well as heat transport couplings found in systems of interest to chemical engineers. The Electromagnetics Module gives users a comprehensive design and modeling tool for simulating systems and devices in the areas of electromagnetic fields and waves. It allows anyone to quickly and easily define and solve models in RF and microwave engineering, AC and DC electromagnetics, and even optics and photonics.

Usage Restrictions:
The Class Kit license of COMSOL Multiphysics permits its use by students for coursework only. It may not be used by graduate students for research, including degree-related research.

To run in VCL:
Comsol Multiphysics is available via VCL only to specific College of Engineering non-research classes upon faculty request.

http://vcl.ncsu.edu

Eclipse 3.4.1 - Eclipse Foundation

Eclipse is an open source community whose projects are focused on building an open development platform comprised of extensible frameworks, tools and runtimes for building, deploying and managing software across the lifecycle. A large and vibrant ecosystem of major technology vendors, innovative start-ups, universities, research institutions and individuals extend, complement and support the Eclipse platform.

To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> Eclipse

To run on Solaris and Linux:
add jdk160
Fortran - NAGware f95 Compiler 5.1 - Numerical Algorithms Group

The NAGWare f95 Compiler is a fortran compiler that is available on a wide range of platforms. Release 5.1 continues to support the full Fortran 95 language, while retaining backwards compatibility to previous releases. It includes improvements in performance and error checking, additional object-oriented features, C interoperability, and access to the command line and environment variables.

To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> Numerical Algorithms Group -> Fortran Builder

To run on Solaris and Linux (in College of Engineering Eos labs only):
add nagf95
f95 source_file {options.....}
NAGWare f95 5.0 is still available on Solaris and Linux. To run:
add nagf95_50
f95 source_file {options....}

ILOG CPLEX 12.1 - IBM

ILOG CPLEX is a mathematical programming optimization application. IBM ILOG CPLEX 12.1 incorporates the latest enhancements in both solution speed and flexibility - faster mixed integer programming, parallel performance enabled by default, and new connectors for popular software.

To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> IBM ILOG -> IBM ILOG CPLEX 12.1

To run on Solaris and Linux:
add ilog
cplex

ILOG OPL CPLEX Development Studio 6.3 - IBM

ILOG OPL Development Studio is a system for rapid development and deployment of optimization applications. It contains the ILOG Optimization Programming Language (OPL) for developing optimization models. ILOG OPL has advanced data types designed for the special needs of optimization problems, and it fully supports linear and quadratic objectives and constraints, as well as real and integer decision variables. Also available for Windows 32-bit machines is an Integrated Development Environment (IDE) to execute and test optimization models. The
IDE contains debugging and tuning tools and makes it easy to evaluate different modeling approaches to a problem.

**To run on Windows (in College of Engineering Eos labs only):**
Start -> Programs -> IBM ILOG -> IBM ILOG OPL 6.3

**To run on Solaris and Linux:**
add ilog
oplr

**Java Development Kit 6 (1.6) - Sun Microsystems, Inc.**

Java(tm) 2 Platform, Standard Edition (J2SE) provides a complete, secure foundation for building and deploying network-centric enterprise applications ranging from the PC desktop computer up to the workgroup server. It provides software developers with a platform for rapid application development and cross-platform compatibility. Java SE 6 streamlines web service and XML development, simplifies GUI development and augments native desktop support, expands programmatic access to native security facilities, and is the first release to offer a standardized framework for scripting languages.

**To run on Windows (in College of Engineering Eos labs only):**
Start -> Programs -> JDK 6

**To run on Solaris and Linux:**
add jdk160
cd /ncsu/jdk160/bin

The Netbeans IDE will automatically be in your path when you add the locker.

Java Development Kit 1.5 is also available as:
add jdk150
cd /ncsu/jdk150/bin

**JMP 8.0 - SAS Institute, Inc.**

JMP (pronounced "jump") is a highly interactive environment for statistical visualization and exploratory data analysis. JMP presents statistics in an easily understood, graphical environment. Data tables are presented clearly in spreadsheet form and are dynamically linked to related graphs and tables. JMP offers capabilities for performing univariate statistics, analysis of variance and multiple regression, nonlinear fitting, multivariate analysis, and nonparametric tests. It also features integrated capabilities for quality improvement and design of experiments, offering five types of classical designs for estimating the effect of one or more factors on a dependent variable. JMP also provides a variety of graphical tools designed for quality control, including Shewhart control charts and Pareto charts. With JMP 8.0, you can create graphs interactively with Graph Builder, process up to 2 billion columns and an unlimited number of rows, and interact dynamically with SAS.
To run on Windows:
Start -> Programs -> JMP

To run on Mac:
See http://oit.ncsu.edu/macintosh/unity-macintosh-lab-kit-fall-2010

To run in VCL:
http://vcl.ncsu.edu

LabVIEW 2009 - National Instruments Corporation

LabVIEW is a system of scalable test, measurement, and control applications. Engineers and scientists can interface with measurement and control hardware, analyze data, share results, and distribute systems. With LabVIEW you can:
• rapidly create test, measurement, control, and automation applications using intuitive graphical development.
• quickly create user interfaces to interactively control your system.
• easily specify system functionality by assembling block diagrams.

To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> National Instruments -> LabVIEW

LINDO v6.1 - Lindo Systems

HyperLINDO is an interactive package designed to solve linear, quadratic and integer programming problems, evaluate the appropriateness of the results, make minor modifications to the data or parameters, and retest to obtain optimum output. As a general-purpose LP, QP, and IP optimizer, it recognizes general integer variables (not just 0/1), free variables, and bounded variables.

To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> Lindo

To run in VCL (College of Engineering only):
http://vcl.ncsu.edu

LINGO v6.0 - Lindo Systems

LINGO is a language for developing large structured models. It is a general-purpose modeling language and optimizer with a built-in text editor. LINGO recognizes subscripted variables, sets, operations over sets, and general mathematical expressions. Commonly used trigonometric, mathematical, and statistical functions are also built in.
To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> Lingo6 -> LINGO 6

To run in VCL (College of Engineering only):
http://vcl.ncsu.edu

Maple 13 - Maplesoft
Maple is a comprehensive computer system for advanced mathematics. It includes facilities for interactive algebra, calculus, discrete mathematics, graphics, numerical computation and many other areas of mathematics. As part of the new 3-D plotting facilities, Maple 13 provides fly-through animations. These animations help you to gain additional insight from your 3-D plots as a virtual camera flies through, over, under, into, and around your surface, letting you focus on points of interest from any angle to understand the trends and behavior of surfaces.

To run on Windows:
Start -> Programs -> Maple 13 -> Maple 13

To run on Mac:
See http://oit.ncsu.edu/macintosh/unity-macintosh-lab-kit-fall-2010

To run on Solaris and Linux:
add maple130
xmaple &
To run Maple 12:
add maple120
xmaple &

To run in VCL:
http://vcl.ncsu.edu

Mathcad 14 - Parametric Technology Corporation (PTC)
Mathcad is engineering calculation software with a visual format and scratchpad interface that integrates standard mathematical notation, text and graphs in a single worksheet. New features of Mathcad 14 include new and improved ordinary differential equation solvers, statespace for ODE matrix operations, polar plot improvements useful for electrical design engineers analyzing electromagnetic radiation, and a Symbolics update with capabilities such as symbolic vectorization, solve fully, new and enhanced keywords, continued fraction expansion, extended, piecewise, and repeating solutions.

To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> Mathcad 14
To run in VCL (College of Engineering only):

http://vcl.ncsu.edu

Mathematica 7.0 - Wolfram Research, Inc.

Mathematica seamlessly integrates a numeric and symbolic computational engine, graphics system, programming language, documentation system, and advanced connectivity to other applications. Uses include:

• Handling complex symbolic calculations that often involve hundreds of thousands or millions of terms
• Loading, analyzing, and visualizing data
• Solving equations, differential equations, and minimization problems numerically or symbolically
• Doing numerical modeling and simulations, ranging from simple control systems to galaxy collisions, financial derivatives, complex biological systems, chemical reactions, environmental impact studies, and magnetic fields in particle accelerators
• Producing professional-quality, interactive technical reports or papers for electronic or print distribution
• Illustrating mathematical or scientific concepts for students from K-12 to postgraduate levels
• Typesetting technical information--for example, for U.S. patents

Mathematica 7 includes over 500 new functions and 12 additional application areas, including new graphics primitives, comprehensive spline support, and a new level of automation and computational aesthetics to vector visualization.

To run on Windows:

Start -> Programs -> Wolfram Mathematica -> Wolfram Mathematica

To run on Mac:

See http://oit.ncsu.edu/macintosh/unity-macintosh-lab-kit-fall-2010

To run on Solaris and Linux:

add mathematica

mathematica &

MathType 6.0 - Design Science, Inc.

MathType is the professional version of the equation editor in MS Office. It will let you create a wider range of equations for a wider range of documents. MathType includes MathPage technology that enables you to transform an entire Word document into a web page with equations that print and display in any modern Windows, Macintosh, Unix or Linux browser.

To run on Windows:

Start -> Programs -> MathType 6 -> MathType

To run on Mac:

See http://oit.ncsu.edu/macintosh/unity-macintosh-lab-kit-fall-2010
MATLAB 7.9 (R2010) - The MathWorks, Inc.

MATLAB is a high-performance language for technical computing. It integrates computation, visualization, and programming in an environment where problems and solutions are expressed in familiar mathematical notation. Typical uses include math and computation, algorithm development, modeling, simulation, prototyping, data analysis, visualization, scientific and engineering graphics, and application development, including Graphical User Interface building. MATLAB features a family of application-specific solutions called toolboxes. Toolboxes are comprehensive collections of MATLAB functions (M-files) that extend the MATLAB environment to solve particular classes of problems. Areas in which toolboxes are available include signal processing, control systems, neural networks, fuzzy logic, wavelets, simulation, and many others.

Note for College of Engineering students:
Visit the MATLAB page in our Software Catalog to find out how to receive MATLAB for your personally owned machine. You may also purchase MATLAB for use at home from the NCSU bookstore or http://www.mathworks.com/academia/student_version/

To run on Windows:
Start -> Programs -> Matlab -> R2010a

To run on Mac:
See http://oit.ncsu.edu/macintosh/unity-macintosh-lab-kit-fall-2010

To run on Solaris and Linux:
add matlab79
matlab &

To run in VCL:
http://vcl.ncsu.edu

Microsoft Access 2007 - Microsoft

Microsoft Access (part of MS Office Professional 2007) is a powerful application for data management, analysis, and report generation. New features of Access 2007 include a library of prebuilt database solutions, WYSIWYG interactive form design capabilities, and a recycle bin for deleted data that helps you recover erroneously deleted data. New features of Access 2007 include:

• Automatic data type detection in tables that improves schema and table creation.
• Interactive form design capabilities that provide a what you see is what you get (WYSIWYG) experience.
• Improved data transfer capabilities that enable you to paste a Microsoft Excel spreadsheet table into a new Access table for easy data transfer.

To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> Microsoft Office -> Microsoft Office Access
Microsoft Excel 2007 - Microsoft

Excel 2007 (part of MS Office Professional 2007) is a spreadsheet application used to create and format spreadsheets and analyze and manage information. The Office Fluent user interface presents the right tools when you need them most. New Features of Excel 2007 include:

• Increased spreadsheet row and column capacity of one million rows by 16,000 columns.
• Chart formatting tools that help you create and format professional-looking charts with greater ease using fewer clicks.
• Conditional formatting with rich data visualization schemes to help you set conditions more easily to discover trends or patterns in your information.

To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> Microsoft Office -> Microsoft Office Excel

To run on Mac:
See http://oit.ncsu.edu/macintosh/unity-macintosh-lab-kit-fall-2010

To run in VCL:
http://vcl.ncsu.edu

Microsoft PowerPoint 2007 - Microsoft

PowerPoint 2007 (part of MS Office Professional 2007) is a presentation graphics program that makes it easy to create impressive and dynamic presentations quickly. New features of PowerPoint 2007 include:

• SmartArt diagram tools that help you create professional diagrams and flow models.
• PowerPoint Slide Libraries that help you publish and share slides and layouts while easily accessing content from other presentations.
• Managed document repositories that can be accessed from within Office PowerPoint 2007, so you have greater control over presentation versions.

To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> Microsoft Office -> Microsoft Office PowerPoint

To run on Mac:
See http://oit.ncsu.edu/macintosh/unity-macintosh-lab-kit-fall-2010

To run in VCL:
http://vcl.ncsu.edu
Microsoft Project 2007 - Microsoft

Project is an application for planning and managing projects. You can set up projects quickly, assign resources to your tasks or make resource adjustments to resolve conflicts and over-allocations, track schedules, and generate reports. Existing task lists created in Excel or Outlook can be converted into project plans with Project.

To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> Microsoft Office -> Microsoft Office Project

Microsoft Visio 2007 - Microsoft

Visio is used to create professional looking diagrams. Its technical drawing tools handle the diagramming needs of engineers simple to complex, rough to precise, general to specialized. Visio helps you define and visualize ideas, information, and systems. Visio 2007 enables easy assembly of diagrams through dragging predefined Microsoft SmartShapes symbols coupled with powerful search capabilities to locate the right shape, whether it is on a computer or the Web.

To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> Microsoft Office -> Microsoft Office Visio

To run in VCL:
http://vcl.ncsu.edu

Microsoft Visual Studio .NET 2008 Professional - Microsoft

Visual Studio .NET is a development tool for creating the next generation of applications. It is a development environment built from the ground up for XML Web services. By allowing applications to share data over the Internet, XML Web services enable developers to assemble applications from new and existing code, regardless of platform, programming language, or object model.

To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> Microsoft Office -> Microsoft Visual Studio

Microsoft Word 2007 - Microsoft

Microsoft Word 2007 (part of MS Office Professional 2007) is an application used to create documents by combining a comprehensive set of writing tools with an easy-to-use interface. With a host of new tools, you can quickly construct documents from predefined parts and styles, as well as compose and publish blogs directly from within Word. New features of MS Word 2007 include:
• The ability to add Building Blocks of predefined content that can reduce the errors associated with copying and pasting frequently used content.
• The tri-pane review panel that makes it easy to compare and combine two versions of a Word document.
• Improved typographic capabilities that offer improved bulleted and numbered lists, numbered list styles, and new fonts designed to improve on-screen reading.

To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> Microsoft Office -> Microsoft Office Word

To run on Mac:
See http://oit.ncsu.edu/macintosh/university-macintosh-lab-kit-fall-2010

**Microstation V8i - Bentley Systems, Inc.**

MicroStation V8i is used by engineers, architects, GIS professionals, constructors, and owner operators to design, model, visualize, document, map, and sustain infrastructure projects. MicroStation V8i and dynamic views help project teams simplify 2d drawing composition and 3d modeling and visualization experiences. With dynamic views users can slice and filter models to see only what’s needed in view and maintain a fully coordinated set of 3d models and 2d deliverables across projects. New features of Microstation V8i include the following:

• A customizable interface to group tools and tasks
• A comprehensive set of drafting and detailing tools
• Luxology powered animation for speed and realism
• Batch printing of multiple drawings

To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> Bentley -> Microstation

**Moldflow 2010 - Autodesk, Inc.**

Autodesk® Moldflow® Adviser software provides easy-to-use tools that help you to simulate and optimize your part, mold, and tool design. Autodesk Moldflow Adviser simplifies plastics injection molding simulation and helps to optimize mold features such as gates, runners, and cavity layouts. It guides designers through analysis setup and results interpretation, enabling them to see how changes to wall thickness, gate locations, material, and geometry affect manufacturability.

To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> Autodesk -> Autodesk Moldflow

**NExS Engineering Spreadsheet v1.6 - GreyTrout Software, Inc.**

NExS is an advanced spreadsheet designed specifically for the X Windows environment. It has an intuitive user interface and requires only a few keystrokes or mouse clicks to analyze data and present the results with graphs
ranging from simple line plots to 3D surfaces. The NExS spreadsheet provides a flexible visual environment in which to handle complex calculations and data manipulations. It calculates a full range of mathematical, statistical, matrix and string functions, all with the ease of a familiar spreadsheet format with point-and-click screen displays and pull-down menus. NExS is a step up to live action, capable of sending and receiving data and commands from other X Windows programs, even on other computers, and automatically recalculating sheets and graphs to reflect the changes. This capability allows NExS to monitor and display data from multiple sources as it is calculated and to pass this information to other programs in a real-time environment. Using the NExS application program interface (API), a client/server application can be fully integrated with the spreadsheet, appearing to the user as a single unified application. This Connections API lets a program remotely control all aspects of the spreadsheet, including drawing graphs, printing, and calculating.

To run on Solaris and Linux:

add nexas
nexas

OfficeScan 10 - TrendMicro, Inc.

NCSU has adopted Trend Micro's OfficeScan as the official Windows antivirus client for the university. OfficeScan™ 10.0 delivers comprehensive client/server security with new, dedicated Web threat protection—an industry first. Innovative Web Reputation protects your clients-on and off the network—blocking access to malicious sites. OfficeScan also features improved virus and spyware protection, new variant detection, anti-rootkit security, malware and remnant removal, plus firewall security. New plug-in architecture, virtualization, and extended platform support ensure better security, seamless compatibility, and ease-of-management.

To run on Windows:

Faculty, staff and students with a Unity ID can visit http://oit.ncsu.edu/antivirus to download. Refer to VirusBarrier X5 - Intego on page 148 for NCSU’s adopted anti-virus protection software for the Macintosh platform.

OpenOffice.org 3.2.0 - OpenOffice.org

OpenOffice.org is an open source office suite. OpenOffice.org applications include Writer, for word processing and desktop publishing, Impress, for creating presentations, Math, for equation editing, Draw, a graphics application for drawing and manipulating objects, Calc, a spreadsheet application, and Base, for database creation, forms, queries, and reports.

To run on Solaris and Linux:

add openoffice

openoffice (or commands for individual applications)

OpenOffice 3.0.1 is still available as:

add openoffice301
OPNET 15 - OPNET Technologies, Inc.

OPNET software embeds expert knowledge about how network devices, network protocols, applications, and servers operate. This intelligence enables users in network operations, engineering, planning, and application development to optimize performance and availability of their networks and applications. Modeler is used for design and analysis of networks, network equipment, and communications protocols. Wireless Module extends the functionality of OPNET Modeler with high-fidelity modeling, simulation, and analysis of wireless networks. The MPLS specialized model offers performance predictions of networks that incorporate MPLS technology and traffic engineering policies. The UMTS specialized model is used for design and operation of cost-efficient UMTS networks.

To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> Opnet Modeler 15.0 -> Opnet Modeler 15.0

To run on Solaris and Linux:
add opnet
modeler &

To run in VCL (College of Engineering only):
http://vcl.ncsu.edu

Primavera P6 - Oracle

P6 is an integrated project portfolio management (PPM) solution comprising role-specific functionality to satisfy each team member's needs, responsibilities and skills. Features include automatic portfolio creation and maintenance, configurable criteria modeling with more than 200 standard project metrics for analysis, portfolio capacity planning, and performance monitoring and reporting.

To run in VCL (College of Engineering only):
http://vcl.ncsu.edu

Pro/ENGINEER Wildfire 5.0 - Parametric Technology Corporation (PTC)

Pro/ENGINEER Wildfire is a tool for delivering high-quality, accurate digital models. The software can help you optimize global design processes.

Enhancements in 5.0 include the following:
• Real-time, dynamic feature editing that lets you see and make changes instantly.
• Intuitive dashboard, icon and ribbon user interface enhancements that help users navigate commands and tasks more efficiently.
• Improved photo-realistic rendering speed and quality. The Pro/ENGINEER Advanced Rendering Extension now includes the high performance, mental images rendering engine which provides unsurpassed realism in less time.
• Enhanced direct surface editing that enables you to make changes up to 70% faster.


To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> PTC -> ProEngineer

To run on Solaris and Linux:
Pro/ENGINEER 5.0 is not available on Solaris and Linux.
Pro/ENGINEER 4.0 is available on Solaris as:
add proewildfire40
proe &

To run in VCL (College of Engineering only):
http://vcl.ncsu.edu

RS Logix 500 - Rockwell Automation, Inc.
The Rockwell Software's RSLogix offers 32-bit flexibility, reliability, and increased productivity to the industrial controls programming world. Operating in the Microsoft Windows environment, RSLogix for a variety of processor families incorporates the latest technologies to maximize performance and save development time. This software is designed to test and debug your ladder logic programs prior to use.

To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> Rockwell Software -> RS Logix

To run in VCL (College of Engineering only):
http://vcl.ncsu.edu

SAS 9.2 - SAS Institute Inc.

SAS is an integrated applications system for data access, management, analysis and presentation. Programs within the SAS system may be used in operations research (models of distribution networks, resource allocation problems, scheduling, production systems), report writing and graphics, business forecasting and decision support, project management, and applications development, among other things.

New features of SAS 9.2 include the following:
• User interface improvements such as: a full undo to reverse an action and redo to reverse the undo action; integrated toolbar that includes Run, Stop, Run To/From Selected Transformation, Step and Continue; and new performance monitoring capabilities that let you see real-time status, statistics, warnings and errors, and new graphical performance charts.
• New analytic capabilities: more than 200 changes and enhancements to SAS/STAT, including production versions of GLIMMIX (generalized linear mixed models), GLMSELECT (large-scale variable selection) and QUANTREG (quantile regression) procedures.
• Enhancements to SAS/OR software, including new solvers for linear, integer and nonlinear optimization.

To run on Windows:
Start -> Programs -> SAS -> SAS

To run in VCL:
http://vcl.ncsu.edu

SlickEdit 2010 - SlickEdit, Inc.
SlickEdit is a multi-platform, multi-language source code and text editor that enables power programmers to create, navigate, modify, and debug code faster and more accurately. New features of SlickEdit 2010 include the following:
• The ability to order the files tabs by most recently opened, most recently viewed, and by dragging and dropping to manually order the tabs.
• Subversion history - When using the Subversion source control tool, SlickEdit builds a version cache that allows it to quickly build and display a version history for the file, including branches.
• Backup History Enhancements: Backup History now allows you to store a comment with any entry in the history list. This is helpful when you have a long list of revisions and you need to find a specific one.
A complete list of new features of SlickEdit 2010 may be found on the SlickEdit - New Features page at http://www.slickedit.com/products/slickedit/new-features

To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> SlickEdit -> SlickEdit

To run on Solaris and Linux:
add slickedit
vs &
SlickEdit 11.0 is also available as:
add slickedit11
vs &

SolidWorks Education Edition 2010-2011 - SolidWorks Corporation
SolidWorks, a standard in 3D modeling, is mechanical design automation software that takes advantage of the MS Windows graphical user interface. Mechanical designers can easily sketch out ideas, experiment with features and dimensions, and produce models and detailed drawings. The product names have changed with the 2009 version of SolidWorks. Of particular note are the new names for the COSMOS products. Following are the former names along with their new names, which are included with the SolidWorks EDU license:
• SolidWorks Office Premium became SolidWorks Premium
• COSMOSWorks Advanced Professional and COSMOSM became SolidWorks Simulation Premium
• COSMOSMotion became SolidWorks Motion
• COSMOSFloWorks became SolidWorks Flow Simulation

Note for College of Engineering and Graphic Communications (GC) students: SolidWorks can be installed on College of Engineering and GC students’ personally-owned computers. Visit the SolidWorks page in our software catalog for information about how to receive SolidWorks for your personally-owned computer.

To run on Windows:
Start -> Programs -> SolidWorks 2010 -> SolidWorks

To run in VCL:
http://vcl.ncsu.edu

SPSS and AMOS - SPSS, Inc.

With SPSS, you can generate decision-making information quickly using powerful statistics, understand and effectively present your results with high-quality tabular and graphical output, share your results with others using a variety of reporting methods, and take advantage of the analytical asset storage and deployment capabilities of other SPSS products.

Amos provides you with powerful and easy-to-use structural equation modeling (SEM) software. Create more realistic models than if you used standard multivariate statistics or multiple regression models alone. Using Amos, you specify, estimate, assess, and present your model in an intuitive path diagram to show hypothesized relationships among variables. This enables you to test and confirm the validity of claims such as “value drives loyalty” in minutes, not hours.

To run on Windows:
Start -> Programs -> SPSS -> Statistics
Start -> Programs -> SPSS -> Amos

SuperPro Designer 7 - Intelligen, Inc.

SuperPro Designer is a tool for engineers and scientists in process development, process engineering, and manufacturing that facilitates modeling, evaluation and optimization of integrated processes. It includes an extensive chemical component and mixture database and extensive equipment and resource databases.

New Features in version 7 include new and updated examples, new and updated flush, leaching, and composition control operations that have been added in the appropriate contexts, and a more consistent and uniform modeling approach to identifying the state of a component in a stream or in a state (equipment contents) inside a procedure.

To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> SuperPro Designer -> SuperPro Designer
SurfCAM Velocity 4 - Surfware, Inc.

SURFCAM Velocity is computer-aided design / manufacturing (CAD/CAM) software used for CNC programming of 2- through 5-axis mills, lathes, Wire-EDM, and multi-tasking machines. It uses Surfware's TrueMill technology, the world's only toolpath that intelligently manages tool load to boost productivity. A powerful suite of function specific toolpaths automate most common operations, such as facing, milling O-ring grooves, chamfering and rounding corners, and hole-making. This major new release offers numerous additions and enhancements to 3-axis finishing, 4-axis machining and 5-axis machining. Among the features implemented are: brand-new 3-Axis High-Speed Machining strategies, top-quality HSM operations including Rest Machining, Offset Pencil Cut and 3D Offset. With Velocity 4’s new 4- and 5-Axis functionality, you gain total control of the tool motion during any event of the cutting process, thus ensuring best cutting conditions and safe tool motions.

To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> Surfcam Velocity 4.0 -> Surfcam Velocity 4.0

Tecplot 360 2010 - Tecplot, Inc.

Tecplot 360 is a numerical simulation and CFD visualization software that combines vital engineering plotting with advanced data visualization into one tool. It allows you to quickly plot and animate all your data exactly the way you want, as well as analyze complex data, arrange multiple layouts, and communicate your results with professional images and animations. Tecplot 360 also helps save time and effort by automating routine tasks.

To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> Tecplot 360 -> Tecplot 360

To run on Solaris and Linux:
add tecplot
tec360
Tecplot 360 2006 is still available. To run:
add tecplot3602006
tecplot

To run in VCL (College of Engineering only):
http://vcl.ncsu.edu
Timberline Office Estimating 7.1.3 - Sage

Timberline Estimating Software is a comprehensive package of tools for automating the estimating process. The Timberline Commercial Knowledgebase is included and contains pre-built models and comprehensive Smart Assemblies backed by RSMeans cost data. The application includes bill of material classes, Smart Assemblies, and thousands of items in industry-specific databases, such as Pre-Construction, Commercial GC, Commercial HVAC, and Residential Home Builder.

To run in VCL (College of Engineering only):
http://vcl.ncsu.edu

TK Solver 4.0 - Universal Technical Systems, Inc.

TK is a rule-based declarative environment for creating mathematical models and solving them multidirectionally. It is a mathematical modeling tool for calculating, designing, testing and troubleshooting; a rule-based declarative programming environment; and a Web applications development tool which integrates well with databases, CAD/3-D solid modeling, Visual Basic “front ends,” HTML or other hypertext environments, multimedia, and other tools to form Web-ready interactive knowledge bases for design, engineering, management and marketing.

To run on Windows (in College of Engineering Eos labs only):
Start -> Programs -> TK Solver 4.0 -> TK Solver 4.0

VirusBarrier X5 - Intego

NCSU has adopted Intego VirusBarrier X5 as the official Macintosh antivirus software for the university. Intego VirusBarrier X5 is the simple, fast and non-intrusive antivirus solution for Macintosh computers. It offers thorough protection against viruses and malware of all types, coming from infected files or applications, whether on CD-ROMs, DVDs or other removable media, or in files downloaded over the Internet or other types of networks. VirusBarrier X5 protects your Mac from viruses by constantly examining all the files that your computer reads and writes, as well as watching for suspicious activity that may be the sign of viruses acting on applications or other files.

To run on Mac:
Faculty, staff and students with a Unity ID can visit http://oit.ncsu.edu/antivirus to download.
Refer to OfficeScan 10 - TrendMicro, Inc. on page 142 for NCSU’s adopted anti-virus protection software for the Windows platform.

Visual MODFLOW 4.3 - Schlumberger Water Services

Visual MODFLOW is the proven standard for professional 3D groundwater flow and contaminant transport modeling using MODFLOW-2000, MODPATH, MT3DMS and RT3D. Visual MODFLOW Pro seamlessly
combines the standard Visual MODFLOW package with WinPEST and the Visual MODFLOW 3D-Explorer to give you the most complete and powerful graphical modeling environment available.

**To run on Windows (in College of Engineering Eos labs only):**
Start -> Programs - SWS Software - Visual MODFLOW

**WaterCAD V8i - Bentley Systems, Inc.**

WaterCAD is a water quality modeling solution for water distribution systems. It features advanced interoperability, model building, optimization, and asset management tools. Engineers can use its built-in water-quality features to perform constituent, water-age, tank-mixing and source-trace analysis to develop comprehensive chlorination schedules, simulate mock contamination events, model flow-paced and mass-booster stations, and visualize zones of influence for every water source.

New features of WaterCAD V8i include the following:

• Easier model maintenance with GIS-ID property: The new GIS-ID property can be used for maintaining associations between records in your source file and elements in your model.

• ModelBuilder improvements such as the ability to import a subset of data using where queries. This allows users to filter the data to import only the information they need, without having to change the data from its original format.

• Ability to create Google Earth (KML) files for results display

**To run on Windows (in College of Engineering Eos labs only):**
Start -> Programs - WaterCAD

**Winedt 5.3 - WinEdt**

This package makes preparation/typesetting of scientific documents using Late as easy, and in many ways easier, than with MSWord. The majority of important equation (including the full AMS symbol suite) and bibliography environments can be entered into a Latex document with a mouse click. Users of MSWord will never want to go back to it once the power of the Winedt GUI and latex/tex is understood. However, neither winedt nor the miktex implementations are perfect.

**To run on Windows (in College of Engineering Eos labs only):**
Start -> Programs - Winedt

**WinSCP 4.0.3**

WinSCP is an open source SFTP client and FTP client for Windows. Its main function is the secure file transfer between a local and a remote computer. Beyond this, WinSCP offers basic file manager functionality. It uses Secure Shell (SSH) and supports, in addition to Secure FTP, also legacy SCP protocol.
To run on Windows:
Start -> Programs -> WinSCP -> WinSCP

X-Win32 9.5 - StarNet Communications

X-Win32 is StarNet's X terminal application for Windows desktop platforms. It allows Windows users to connect to campus remote-access servers and display full windowed Linux/Solaris applications back to their Windows machines. The applications are running remotely, but you interact with them on your Windows desktop just like you were sitting in front of a Solaris or Linux workstation in an Eos computer lab. X-Win32 can display multiple X applications with full graphical user interface, so you are not restricted to working from the command line. It also permits copying and pasting data between X and Windows applications.

To run on Windows:
Start -> Programs -> X-Win32 9.5 -> W-Win32
Index

A
accessibility 19
accounts
  activation 7
  deactivation 9
  faculty and staff 7, 9, 10
  guest 7, 9
  Hesiod 17
  policies 12
  privileges 9
  sharing 19
  summer 9
  user lookup 10, 11, 17
add 33, 35, 39, 90, 112, 127
AFS 11, 63, 65, 69, 79, 88, 93
  access control list 95, 96, 97, 100, 101
  authentication 95
  backup volume 27
  cache manager 95
  cell 22, 93
  commands 65, 79, 83, 85, 88, 90, 95, 96, 97, 100, 101
  file tree 22, 24, 25, 93, 99, 100
  glossary 102
  home directory 11, 22, 23, 24, 27, 29, 94, 95, 97, 99, 100
  mount point 94, 99, 101
  OpenAFS 101
  partition 22, 94
  path 22, 23, 24, 25, 30, 95, 96, 97, 99, 100, 101
  pts group 97
  quota 94, 100
  root 22
  site 22, 93
  token 95
  volume 22, 27, 94, 99, 100
  anti-virus 9, 12
  attach 112

B
backup 9, 22, 27, 95
Blackboard Vista 9, 56, 57

C
calendar 55
Campus Linux Services (CLS) 39

D
documentation 13, 48

E
Elluminate 9, 56, 57
email 9, 19, 52, 62
  address 7, 52, 62
  attachments 53, 54
  quota 11
  spam 54, 55
  ExpanDrive 65, 66, 79, 101

F
file storage 9, 11, 22, 27, 94, 95
file transfer 63, 65, 69, 79, 88

G
Google 52, 53, 55
graphical user interface 33, 39, 65, 72, 79
GroupWise 52, 55

H
help 8, 9, 13, 15, 16, 19, 33
Hesiod 17
home directory 22, 23, 24, 27, 29, 94, 96, 99, 100

I
IMAP 11, 27
ITECS 11, 13, 17, 91

J
J drive 25, 99, 101

K
K drive 11, 22, 24, 38, 99, 100, 101
Kerberos 101
knowledgebase 15

L
labs 9, 11, 12, 17, 48, 54, 95, 127
  accessibility 21
  college 21
  Eos policies 19
  printing 43
  storage devices 27
  Unity policies 17
Index

labs (continued)
  Windows 34
locker 22, 30, 58, 61, 62, 94
logging in 7

M

M drive 11
Mediasite 9
messaging 9, 52
Moodle 9, 56, 57
MyPack Portal 7, 9

N

Novell 11

O

Office of Information Technology (OIT) 11, 13, 17, 29, 48, 91
Office of Information Technology Division (OIT) 7
OpenAFS 101

P

password 29, 42, 59, 76, 88, 95
  change 8, 19
  initial 8
  reset 8
  sharing 8, 12
PDF 47, 49, 50, 51, 54
policies 7, 12, 17, 19, 30
printing 9, 17, 46
  cancel job 47, 49, 51
  color 48
  commands 48
  help 43, 48
  large format 48
  PDF 50, 51
  queues 43, 47
  quota 43, 44, 45, 51
  to a file 43, 46, 49, 50
processes 37, 38, 39
PureMessage 55
PuTTY 70, 71

Q

quota 22, 43, 44, 51, 94, 100
Quota Manager 9, 11, 94

R

rdesktop 90
Remedy 13, 15, 16
remote access 9, 11, 12, 19, 63, 64, 65, 70, 91
  distance students 8
remote access (continued)
  file transfer 63, 64, 65, 70, 79, 88
  Linux 88, 89, 90
  Mac 79, 83, 84, 85
  running applications 63, 65, 70, 72, 75, 76, 79, 83, 84, 85, 88, 90, 91
  SCP and SFTP 63, 64, 69, 70, 88, 89
  SSH 69, 70, 83, 88, 89
  Windows 65, 70, 72, 75, 76
remote desktop connection 64
Remote Desktop Connection (RDC) 64, 65, 76, 77, 79, 85, 88, 90
Remote Desktop Protocol (RDP) 64, 65, 76, 85, 90
ResNet 12
running applications remotely 64, 76, 85, 90

S

SCP 63, 88, 89
SecPanel 89
Secure SHell (SSH) 64, 65, 69, 70, 83, 88, 89
security 12
SFTP 63, 70, 88
software 9, 11, 33, 90, 94, 99, 127
  anti-virus 12
  documentation 33
  download 12, 33, 42, 69, 70, 72, 89, 127
  engineering 38
  licensing 42
  Linux 33, 39, 127
  Solaris 33, 34, 35, 37, 39, 127
  VCL 65, 79, 85, 88, 90, 91
  Windows 33, 38, 127
  Mac 33, 41, 127
spam 54, 55
spam filtering 9
student-owned computing 11, 42
sysnews 9, 10, 11, 13, 14, 17, 29, 94

U

Unity ID 7, 17, 42, 47, 59, 76, 99, 100
UNIX 65, 101, 103, 104, 105, 108
  argument 105
  C shell 108
  command-line 70
  commands 79, 83, 84, 85, 88, 90, 101, 105, 112
  directory commands 110
  environment and shell variables 109
  file names 106
  man page 107

V

Virtual Computing Lab (VCL) 9, 11, 33, 63, 64, 65, 75, 76, 79, 85, 88, 90, 91, 127
virus 54
W

web
  applications 9
  HTML guide 30
  personal 9, 24, 28, 29, 30, 97
  software 30
WebAssign 9, 57
Webmail 11, 52, 53
window manager 33, 36
WinSCP 65, 69, 70
wireless 9, 11, 12
WolfCopy 17, 43, 46, 48
WolfPaw 7
WolfPrint 43, 47, 48
Wolfware 9, 58, 59, 60, 61, 62, 63
WRAP 42, 58, 60

X

X Window System (X11) 36, 70, 79, 83, 84, 88
X-Win32 65, 70, 72, 75